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 เว็บไซตถือเปนสื่อที่สําคัญอยางหนึ่งในปจจุบัน ซ่ึงทุกคน ทุกหนวยงาน ทุกองคกร สามารถมีเปนของตนเองได 
ขอดีของเว็บไซต ไดแก 

• สามารถเผยแพรขอมูลขาวสาร เชน รายการสินคา การบริการ ประชาสัมพันธ ผลงานตางๆ ฯลฯ 
• นําเสนอไดอยางกวางขวาง ไมวาอยูตรงสวนใดของมุมโลก สามารถเปดเขามาดูเว็บไซตไดตลอดเวลา 
• นําเสนอขอมูลไดหลายรูปแบบ เชน ขอความ ภาพนิ่ง ภาพเคลื่อนไหว ฯลฯ 
• เพิ่มภาพลักษณ เพิ่มความนาเชื่อถือใหกับผูประกอบการ หางราน บริษทั หรือองคกร 
• ปรับปรุงขอมูลการนําเสนอไดงาย และรวดเร็ว เพื่อใหไดขอมูลที่ทันสมัย ใหมอยูตลอดเวลา  

 
หลักท่ัวไปในการออกแบบเว็บไซต 

• นําเสนอขอมูลโดยจัดสีสันขอความใหดูสะดุดตา และมีรูปภาพประกอบ 
• หนาแรกไมควรมีขอมูล หรือรูปภาพใหญๆ  มากเกินไปจะทําใหเว็บไซตเปดไดชา ถาตองการนําเสนอภาพ

ขนาดใหญควรเริ่มตนการแสดงภาพขนาดเล็กกอนแลวทําลิงคใหสามารถคลิกเพื่อเปดดูภาพใหญได 
• มีภาพเคลื่อนไหวประกอบเพื่อโฆษณาประชาสัมพันธดงึดูดความสนใจแตไมควรใสมากเกินไป 
• หนาเว็บไซตควรตกแตงดวยภาพกราฟกพอประมาณ ถามากเกนิไปจะทําใหเปดเว็บไซตไดชาผูชมอาจหนีไป

เว็บไซตอ่ืนเนือ่งจากรอไมไหว 
• อัพเดทขอมูลเว็บไซตเปนระยะๆ เพื่อไมใหผูชมรูสึกเบื่อ เชน เพิ่มเนื้อหาขาวใหม เปลี่ยนสี เปลี่ยนรูปภาพ 

ฯลฯ 
• ควรมีช่ือเว็บไซต หรือช่ือองคกร และขอมลูสําหรับติดตอ เชน ที่อยูอีเมล หมายเลขโทรศัพท ไวที่เว็บไซต

ทุกๆ หนา อาจเปนสวนลาง หรือสวนบนหัวเว็บไซตกไ็ดแลวแตความเหมาะสมในการออกแบบ  
 

ควรมีหนาเวบ็เพจอะไรบาง 
การที่เว็บไซตจะมีหนาเว็บอะไรบาง โดยทัว่ไปแลวไมมกีฎเกณฑตายตัว ขึ้นอยูกับการออกแบบ และความตองการ

ของเจาของ แตโดยพื้นฐานที่สุด ควรมีหนาเว็บตอไปนี ้
1. ขอมูลเกี่ยวกับบริษัทหรือองคกร อาทิ ประวัติ ผลงานที่ผานมา ขอมูลอ่ืนๆ ที่ทําใหผูชมมั่นใจในองคกร 
2. ขอมูลผลิตภัณฑ และบริการ ถามีมากก็ควรจัดแบงเปนหมวดหมู 
3. คําถามคําตอบที่มักพบบอย คือ การรวบรวมคําถาม และคําตอบที่ผูคนมักสอบถามกันบอยๆ มาไวในเว็บหนา

หนึ่ง เพื่อที่ผูชมจะไดเปดอานแลวเขาใจไดชัดเจนขึ้น 
4. ขอมูลสําหรับติดตอแสดงรายละเอียดสําหรับการติดตอสอบถามเพิ่มเติม เชน ที่อยูอีเมล หมายเลขโทรศัพท 

หมายเลขโทรสาร อาจมีแผนที่แสดงไวดวยก็ได 
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Photoshop เปนโปรแกรมสําหรับสราง และตกแตงภาพที่มีช่ือเสียง และไดรับความนิยมมากที่สุดอันเนื่องมาจาก

คุณสมบัติเดนซึ่งมีอยูอยางมากมาย ไมวาจะเปนความสามารถจัดการกบัไฟลสารพัดชนิดที่ใชในงานประเภทตางๆ ทั้งรูปที่
จะนําไปผานกระบวนการพมิพ และรูปทีน่ําไปใชในเวบ็เพจ หรือสงผานสื่ออิเล็กทรอนิกสมีความสามารถเปนเยี่ยมในการ
แกไขตกแตงภาพ และการสรางเอฟเฟคตพิเศษตางๆ มีเครื่องที่มีประสิทธิภาพ และความยืดหยุนสูงสามารถบันทึกขั้นตอน
ที่ตองทําซ้ําๆ ไวเรียกใชภายหลังตลอดจนมีผูผลิตปลั๊กอิน(Plug-in) ใหเปนจํานวนมาก ซ่ึงปลั๊กอินก็คือโปรแกรมเสริม
สําหรับชวยใหการทํางานทีซั่บซอนสําเร็จลงไดอยางรวดเร็ว 

ตอไปนี้เปนตวัอยางของงานประเภทตางๆ ซ่ึงคุณสามารถใช Photoshop ชวยจัดการไดอยางงายดาย 
• แกไขภาพถายที่บกพรองหรือมีตําหนิ เชน ปรับสีที่เพี้ยน ปรับแสงเงาที่สวาง หรือมืดเกินไป 
• ตกแตงภาพ เชน ตัดสวนทีไ่มตองการออกไป ลบองคประกอบที่รกรุงรัง ปรับภาพใหเบลอ หรือคมชัด ปรับ 

ผิวกายนางแบบใหขาวนวล และขจัดไฝฝาตางๆ ขจัดเม็ดสีที่เกิดในภาพที่สแกนจากสิ่งพิมพ 
• ดัดแปลงภาพ เชน ทําภาพใหมใหกลายเปนภาพสีซีเปยแบบโบราณ หรือแปลงภาพเกาๆ ที่เปนขาวดาํให

กลายเปนภาพสี เปลี่ยนภาพคนใหอวนขึ้น- ผอมลง หรือเด็ก- แกกวาที่เปนจริง 
• ตัดตอภาพ เชน ยายตัวคนจากภาพถายชายทะเลไปยืนบนภูเขาหิมะ นาํตัวคุณไปอยูในภาพเหตุการณสําคัญ

ทางประวัติศาสตรเหมือนในภาพยนตรเร่ือง Forest Gump 
• ใสเอฟเฟคตพิเศษใหภาพ เชน ทําใหเหมือนกําลังมองภาพผานกระจกชนิด และลายตางๆ หรือเหมือนเงา

สะทอนในน้ําเปลี่ยนภาพถายใหดูคลายภาพวาดดวยเครื่องมือหลากหลายชนิด ใสประกายแสง หรือเงาใหวัตถุ 
ทําวัตถุแบนๆ ใหดูเปน 3 มิต ิเปลี่ยนโทนสขีองภาพ 

• สรางภาพกราฟกซึ่งผสมผสานระหวางภาพถาย ขอความ และภาพวัตถุ หรือเอฟเฟคตพิเศษที่สรางขึ้นใน 
Photoshop เพื่อใชในงานผลิตสื่อโฆษณา ทําปกหนังสือหรือนิตยสาร หรือใชตกแตงเว็บเพจ 

• สรางองคประกอบที่ใชในเวบ็เพจ (โดยทํางานรวมกับโปรแกรม Image Ready  ที่ใหมาดวยกนั) เชน การตัด
แบงภาพขนาดใหญออกเปนสวนๆ (Slice)  การแบงพืน้ที่ภาพเพื่อสรางไฮเปอรลิงคเฉพาะสวน (Image map)
การสรางภาพเคลื่อนไหว (Animation) และการสรางปุมที่เปลี่ยนสถานะตามเมาส (Rollover) 

• อ่ืนๆ อีกมากมาย 
 
 



 

 3 

 

แนะนําองคประกอบหลัก และพ้ืนที่การทํางานของโปรแกรม 
เมื่อเรียกใชโปรแกรมดวยคําสั่ง All Program  > Adobe Photoshop CS จากปุม Start จะปรากฏหนาตางของ

โปรแกรม โดยมีสวนประกอบตางๆ ดังนี้ 
 

หนาจอของ Photoshop CS 
เมื่อเปดโปรแกรม Photoshop ขึ้นมาเราจะเหน็เครื่องมือในการทํางานจํานวนมาก ไดแก ไตเติลบาร(Title Bar) 

เมนูบาร (Menu Bar)  ออปชั่นบาร (Option Bar)  กลองเครื่องมือ (Toolbox)  พาเล็ต(Palette) ตางๆ และแถบสถานะ 
(Status Bar) 
 สําหรับ Photoshop CS นั้น ออปชั่นของเครื่องมือตางๆ จะอยูบนออปชัน่บารทําใหใชงานไดงาย ซ่ึงเมื่อเราคลิก
เลือกเครื่องมือใดๆ จากกลองเครื่องมือ หนาตาของออปชั่นบารก็จะเปลี่ยนแปลงตามไปดวย นอกจากนั้นในกลองเครื่องมือ
ก็มีเครื่องมือใหมเพิ่มเขามา และมีการปรับรูปแบบใหสวยงามนาใชยิ่งขึ้น 
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ไตเติลบาร (Title Bar) และเมนูบาร (Menu Bar) 
 ไตเติลบาร คือ แถบดานบนสุดของวินโดวที่ใชแสดงชือ่โปรแกรม และช่ือไฟลที่เรากําลังทํางานดวยในขณะนัน้ซึ่ง
ที่มุมดานหนึ่งจะมีไอคอนทีใ่ชยอขยายวนิโดว และปดโปรแกรม 
 บรรทัดถัดมาจะเปนเมนูบารซ่ึงประกอบดวยเมนูคําสั่งตางๆ ที่ใชจัดการกับไฟลทํางานกับภาพ และปรับคาตางๆ
โดยเมนูเหลานี้มีเมนูยอยๆ ใหเลือกใชงาน 
 
 
 
 
 
 
 
 
 
 
 
 
 
ออปชั่นบาร (Option Bar) 
 ออปชั่นบารเปนสวนที่ใชในการปรับแตงการทํางานของเครื่องมือตางๆ ซ่ึงรายละเอียดในออปชั่นบารจะเปลี่ยนไป
ตามเครื่องมือที่เราเลือกใชในขณะนั้น เชน เมื่อเราเลือกเครื่องมือพูกัน บนออปชั่นบารก็จะประกอบดวยออปชั่นที่ใช
กําหนดขนาด และลักษณะหวัพูกนั โหมดในการระบาย ความโปรงใสของสี และอัตราการไหลของสี เปนตน 
 
 

 
กลองเครื่องมือ (Toolbox)  
 กลองเครื่องมือ หรือที่ตอไปจะเรียกทับศัพท  ทูลบ็อกซประกอบดวยเครื่องมือตางๆ ที่จําเปนตอการทํางาน 
เครื่องมือเหลานี้มีเปนจํานวนมากดังนั้นจงึมีการรวมเครือ่งมือบางอยางไวในปุมเดยีวกันโดยจะมีรูปสามเหลี่ยมสีดําอยูที่มุม
ขวาลางเพื่อบอกวายงัมีเครื่องมืออ่ืนอยูดวย เชน เครื่องมือสําหรับการเลือกพื้นที่หรือ Marquee จะประกอบดวยเครื่องมือ
เครื่องมือเลือกพื้นที่ส่ีเหล่ียม พื้นที่วงกลม พื้นที่ในแนวนอนขนาด 1 พกิเซลเปนตน 
 เมื่อเราคลิกปุมใดๆ 1 คร้ังจะเปนการเลือกเครื่องมือนั้นสําหรับนําไปใชงาน ซ่ึงจะสังเกตไดวาเมาสพอยเตอรจะ
เปลี่ยนไปตามลักษณะเครื่องมือที่เลือกแตถาตองการเลือกเครื่องมืออ่ืนที่อยูบนปุมเดยีวกันจะทําได 2 แบบคือ 
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• คลิกบนปุมคางไวสักครู จะปรากฏแถบแสดงรายการใหเราคลิกเลือกเครื่องมืออ่ืนได 
• คลิกขวาบนปุม จะปรากฏแถบแสดงรายการทันที 

 

ทั้งนี้ปุมทูลบ็อกซจะแสดงไอคอนของเครื่องมือหลังสุดบนปุมนั้นที่ถูกเรียกใช 
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เครื่องมือพื้นฐานใน Adobe Photoshop 
 

 

Rectangular marquee tool เครือ่งมือเลือกขอบเขตพื้นที่การทํางาน 
แบบสี่เหลี่ยม 
Elliptical marquee tool เครื่องมือเลือกขอบเขตพื้นที่การทํางาน 
แบบวงกลม  ทําวงรี 
Single row marquee tool เครื่องมือเลือกขอบเขตพื้นที่การทํางาน  
แบบเสนแนวนอน 
Single column marquee tool เครื่องมือเลือกขอบเขตพื้นที่การ
ทํางาน แบบเสนตั้ง 

 Move tool เครื่องมือที่ใชเลือกช้ินงาน ยายตําแหนงของภาพใน Layer   

 

Lasso tool เครื่องมือเลือกขอบเขตพื้นที่การทํางาน แบบอิสระ 
Polygonal lasso tool เครื่องมือเลือกขอบเขตพื้นที่ทํางาน แบบเปน 
เหลี่ยม เปนมุม 
Magnetic lasso tool เครื่องมือเลือกขอบเขตพื้นที่การทํางาน แบบ
อัตโนมัติ 

 
Magic wand tool เครื่องมือเลือกขอบเขตพื้นที่การทํางาน โดยอานคา
ของจุดสีที่อยูใกลเคียงกัน 

 
Crop tool เครื่องมือที่ใช ตัดสวนเกินของภาพที่ไมตองการออกไป 

 

Slice tool เครื่องมือที่ใช ตัดแบงภาพออกเปนภาพยอยๆ เพื่อนําไปใช
กับงานดาน Web Design 
Slice select tool เครื่องมือที่ใชเลือกช้ินงานที่ Slice ไวแลว 

 

Healing Brush tool เปนเครื่องมือใชแกไขตําหนิที่เปนจุด 
Patch Tool เปนเครื่องมือใชแกไขตําหนิโดยการนําสวนที่ดีมาปะทับ 

 

Painbrush tool เครื่องมือที่ใช ระบายสี แบบหัวพูกัน  
Pencil tool เครื่องมือที่ใชวาดภาพตางๆ ลงในชิ้นงานมีลักษณะการ
ทํางานเหมือนเราใชดินสอวาดภาพ 

 

Clone stamp tool เครื่องมือที่ใช ทําสําเนาภาพจากจุดหนึ่งไปยังอีก
จุดหนึ่ง 
Pattern stamp tool เครื่องมือที่ใช พิมพลาย Pattern ใหกับงาน 

 

History brush tool เครื่องมือที่ใชลบ Effect บางสวนออกไป  
Art history brush tool เครื่องมือที่ใช แตงภาพใหเหมือนภาพเขียน 
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Eraser tool เครื่องมือที่ใชเพื่อลบภาพ  
Background eraser tool เครื่องมือที่ใชเพื่อลบภาพ โดยจะลบ
เฉพาะสวนที่เปน Background  
Magic eraser tool เครื่องมือที่ใชลบภาพโดยจะอานคาที่จะลบจากจุด
สีที่อยูใกลเคียงกัน 

 

Gradient tool เครื่องมือที่ใช สรางสีใหกับงาน แบบไลน้ําหนักสี 
Paint bucket tool เครื่องมือที่ใช เทสีใหกับงานโดยจะเทสีเทากัน
โดยไมมีการไลน้ําหนักสี 

 

Blur tool เครื่องมือที่ใช ทําใหภาพเบลอ  
Sharpen tool เครื่องมือที่ใช ขูดภาพทําใหภาพดูคมชัดขึ้น  
Smudge tool เครื่องมือที่ใช ถูใหภาพดูเบลอ   

  

 

Type tool เครื่องมือที่ใชเพื่อสรางตัวอักษรใหกับช้ินงาน 

 

Pen tool เครื่องมือที่ใช สรางเสนพาท     
เสนพาท คือ เสนที่แสดงรูปรางของภาพ หรือวัตถุที่เราจะสราง  
Freefrom pen tool เครื่องมือที่ใช วาดเสนพาทแบบอิสระ  
Add anchor point tool เครื่องมือที่ใชเพิ่มจุด anchor บนเสนพาท  
Anchor point คือ จุดที่อยูบนเสนพาท ที่สามารถเคลื่อนยายเพื่อ
ปรับเปลี่ยนรูปรางของเสนพาทได  
Delete anchor tool เครื่องมือที่ใชลบจุด anchor บนเสนพาท  
Convert point tool เครื่องมือที่ใชเคลื่อนยาย ปรับแตงเสนพาทใหโค
งหรือเปนมุมแหลม 

 

Rectangle tool เครื่องมือที่ใช วาดภาพสี่เหลี่ยม  
Rounded rectangle tool เครื่องมือที่ใช วาดภาพสี่เหลี่ยมมุมมน  
Elipse tool เครื่องมือที่ใช วาดภาพวงกลม วงรี  
Polygon tool เครื่องมือที่ใช วาดภาพรูปทรงหลายเหลี่ยม  
Line tool เครื่องมือที่ใช วาดเสนตรง  
Custom shape tool เครื่องมือ วาดรูปภาพที่เราสามารถกําหนดไดเอง 

 

Eyedropper tool เครื่องมือที่ใช ดูดสีของภาพมาทําเปนสี foreground  
Color sampler tool เครื่องมือที่ใช อานคาสีในภาพ  
Mesaure tool เครื่องมือที่ใช วัดขนาด ระยะตางๆในภาพ 
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Hand Tool เปนเครื่องมือใชเลื่อนภาพบนจอ จะสามารถใชไดก็ 
ตอเมื่อเราไดขยายภาพลนหนาจอ แลวเทานั้น 

 Zoom tool เครื่องมือที่ใช ยอ/ขยายขนาดมุมมองของพื้นที่ทํางาน 

       
Edit in standard mode เครื่องมือแกไขภาพในโหมด standard  
Edit in quick mask mode เครื่องมือแกไขภาพใหโหมด quick mode 

 

Set foreground color เครื่องมือที่ใช เลือกสี/แสดงสี foreground  
Set background color เครื่องมือที่ใช เลือกสี/แสดงสี background   

 
 
การใชเมนูลดั 
 ในขณะที่ทํางานอยูกับรูปภาพนั้น เราสามารถคลิกขวาบนรูปภาพเพื่อเปดเมน ู
ลัดไดโดยคําสัง่สวนใหญจะเกี่ยวของกับเครื่องมือที่กําลังเลือก เชน ขณะเลือกเครื่องมอื  
Rectangular Marquee เมื่อคลิกขวาบนภาพจะปรากฏเมนูลัด ดังรูป  
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แถบสถานะ 
 แถบสถานะจะปรากฏอยูดานลางสุดของวนิโดวโดยจะแสดงเปอรเซ็นตของการซูมภาพ  ขนาดของไฟลรูปรวมถึง
อธิบายการทํางานของเครื่องมือที่กําลังเลือกในขณะนั้น 
 
 
 
 
 
 
 
 
 
 

พาเล็ตตางๆ 
 พาเล็ต หมายถงึวินโดวยอยๆ ที่ใชเลือกรายละเอียดสําหรับประกอบการ 
ทํางานตางๆ ในโปรแกรม Photoshop มีพาเล็ตใหใชจํานวนมาก เชน พาเล็ต  
Color ใชสําหรับเลือกสี  พาเล็ต Layer ใชควบคุมการใชงานเลเยอร พาเล็ต History 
ใชเก็บบันทกึการทํางานที่ผานมา พาเล็ต Info ใชแสดงขอมูลเกี่ยวกับขนาด/ตําแหนง 
ของออปเจ็ค รวมถึงคาของสีในโมเดลตางๆ เปนตน 
 ในการเปดใชพาเล็ตตางๆ นั้นใหเราเลือกคาํสั่ง  Windows  > ช่ือพาเล็ต  
เชน Window  >  Leyers คือใหแสดงพาเล็ต Leyers เปนตน 
 สําหรับคําสั่ง Window  >  Workspace  >  Reset Palette Locations  
เปนการสั่งใหเปด และจดัตําแหนงของพาเล็ตใหเหมือนกับตอนที่เปดโปรแกรม 
คร้ังแรก 
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การใชงานพื้นฐาน และการบันทึกไฟลภาพ 
 

การสรางไฟลใหม 
 การสรางไฟลใหมเพื่อทํางานมีขั้นตอนดังนี้ 

1. เลือกคําสั่ง File > New หรือกดคีย Ctrl + N จะ 
ปรากฎไดอะลอ็กบ็อกซ New  

2. กําหนดชื่อใหไฟลใหมนีใ้นชอง Name (หรือจะ 
เก็บไวกําหนดตอนสั่งบันทึกไฟลก็ได) 

3. กําหนดขนาดกวาง  ยาวของรูปภาพ โดยใสคา 
แลวคลิกเลือกหนวยวัดในชองดานหลัง 

• Width ความกวางของรูป 
• Height  ความสูงของรูป 

4. กําหนดคาความละเอียดของภาพในชอง  
Resolution  

5. เลือกโหมดสสํีาหรับไฟลในชอง Color Mode 
6. เลือกลักษณะของฉากหลังโดยใชออปชัน่กลุม Background Contents  

• White ใหพืน้มีสีขาว 
• Background Color ใหพื้นเปนสีเดียวกับสี background ตามที่เลือกไวบนทูลบอกซ 
• Transparent ใหพื้นเปนลักษณะโปรงใส 

7. คลิก OK 
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การบันทึกไฟล 
 หลังจากสราง หรือแกไขรูปภาพเสร็จแลวเราตองสั่งบันทึกไฟล ซ่ึงสามารถเลือกไดหลายรูปแบบ เชน ไฟล PSD 
ของ Photoshop เอง หรือไฟลรูปภาพชนดิอื่นๆ เชน TIF. GIF . JPEG เปนตนเพื่อใหเหมาะกับการนําไปใชงานในแตละ
กรณ ี
 อยางไรก็ตาม เราควรบันทึกรูปภาพไวในรปูแบบของ Photoshop ดวยอีกชุดหนึ่งตางหากจากรูปที่จะนําไปใชจริง 
เนื่องจากการแกไขไฟล PSD  จะทําไดงาย เพราะขอมูลตางๆ เชน เลเยอร ฟอนต จะถกูเก็บไวอยางครบถวน ในขณะที่ไฟล
ชนิดอื่นจะเกบ็ขอมูลเหลานี้ไมได หรือไดเพียงบางสวน ตัวอยาง เชน เมื่อบันทึกไฟลภาพเปนไฟล JPEG เลเยอรทั้งหมดจะ
ถูกยุบรวมกนั และขอมูลประเภทเวคเตอรจะถูกแปลงเปนบิตแมพทั้งหมด ทําใหไมสามารถแกไขภาพเปนสวนๆ ไดอีก 
 การบันทึกไฟลที่สรางใหม มีขั้นตอนดังนี ้

1. เลือกคําสั่ง File > Save  
2. เลือกโฟลเดอรที่ตองการใชจัดเก็บในชอง Save in 
3. ตั้งชื่อไฟลในชอง File name  
4. เลือกรูปแบบ หรือนามสกุลของไฟลในชอง Format 
5. กําหนดออปชั่นตางๆ ตามตองการ 
6. คลิกปุม Save 
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สําหรับการบันทึกครั้งตอๆ ไป เราสามารถเลือกคําสั่ง File > Save หรือกดคีย Ctrl + S โดยที่ไมตองกําหนด

ออปชั่นตางๆ อีก ไฟลจะถูกบันทึกทันท ี
 ในกรณีที่เราบนัทึกไฟลไปแลวแตตองการบันทึกสําเนาในชื่อหรือรูปแบบอื่นๆ อีก ใหใชคําสั่ง File > Save As 
แทน แลวกําหนดออปชั่นตางๆ เชนเดียวกนั 
 

การเปดไฟลท่ีมีอยูแลว 
 เราสามารถเปดไฟลรูปภาพขึ้นมาใชงานไดหลายรูปแบบ ไมจําเปนตองเปนไฟล PSD เพียงอยางเดียว เชน JPEG 
GIF TIFF BMP เปนตนโดยมีขั้นตอนดังนี ้

1. เลือกคําสั่ง File > Open  
2. เลือกโฟลเดอรที่เก็บไฟลจากชอง Look in 
3. ในกรณีที่ตองการใหไดอะลอ็กบ็อกซนี้แสดงเฉพาะไฟลบางชนิด ใหเลือกประเภทไฟลในชอง Files of type  
4. คลิกเลือกชื่อไฟลจากรายการ หรือปอนชื่อลงในชอง File Name ที่ดานลางของไดอะล็อกบ็อกซจะแสดงภาพ 
       ตัวอยางของไฟลนั้น รวมทั้งแสดงขนาดไฟลไวใตภาพดวย 
5. คลิกปุม Open 
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การยอ/ขยายภาพดวยเครื่องมือ Zoom  
 เราสามารถซูมภาพใหเล็กลง (Zoom out) หรือใหญขึ้น (Zoom In) ไดตามความจําเปนในการใชงาน เชน ในการ
ตกแตงภาพรปูดวงตาของใครสักคนหนึ่ง เราจําเปนตองซูมภาพใหเหน็เฉพาะสวนของดวงตาเพื่อความสะดวกในการ
ปรับแตงเปนตน 

1. คลิกเลือกเครื่องมือ Zoom           จากทูลบาร 
2. เมาสพอยนเตอรจะเปลี่ยนเปนรูป         จากนั้นใหเลือกวิธีใดวิธีหนึ่งในการซูมภาพดังนี ้

 
 

 
 
 
 
 
 
 
 

• การซูมภาพใหใหญขึ้นนัน้ ใหเราคลิกเมาสบนตําแหนงทีต่องการซูม และถาตองการซูมใหใหญขึน้
อีกใหคลิกซ้ําหลายๆ คร้ัง ซ่ึงภาพจะถูกขยายใหใหญขึ้นในแตละครั้งที่คลิก 

• เมื่อตองการซูมภาพใหเล็กลง ใหใชเครื่องมือ Zoom          เชนกันโดยกดคีย Alt คางไว ซ่ึงเมาสจะ
เปลี่ยนเปนรูป          จากนั้นคลิกบนตําแหนงที่ตองการซูมใหเล็กลง 

 
การเลื่อนดูภาพดวยเครื่องมือ Hand  
 ในกรณีที่เราซูมภาพจนใหญเกินกวาวินโดวสของไฟลนัน้ ก็จะทําใหบางสวนของภาพถูกซอนไว โดยสังเกตได
จากสโครลบาร ที่ปรากฏขึ้นมาทางดานลาง และดานขวาของวินโดวส ซ่ึงเราสามารถใชสโครลบารนี้เล่ือนดูสวนอื่นของ
ภาพได 
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การเลื่อนดูภาพอีกวิธีหนึ่งกค็ือ การใชเครื่องมือ Hand ตามขั้นตอนดงัตอไปนี้  
1. คลิกปุมเครื่องมือ Hand  
2. ใชเมาสรูป        คลิกคางไวบนภาพ แลวเล่ือนขึ้นลง หรือ ซาย ขวา เพื่อดูสวนตางๆ ของภาพไดตามตองการ  
        ดังรูป 

 
 

 
 
 
 
 
 
 

การใชงานพาเล็ต Navigator  
 การซูมภาพดวยพาเล็ต Navigator ทําใหเราไดอัตราการซูมที่แนนอน และสามารถเลื่อนภาพในสวนที่ตองการได
อยางสะดวกการเปดพาเล็ต Navigator ทําไดโดยใชคําสั่ง Windows > Navigator  

บนพาเล็ต Navigator จะแสดงภาพตวัอยางของไฟลภาพนั้น โดยกรอบสีแดงจะบอกใหรูวาขณะนัน้สวนใดของ
ภาพกําลังถูกแสดงอยูในวินโดวส สําหรับการซูมภาพใหวธีิตอไปนี้ 

• ปอนคาอัตราการซูมภาพที่ตองการลงในชองมุมซายลาง โดยมีหนวยเปนเปอรเซ็นต (การปอนอัตราการซูม
ภาพลงในชองทางซายสุดของแถบสถานะก็ใหผลเชนเดยีวกัน)  

• คลิกปุม         เพื่อซูมออก (ภาพเล็กลง) หรือคลิกปุม         เพื่อซูมเขา (ภาพใหญขึ้น )  
• ใชการคลิกลากสไลเดอรบารระหวางปุมทัง้สองเพื่อเลือกขนาดตามทีต่องการ 
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เราสามารถเลื่อนดูสวนอืน่ของภาพไดโดยคลิก ลากกรอบสีแดงบนพาเล็ต Navigator ไปยังสวนที่ตองการซึ่งเมาส

พอยนเตอรจะเปลี่ยนเปนรูป         หรือ อีกวิธีหนึ่งคือ คลิกเมาสบนสวนของภาพที่อยูนอกกรอบสีแดง 1 คร้ัง (กรณีนี้เมาส
พอยนเตอรจะเปลี่ยนเปนรูป      )  กรอบสีแดงกจ็ะเลื่อนมายังตําแหนงที่คลิกนั้น 

 
 
 
 
 
การใชไมบรรทัด (Ruler) 
 ประโยชนของไมบรรทัด คือทําใหเราสามารถกําหนดตําแนงตางๆ ของออปเจ็คตางๆ ไดแมนยําขึ้นปกติไมบรรทัด
จะปรากฏอยูทีด่านซาย และดานบนของแตละวินโดวส และเราสามารถเลือกหนวยวดัไดตามความตองการ 
 การแสดงไมบรรทัดใหเลือกคําสั่ง View > Rulers หรือกด Ctrl + R สําหรับวิธีการใชไมบรรทัดมีดงันี้ 

• เมื่อเล่ือนเมาสไปบนรูปภาพ เราจะเห็นวามีเสนประปรากฏบนไมบรรทัดทั้งแนวตั้ง และแนวนอน เคลื่อนที่
ตามตําแหนงที่เมาสเคลื่อนไป ดังนั้นเราสามารถดูตําแหนงของเมาสไดดวยวิธีนี ้
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• การเปลี่ยนหนวยวัดของไมบรรทัดทําไดโดยเลือก คําสั่ง  

Edit > Preferences > Units &  Rulers จากนั้นใหเลือก 
หนวยวัดในชอง Rulers หรืออีกวิธีหนึ่ง คอื คลิกขวาบน 
ไมบรรทัด แลวเลือกหนวยวดัจากเมนูลัดทีป่รากฎขึ้น 

 
 
 
 
 

 
   

 
 
 
 
 
 
 

การใชเสนไกด (Guide) 
 เสนไกด (Guide)  คือ เสนที่ชวยในการกะระยะ และตําแนงเพื่อจัดวางออปเจ็ค เสนไกดนี้เราสามารถสรางขึ้นเอง
ที่ตําแหนงใดก็ไดที่ตองการทั้งแนวตั้ง และแนวนอน โดยจะมีลักษณะเปนเสนสีฟา (คาเริ่มตน) แตเสนนี้จะไมปรากฏเมื่อ
นําภาพไปใช ไมวาจะเปนการพิมพทางเครื่องพิมพ หรือนําไปใชกบัเวบ็เพจก็ตาม 

การสรางเสนไกดสามารถทําไดดังนี ้
• ใหแสดงไมบรรทัดกอน โดยเลือกคําสั่ง View > Rulers จากนั้นจึงใชเมาสคลิกลากเสนไกดจากไมบรรทัดไป

วางตรงตําแนงที่ตองการ ซ่ึงทําไดทั้งแนวตัง้ และแนวนอน โดยเมาสพอยนเตอร จะเปลี่ยนเปนรูป        
(แนวนอน) หรือ       (แนวตัง้) และเสนไกดที่ไดจะมีสีฟา 
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เทคนิคการวาดภาพ และลวดลาย 

โปรแกรม Photoshop ที่มีเครื่องมืออยูจํานวนหนึ่งทีใ่ชในการวาดภาพ ซ่ึงแบงออกเปน เครื่องมือระบายสีแตละ
แบบจําลองการใชงานมาจากเครื่องมือวาดภาพจริงโดยเครื่องมือ Bush จําลองมาจากพูกัน  เครื่องมือ Pencil จําลอง 
มาจากดนิสอสี และเครื่องมือ Eraser จําลองมาจากยางลบ เราสามารถปรับแตงใหเครื่องมือเหลานี้มีลักษณะพิเศษ
เหมือนกับเครื่องมือที่ใชงานจริงๆ ได 
 สําหรับเครื่องมือที่ใชเติมสีภายในขอบเขตที่กําหนดไวนัน้ มีทั้งเครื่องมือเติมสีทึบ (เครื่องมือ Paint Bucket) เติม
ดวยลวดลาย (เครื่องมือ Pattem Stamp) และเติมสีดวยสีที่มีการไลเฉด หรือไลระดับความเขมจาง (เครื่องมือ Gradient)  
 นอกจากนั้นยงัมีเครื่องมือระบายสีอีก 2 ประเภททีใ่ชในการสรางภาพพิเศษไดแก เครื่องมือ History Brush ซ่ึง
นําเอาขั้นตอนในพาเล็ต History มาแทนสีที่ใชระบายภาพ และเครื่องมอื Art History มาแทนสีที่ใชระบายภาพ และ
เครื่องมือ Art History Brush ซ่ึงมีการทํางานเหมือนกับเครื่องมือ History Brush แตภาพที่ไดจะมลัีกษณะคลายภาพวาด
ของจิตรกร 
 เราสามารถกําหนดหัวแปรงใหกับเครื่องมือแตละประเภทไดทั้งขนาด และลักษณะ เชน หัวแปลงกลมที่ระบายได
ทั้งแบบขอบคมชัด หรือขอบเบลอ หรือหัวพูกันที่มีรูปรางลักษณะตางๆ  รวมทั้งอาจสรางหัวแปลงขึ้นมาใหมดวยตัวเองได
เชนกันซึ่งนับเปนจุดเดนอีกประการหนึ่งของโปรแกรมนี ้
 

กลุมเครื่องมอืระบายส ี
 เครื่องมือที่ใชในการระบายสีประกอบดวย 

เครื่องมือ Brush 
เครื่องมือ Pencil 
เครื่องมือ Eraser ใชลบสวนที่ไมตองการ 
 

วิธีใชเครื่องมอืการระบายสมีีดังนี ้
1. คลิกเลือกเครื่องมือที่ตองการ 
2. กําหนดขนาด และลักษณะของหัวแปลงบนออปชั่น 

บาร หรือบนพาเล็ต Brushes  
3. กําหนดออปชั่นอื่นๆ บนออปชั่นบาร 
4. กําหนดสี Foreground หรือ Background 
5. ใชเมาสคลิกลากไปบนพืน้ทีท่ี่ตองการ 
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การกําหนดขนาดและลักษณะของหวัแปรง 
 เราสามารถกําหนดขนาด และลักษณะของหัวแปรงไดจากออปชั่นซึ่งมีวิธีการดังนี ้

 
 
 
 
 
 
 
 
 

1. คลิกปุมลูกศรหลังชอง Brush บนออปชั่นบารของเครื่องมือระบายสีชนิดใดชนิดหนึง่ 
2. คลิกเลือกขนาด และลักษณะของหัวแปรงที่ตองการ 
3. (ถาตองการ) ปรับขนาดของหัวแปรงในชอง Masker Diameter 
 
ลักษณะของหวัแปรงที่เราเลอืกไดมีอยูหลายแบบ เชน 

รูปวงกลมขอบเรียบ           ซ่ึงเมื่อนําไประบายจะไดลายเสนที่มีขอบชัดเจน      
รูปวงกลมขอบเบลอ           ซ่ึงจะใหลายเสนที่มีชอบเบลอ     
รูปอื่นๆ เชน           ซ่ึงจะใหลายเสนที่มีลักษณะตางๆ กันออกไปตามรูปทรงของมัน   
 

  สําหรับตัวเลขที่กํากับอยูดานลาง คือ ขนาดของหัวแปรงในหนวยพิกเซล ดังนั้นเวลานําไปใชตองระวังวา
แมจะเห็นรูปตวัอยางหัวแปรงในพาเล็ตมีขนาดเทากนัแตขนาดจริงอาจแตกตางกัน 
 

ออปชั่นของเครื่องมือ Eraser 
 เครื่องมือ Eraser ใชสําหรับลบรูปภาพสวนที่ไมตองการ โดยหากภาพดังกลาวอยูในเลเยอร Background หรือถูก
ล็อคพิกเซลที่โปรงใสเอาไว สวนที่ถูกลบจะกลายเปนสี Background แตสําหรับภาพที่อยูในเลเยอรปกติ สวนที่ถูกลบจะ
กลายเปนพกิเซลโปรงใสแทน 

1.     คลิกปุมลูกศรหลังชอง Brush บนออปชั่นบารของเครื่องมือลบ 
2.     คลิกเลือกขนาด และลักษณะที่ตองการ 
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3.     ถาตองการปรับขนาด ใหปรับในชอง Masker Diameter 
 

 
 
 
 
 
 
 
 
 
 
สรางรูปทรงเรขาคณิตดวยเครื่องมือ Shape  
 ในกรณีที่เราตองการสรางรูปทรงเรขาคณิตก็อาจเลือกใชเครื่องมือ 
ในกลุม Shape เพื่อวาดเสน Path ไดดังนี ้

เครื่องมือ Rectangle ใชสรางรูปทรงสี่เหล่ืยม 
เครื่องมือ Rounded  Rectangle  ใชสรางรูปทรงสี่เหล่ียมมุมบน 
เครื่องมือ Ellipse ใชสรางรูปวงกลม/วงรี 
เครื่องมือ Polygon ใชสรางรูปทรงหลายเหลี่ยม 
เครื่องมือ Line ใชสรางเสนตรง 
เครื่องมือ Custom Shape ใชสรางรูปทรงโดยเรียกจากรปูทรงของ 
โปรแกรม หรือที่สรางบันทึกเก็บไว 

วิธีใชงานเครื่องมือกลุม Shape ทุกขั้นจะมขีั้นตอนที่เหมอืนกัน คือ 
1. คลิกเลือกเครื่องมือจากทูลบอกซ (หรือถากําลังใชเครื่องมือ Shape ช้ินใดชิ้นหนึ่งอยูแลว ก็สามารถ

คลิกเลือกเครื่องมือช้ินอื่นไดจากออปชั่นบารทันที) 
2. กําหนดออปชั่นบนออปชั่นบาร 
3. ใชเมาสรูป + คลิกลากบนรูปภาพใหไดขนาด และรูปทรงตามตองการ 

• ถาตองการสรางรูปสี่เหล่ียมจัตุรัส วงกลม หรือคงสัดสวนเดิมของรูปทรงสําเร็จรูปใหกดคีย  
Shift คางไวดวยขณะที่คลิกลากเมาส 
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• ถาตองการใหรูปทรงขยายตวัออกจากจุดเริ่มตนคลิกลากเมาส ก็กดคีย Alt คางไวดวย 
 

 
 
 
 
 
 
 

ออปชั่นของเครื่องมือ Shape ชนิดตาง ๆ  
 เมื่อเราคลิกเลือกเครื่องมือสรางรูปทรงแตละชนิด บนออปชั่นบารจะแสดงออปชั่นสําหรับเครื่องมือนั้นๆ ซ่ึงจะมี
บางสวนที่เหมอืนกัน ไดแก 

• ปุม Shape layers        และปุม        Paths ซ่ึงมีรายละเอียดเหมือนกบัออปชั่นของเครื่องมือ Pen  
• ปุม Full pixels         สําหรับสรางรูปทรงเปนภาพบิตแมพขึ้นบนเลเยอรปจจุบันโดยตรง (ผลที่ไดจะไม

เปน Path และไมเปน Shape) โดยภาพที่ไดจะถูกเติมดวยสี Foreground เมื่อเราคลิกปุมนี้จะปรากฏ
ออปชั่นเพิ่มเตมิใหเราปรับคาตางๆ ซ่ึงไดแก ออปชั่น Mode, Opacity และ Anti-aliased  

 
สําหรับออปชั่นเฉพาะของเครื่องมือแตละชนิดนั้นเราจะตองคลิกปุม        เพื่อเปดรายการออปชั่นยอยออกมา 
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เทคนิคการใชสี 
โหมดสีของ Photoshop 
 โหมดสีใน Photoshop แบงออกเปน 8 โหมดซึ่งแตละโหมดกแ็ทนธรรมชาติของการใชงานรูปภาพในลักษณะ
ตางๆ กัน เชน การพิมพ 4 สี (CMYK) การแสดงบนจอภาพ (RGB) การพิมพสีพิเศษ (Duotone) และภาพลายเสน (Bitmap) 
เปนตน ทั้งนีเ้ราสามารถแปลงภาพจากโหมดหนึ่งไปยังอีกโหมดหนึ่งไดตามความจาํเปนในการใชงานของเรา แตก็ให
ระลึกเสมอวาแตละโหมดมเีราสมบัติไมเหมือนกัน ดังนัน้จึงอาจมีความเพี้ยนเกิดขึน้ในการแปลงคาสีแตละครั้ง โหมดสี
ตางๆ ใน Photoshop ไดแก 
 
โหมดสี RGB  
 เปนการแสดงสีของแตละพกิเซลที่เกิดจากการผสมกันของแสงสี 3 สี ตามโมเดลสีแบบ RGB ไดแก 

• Red สีแดง (R) 
• Green สีเขียว (G) 
• Blue สีน้ําเงิน (B) 
การผสมกันของทั้งสามสีทําใหเกิดสีสันทีแ่ตกตางกันออกไปตามระดบั เชน สีเหลืองสดประกอบดวย Red ที่

ระดับ 248 Green ที่ระดับ 237 และ Blue ที่ระดับ 55 เปนตน 
ระดับของแตละสีมีคาไดตั้งแต 0 จนถึง 255 (รวม 256 ระดับ) ซ่ึงเมื่อผสมทั้ง 3 สีดวยกนัในระดับ 255 ก็จะทําให

ไดสีขาว แตถาผสมกันที่ระดับ 0 ทุกสีก็จะไดสีดํา นอกจากนี้เมื่อผสมทุกสีใหมีระดบัเทาๆ กันก็จะไดสีเทาซึ่งมนี้ําหนกั
ออนแกตางกนัไปตามระดบัสีที่ผสม 

รูปภาพในโหมด RGB สีหลักทั้ง 3 จะแยกกันอยูคนละแชนแนล (Channel) ดังนั้นภาพ RGB จึงประกอบดวย
แชนแนลของสีหลัก 3 แชนแนลคือ Red, Green และ Blue เนื่องจากแตละสีจะมีน้ําหนักออนแกได 256 ระดับหรือเทากับ
เลขฐานสอง 8 บิต ดังนั้นแตละจุดในภาพจงึเกิดจากขอมลู 3 แชนแนล x 8 บิต = 24 บิต ทําใหแตละจุดสามารถแสดงสีได
มากถึง 16.7 ลานสี (224)  

 
โหมดสี CMYK 
 สีแบบ CMYK เปนสีที่ใชในงานพิมพดวยหมึกพิมพ 4 สีตามโมเดลสีแบบ CMYK โดยมีพื้นฐานบนคุณภาพในการ
ดูดซับสีของหมึกที่พิมพบนกระดาษเมื่อแสงกระทบกระดาษ สีบางสวนจะถูกกระดาษดูดซับไว และที่เหลือก็สะทอนมาเขา
ตาของเรา 
 สี 3 สีแรก ไดแก 

• Cyan สีฟา (C) 
• Magenta สีแดงมวง (M) 

 



 

 23 

 
• Yellow สีเหลือง (Y) 

ในทางทฤษฏีเมื่อใชทั้ง 3 สีขางตนก็นาจะเพียงพอแลวในการผสมกันเพื่อใหไดผลลัพธเปนสีอ่ืนทุกๆ สี และ
สามารถผสมเปนสีดําไดดวยเชนกนั แตในทางปฏิบัติแลว สีทั้ง 3 กลับผสมกันไดเพียงสีน้ําตาลเขมดังนั้น
เพื่อใหไดสีดําสนิท จึงจําเปนตองมีหมึกสดีํามาผสมดวยอีกสีหนึ่ง สีดาํจึงเปนสีที่ 4 นัน่คือ 

• Black สีดํา แตถาใชตัวยอเปน B อาจสับสนกับสีน้ําเงนิ จึงตองใชตวั K แทน 
 

 โหมดสี CMYK ใน Photoshop แตละพิกเซลจะประกอบดวยคาเปอรเซ็นตของแตละสีหมึกพิมพโดยที่ 0% ทําให
ไดสีออนสุด และ 100 % ทําใหไดสีเขมสุดของหมึกนั้นๆ เชน สีเหลืองสดจะประกอบดวย C = 6%, M = 0%, Y = 88% 
และ K = 0% 

เราสามารถแปลงภาพจากโหมด RGB ไปเปน CMYK เพื่อสงโรงพิมพไดโดยมกีารสูญเสียคุณภาพของภาพไปแลว
บางแตก็ไมมากนัก อยางไรกต็ามทางที่ดีแลวถาเราเริ่มทํางานกับภาพ RGB ควรแกไขภาพใหเรียบรอยกอนจึงคอยแปลงไป
เปน CMYK ในขั้นตอนสุดทายแตในกรณีที่สแกน หรืออิมพอรตภาพมาในโหมด CMYK อยูแลวเราก็สามารถทํางานใน
โหมดสี CMYK ไดโดยตรงเชนกัน เพียงแตเราสมบัติบางอยางจะใชไมได เชน ฟลเตอรบางตัวเปนตน 
 
โหมดสี Lab 
 สีในโหมดนี้ถูกกําหนดขึ้นเพื่อเปนมาตรฐานในการวัดคาสีเพื่อการสราง หรือเพื่อแสดงผลงานออกมาโดยไม
คํานึงถึงอุปกรณที่นํามาใช เชน จอมอนิเตอร เครื่องพิมพ หรือสแกนเนอร คือ เปนไปตามโมเดลสีแบบ CIE L*a*b นั่นเอง 
(ตัดเครื่องหมาย * ออกไปจากชื่อโมเดล) สีในโหมด Lab ประกอบดวยองคประกอบตอไปนี ้

• L (Luminance) หรือสวนทีเ่ปนความสวาง 
• a คือ คาสีที่ไลตั้งแตสีเขียวถึงสีแดง(คามากจะหนกัไปทางสีแดง สวนคานอยจะหนกัไปทางสีเขียว) 
• b คือ คาสีที่ไลตั้งแตสีน้ําเงินถึงสีเหลือง(คามากจะหนกัไปทางสีเหลือง สวนคานอยจะหนกัไปทางสีน้ําเงิน) 
 
สําหรับใน Photoshop นั้น ในองคประกอบสวน L จะมรีะดับตั้งแต 0 ถึง 100 องคประกอบสวน a และ b มีระดบั

ตั้งแต +120 ถึง -120 
สีในโหมด Lab นี้เปนสีที่ Photoshop ใชเปนตัวกลางในการแปลงสีจากโหมดหนึ่งไปเปนอีกโหมดหนึ่ง โดย

แปลงใหเปนสีในโหมด Lab กอน (เปนการทํางานภายในของโปรแกรมเอง) 
สําหรับสีในโหมดอื่นๆ นอกจากนี้คือ Bitmap, Grayscale, Duotone, Index Color และ Multichannel จะเปน

โหมดสีที่ใชในกรณีพเิศษ เชน การพิมพดวยเทคนิคบางอยางดังนี ้
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โหมดสี Bitmap 
 สีในโหมดนีจ้ะมีเพยีง 2 สี คือ สีขาว และสดีําเทานั้น โดยไมมีคากลางๆ เชนสีเทา ภาพที่ไดจึงเปนเหมือนกับภาพ
ลายเสนที่วาดดวยปากกาเขียนแบบ ถาเราตองการแปลงภาพสี (โหมด RGB, CMYK, Lab ฯลฯ) ไปเปนโหมด Bitmap เรา
ตองแปลงภาพนั้นใหอยูในโหมด Grayscale เสียกอน นอกจากนั้นภาพในโหมดนีจ้ะมีเลเยอรไมได และโปรแกรมจะยุบ
ใหเหลือเพียงเลเยอร Background 
 
โหมดสี Grayscale 
 สีในโหมดนี้มรีะดับสีเทาทั้งหมด 256 ระดบั โดยแตละพกิเซลของภาพจะมีคาความสวางตั้งแต 0 (สีดํา) ถึง 255 (สี
ขาว) แตสวนใหญในโปรแกรมจะใหเรากําหนดคาสีในรูปเปอรเซนต ตั้งแต 0% (สีขาว) จนถึง 100 % (สีดํา) ภาพในโหมด
นี้จะมีลักษณะเหมือนกับภาพถายขาวดํานัน่เอง 
 ในการแปลงภาพสีใหเปนโหมด Grayscale นั้นโปรแกรมจะทิ้งรายละเอียดของสทีี่อยูในภาพตนฉบับไปหมด 
เหลือไวแตโทนสีเทาเทานั้น ซ่ึงเราก็สามารถแปลงภาพ Grayscale นี้กลับไปเปนโหมด RGB, CMYK หรือ Lab เพื่อเพิ่มสี
ใหกับภาพนั้นตอไป 
 
โหมดสี Duotone 
 โหมดนี้ใชสรางภาพดวยชุดสีที่เราเลือก โดยสามารถใชสีไดตั้งแต 1-4 สีมาผสมกัน ทําใหไดภาพที่มีความเปรียบ
ตาง (Contrast) สูงกวาภาพขาวดํา ธรรมดา ไดแก 
 

• Monotone ประกอบดวย 1 สี 
• Duotone ประกอบดวย 2 สี 
• Tritone  ประกอบดวย 3 สี 
• Quadtone ประกอบดวย 4 สี 
 

โหมดสี Indexed Color 
 ภาพในโหมดนี้ใชสีไดมากที่สุดแค 256 สี โดยเมื่อมีการแปลงภาพใหเปนโหมด Indexed โปรแกรม Photoshop 
จะสรางภาพใหม โดยใชสีในตารางสี (Palette) ที่มีจํานวนจํากัดเพียงไมเกิน 256 สีมาเปรียบเทียบ และแทนที่สีเดิมในภาพ 
ถาสีของภาพเดิมไมปรากฏในตารางสีที่ใชนั้น โปรแกรมก็จะเลือกสีที่ใกลเคียงที่สุดมาแทน ดังนั้นคณุภาพของภาพที่เก็บ
ในโหมดนี้จึงขึ้นกับการเลือกเก็บสีในตารางสีเปนสําคัญ 
 การใช Indexed Color ทําใหขนาดของไฟลลดลงเนื่องจากการจํากัดปริมาณของสีใหเหลือนอยลง แตสีของภาพก็
จะเพีย้นไปดวย 
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โหมดสี Multichannel Color 
 โหมดนี้ใชสีเทา 256 ระดับสีในแตละแชนแนลสีในโหมด Multichannel มีประโยชนในการกําหนดสีพิเศษใหกับ
การพิมพ 
 เมื่อเราแปลงภาพสีใหเปน Multichannel แลวแชนแนลในภาพเดิมจะถูกแปลงใหเปน Spot Color Channel ซ่ึง
เปนแชนแนลที่เราสามารถเพิ่ม/ลบแชนแนล หรือเปลี่ยนสีใหกับแชนแนลนั้นไดเพือ่สรางผลลัพธพิเศษ 
 เมื่อเราลบแชนแนลออกจากรูปภาพในโหมด RGB, CMYK หรือ Lab ภาพนั้นก็จะกลายเปนภาพในโหมด 
Multichannel ไปโดยอัตโนมัติ 
 
การแปลงโหมดสี 
 เมื่อเราเปลี่ยนโหมดภาพของเราไปเปนโหมดสีอ่ืน ก็เทากับวาเราไดเปลี่ยนแปลงคาของสีในภาพไปอยางถาวร เชน 
เมื่อแปลงภาพ RGB ไปเปน CMYK คาของสี RGB ที่อยูนอกขอบเขตของสี CMYK ก็จะถูกปรับใหอยูภายในของเขตของสี 
CMYK ที่ใกลเคียงซึ่งอาจมีความเพีย้นเกิดขึ้นได ดังนั้นกอนการแปลงโหมดสี เราควรทําการปรับแตงภาพในโหมดสีเดิมให
ไดมากที่สุดเทาที่จะทําไดเสยีกอน และกอนการแปลงก็ควรเก็บภาพตนฉบับไวดวย เพื่อใหสามารถกลับมาแกไขภาพใน
โหมดเดิมไดถาตองการ นอกจากนีใ้นบางกรณีจะตองมกีารยุบรวมเลเยอรทั้งหมดของภาพใหเปนเลเยอร Background ใน
กรณีที่เราไมไดรวมเลเยอรไวกอนโปรแกรมจะแสดงไดอะล็อกบ็อกซ ใหเรายนืยนัการรวมเลเยอรกอนการแปลงโหมดให 
 ในการแปลงภาพจากโหมดหนึ่งไปยังอีกโหมดหนึ่งใหเลือกคําสั่ง Image > Mode > ช่ือโหมดสีที่ตองการ 
 สําหรับบางโหมด เชน Bitmap และ Duotone เราจําเปนตองแปลงใหเปน Grayscale กอนจึงจะสามารถแปลงให
เปน Bitmap หรือ Duotone ได 
 
สี Foreground และ Background 
 การเลือกสีเพือ่นําไปใชในการตกแตงภาพนั้นสีที่เราเลือกจะไปปรากฏที่ชอง Forground (FG) หรือชอง 
Background บนทูลบ็อก 
 เราสามารถสลับสีระหวาง FG และ BG ไดโดยคลิกที่ไอคอน        ขางๆ ชองสี ถาตองการปรับสีใหเปนคาเริ่มตน  
ใหคลิกไอคอน        ก็จะทําใหสี FG เปน เปลี่ยนสีเปนสดีํา  และสี BG เปนสีขาว 
 ในการกําหนดสีใหกับ FG และ BG ใหเราคลิกบนแตละชองเพื่อเลือกสีจากไดอะล็อกบ็อก Color Picker 
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การเลือกสีดวย Color Picker  
 เมื่อเราคลิกเลือกสี FG หรือ BG บนทูลบ็อกเพื่อเลือกสีใหม จะปรากฏไดอะล็อกบ็อก  Color Picker ดังนี ้
 
 
 
 
 
 
 
 
 
 
 
 

การเลือกสีดวย Color Picker มีขั้นตอนดงันี้ 
1. ตัดสินใจวาตองการเลือกสีโดยใชโมเดลสีแบบใด  
2. เล่ือนสไลเดอร หรือคลิกบนแถบเพื่อเลือกคาสีขององคประกอบแรก 
3. คลิกบนกรอบสี่เหล่ียมใหญเพื่อเลือกสีที่ตองการ 
4. คลิก OK จากนั้นสีที่เราเลือกจะไปปรากฏบนชอง Forground หรือ Background 
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เทคนิคการสราง Selection แบบมืออาชีพ 

ในการตกแตงภาพดวย Photoshop นั้นการเลือกสวนที่ตองการโดยใช Selection ถือเปนคุณสมบัตทิี่สําคัญมาก 
เพราะขั้นตอนนี้มีความจําเปนตอการทํางานตางๆ ไมวาจะเปนการตัดสวนที่ไมตองการออกจากภาพ การสรางเอฟเฟคต
เฉพาะสวนที่เลือกไวการคัดลอกสวนที่เลือกไวเพื่อนําไปใชกับไฟลอ่ืน ฯลฯ 
 ตอไปนี้เปนตวัอยางของการตกแตงภาพทีต่องอาศัยการสราง Selection  

• การนําภาพคนไปวางไวบนภาพทิวทัศน เราตองสราง Selection เพื่อเลือกตัดภาพคนออกมาจากฉากหลังกอน
แลวนําภาพคนนั้นไปวางไวบนภาพทวิทัศน 

• การทําฉากหลงัของภาพใหเบลอเพื่อสรางความเดนชดัใหกับออปเจ็คหลักของภาพ เราตองเลือกสวนที่เปน
ฉากหลังแลวใชฟลเตอรเพิ่มความเบลอใหฉากหลัง 

• การสรางภาพที่ฉากหลังโปรงใสเพื่อนําไปใชกับเว็บเพจ เราตองเลือกสวนที่เปนฉากหลังแลวตดัออกจากภาพ 
• การสรางรูปทรงเรขาคณิต เราอาจตองสราง Selection ใหมีรูปทรงตามที่ตองการกอนแลวจงึเติมสีภายใน 

หรือลงสีที่ขอบนอกของรูปทรงนั้น 
เสน Selection มีลักษณะเปนเสนประที่เคลื่อนไหวรอบบริเวณที่เลือกไวเครื่องมือในการสราง Selection ของ 

Photoshop มีอยูหลายประเภท ซ่ึงแตละประเภทก็เหมาะกับงานที่แตกตางกันออกไปซึ่งทุกประเภทจะมีออปชั่นทีใ่ช
สําหรับปรับแตงคาเพื่อใหการทํางานเปนไปไดอยางทีต่องการ 

 
เครื่องมือในกลุม Marquee 
 เครื่องมือในกลุม Marquee เปนเครื่องมือที่ใชในการสราง Selection เปนรูปทรงเรขาคณิต ประกอบดวย
เครื่องมือ 4 ชนิดไดแก 

เครื่องมือ Rectangular ใชสราง Selection เปนพืน้ที่ส่ีเหล่ียม 
เครื่องมือ Elliptical Marquee ใชสราง Selection เปนพืน้ที่วงกลม/วงรี 
เครื่องมือ Single Row Marquee ใชสราง Selection แนวนอนที่มีความสูง 1 พิกเซล 
เครื่องมือ Single Column Marquee ใชสราง Selection แนวตั่งที่มคีวามกวาง 1 พิเซล 
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การใชเครื่องมือ Rectangular และ Elliptical Marquee 
 เครื่องมือ  Rectangular Marquee ใชเลือกพื้นที่เปนรูปสี่เหล่ียม และเครื่องมือ Elliptical Marquee ใชเลือกพืน้ที่
เปนวงกลม/วงรี โดยเครื่องมือทั้งสองนี้มีวธีิใชงาน และออปชั่นที่เหมอืนกันดังตอไปนี้ 

1. เลือกเครื่องมือ Rectangular Marquee หรือ Elliptical Marquee 
2. กําหนดออปชั่นของเครื่องมือบนออปชั่นบาร 
3. ใชเมาสรูป + คลิกคางไวที่ตาํแหนงหนึ่งแลวลากไปอีกตาํแหนงหนึ่งกจ็ะปรากฏเสนในแนวนอน หรือแนวตั้ง

ขึ้นมา 1 เสนเราสามารถคลิกเมาสคางไวแลวลากไปในแนว หรือแนวตั้งได ซ่ึงจะทําตําแหนงของเสน 
Selection เปลี่ยนไป 

 
 

 
 
 
 
 
 

 
ออปชั่น Feather 
 Feather คือ ออปชั่นที่ใชกําหนดการฟุงกระจายบริเวณขอบของ Selection โดยระบเุปนจํานวนพกิเซลออปชั่นนี้
มีอยูในเครื่องมือที่ใชสราง Selection 

การกําหนดคา Feather สามารถทําไดดังนี ้
กําหนดคากอนการสราง Selection  
 การกําหนดการฟุงกระจายบริเวณขอบวิธีนีท้ําไดโดยปอนตัวเลขลงในชอง Feather ของออปชั่นบารซ่ึง
จะมีอยูในเครือ่งมือที่ใชสราง Selection ทุกชนิดยกเวน Magic Wand 
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การใชเครื่องมือ Lasso  
 การสราง Selection ดวยเครื่องมือ Lasso             ทําไดโดยใชเมาสคลิกลากไปรอบๆ บริเวณที่ตองการ 

1. คลิกเลือกเครื่องมือ Lasso 
2. กําหนดออปชั่นบนออปชั่นบาร 
3. ใชเมาสคลิกลากรอบพื้นที่ทีต่องการจนครบซึ่งการยุติเสน Selection มี 2 วิธีคือ 

• ลากเมาสมาบรรจบกับจุดเริม่ตนโดยไมปลอยเมาส 
• ปลอยเมาสที่ตําแหนงหนึ่ง กจ็ะเกิดเสนตรงเชื่อมตอจุดเริม่ตนกับจดุสุดทายโดยอัตโนมัติ 

 
                                 
 
 
 
 
 
 
 
 
 
 
 
 
 

การใชเครื่องมือ Magic Wand  
 Magic Wand            เปนเครื่องมือที่ใชสราง Selection ตามคาสีของตําแหนงทีเ่ราคลิกลงไป เชน ถาคลิกบน
พื้นที่สีเขียวของพริก เครื่องมือนี้ก็จะสราง Selection ครอบคลุมบริเวณที่เปนสีดังกลาวรวมทั้งสีใกลเคียงใหโดยอัตโนมัติ 
โดยเราสามารถกําหนดความแตกตางของระดับสีไดจากออปชั่น Tolerance 
 มีวิธีการใชงาน Magic Wand มีดังนี ้

1. คลิกเลือกเครื่องมือ Magic Wand 
2. กําหนดออปชั่นของเครื่องมือบนออปชั่นบาร 
3. ใชเมาสคลิกภายในบริเวณทีต่องการเลือก 1 คร้ัง 
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การเลือกรูปภาพทั้งรูป 
 การเลือกรูปภาพทั้งรูปสามารถทําไดโดยใชคําสั่ง Select  >  All หรือกดคีย Ctrl+A ทุกๆ พิกเซลในภาพจะถูก
เลือกแบบ 100% 
 
 
 
 
 
 
 
 
การสลับ Selection  
 การสลับ Selection หมายถึง การเปลี่ยนสวนที่ถูกเลือกไวใหกลายเปนสวนที่ไมถูกเลือก และเปลีย่นสวนที่ไมถูก
เลือกใหกลายเปนสวนที่ถูกเลือก และในกรณีที่พิกเซล ถูกเลือกบางสวน มันจะกลับเปอรเซ็นตจากเดิม เชน พกิเซลที่ถูก
เลือก 60 % เมื่อสลับ Selection แลวมันจะถูกเลือก 40% 
 สถานการณที่เหมาะกับการสลับ Selection คือ เมื่อเราตองการเลอืกออปเจ็คที่อยูบนฉากหลังที่มสีีเดียว (หรือฉาก
หลังที่มีลวดลายไมมากนัก) ทั้งนี้โดยใชเครื่องมือ Magic Wind เลือกสวนที่เปนฉากหลังกอนหลังจากนั้นจึงทําการสลับ 
Selection เพื่อใหออปเจ็คเปาหมายถูกเลอืกแทน 
 ขั้นตอนการสลับ Selection มีดังนี ้

1. สราง Selection 
2. เลือกคําสั่ง Select  > Inverse หรือกดคยี Shift + Crtl + l 

 
 
 
 
 
 
 
 
 
 
การยกเลิก Selection  
 การยกเลิก Selection สามารถทําไดงายๆ โดยขณะที่กําลังเลือกเครื่องมือ Marquee อยูใหคลิกเมาสบนพื้นที่ที่อยู
นอก Selection ก็จะทําใหเสน Selection หายไป  
 การยกเลิก Selection อีกวิธีหนึ่ง คือ การเลือกคําสั่ง Selection > Deselect จากเมนบูารหรือกดคีย Ctrl + D 
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การใชงาน Layer เพ่ือจัดลําดับการซอนภาพ 

เลเยอร เปรียบเสมือนแผนใสที่ใชในการจดัวางออปเจ็ค โดยบริเวณที่ไมไดจัดวางออปเจ็คก็จะโปรงใส มองเห็น
ออปเจ็คอื่นดานลางได เราสามารถวางออปเจ็คไวบนเลเยอรคนละเลเยอรกัน หลังจากนั้นจึงนํามาจดัเรียงซอนกนัเพื่อใหได
ภาพที่ตองการ 
 การใชเลเยอรจะทําใหสามารถแกไขรูปภาพเฉพาะสวนใดสวนหนึ่งไดงาย สามารถเคลื่อนยาย หรือเปลี่ยนขนาด
ของออปเจ็คในเลเยอรตางๆ ไดอยางเปนอสิระจากกนัโดยเฉพาะอยางยิง่การทดลองสรางงานหลายๆ รูปแบบบนแตละ 
เลเยอรจากนัน้จึงสลับการซอน และแสดงเลเยอรตางๆ เพื่อดูผลลัพธของงานถาไมถูกใจรูปแบบใดก็เลือกลบไดทัง้เลเยอร 
 ยกตวัอยาง เชน ในการจัดรูปสวน เราอาจจัดวางตนไมหลากหลายชนิดไวในแตละเลเยอรแลวลองแสดงบางตน
ซอนบางตนไวเพื่อดวูาเหมาะสมลงตัวกับภาพ หรือไมหรือการเคลื่อนยายตําแหนงตนไมก็เลนกัน เราอาจเลือกยายตนใดก็
ได ซ่ึงจะไมสงผลกระทบตอตนอื่นในรูปภาพ 
 การเปลี่ยนลําดับการซอนของภาพก็ทําไดงายดายโดยเพยีงแคลากเลเยอรไปวางไวในลําดับชั้นที่ตองการลําดับการ
ซอนจะสงผลตอภาพที่ปรากฏทั้งนี้ภาพบนเลเยอรดานบนจะบดบังภาพดานลางไวแตสําหรับสวนที่ไมมีภาพ หรือสวนที่
วางๆ ก็จะมองทะลุไปยังเลเยอรดานลางได 
 
รูจักกับพาเล็ต Layer 
 ในการใชเลเยอรเราจําเปนตองรูจักกับพาเล็ต Layer ซ่ึงเปนสวนหลักที่ใชควบคุมการทํางานไมวาจะเปนการเพิม่ 
เลเยอร เปลี่ยนลําดับการซอนทับ การปรับความโปรงใส ฯลฯ  
 การเปดพาเล็ต Layer ทําไดโดยเลือกคําสั่ง Window > Layer 
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เลเยอร Background  
 กอนที่จะเรียนรูการใชงานเลเยอรผูเขียนอยากใหเราไดเขาใจความแตกตางระหวางเลเยอร Background กับ 
เลเยอรธรรมดาเสียกอนเนื่องจากเลเยอร 2 แบบนี้มีเราสมบัติที่แตกตางกันออกไป 
 ตามปกติเมื่อเราเปดไฟลรูปภาพทั่วๆ ไปเขามาใชใน Photoshop ภาพนั้นจะอยูในเลเยอร Background เมื่อเรา
สราง Selection และกดคีย Delete เพื่อตดัฉากหลังออกไป พื้นที่ของสวนที่ถูกตัดจะถูกเติมเต็มดวยสี Background (สีที่
แสดงอยูในชอง Background Color บนทลูบอ็กซ) 
 
 
 
 
 
 
 
 
 
 
 

เลเยอร Background จะอยูในลําดับลางสุดเสมอและจะถูกล็อคไวไมใหมีการเคลื่อนยายโดยสังเกตไดจากไอคอน          
       ที่ดานหลังของเลเยอร 
 ในการตกแตงภาพหรือสรางเอฟเฟคตที่ซับซอนเราอาจตองการใหฉากหลังของภาพกลายเปนพืน้แบบโปรงใส ซ่ึง
สามารถทําไดดวยการเปลี่ยนเลเยอร Background ไปเปนเลเยอรธรรมดา โดยดับเบลิคลิกที่เลเยอร Background แลว
ปอนชื่อใหมในชอง Name (ช่ือที่โปรแกรมตั้งใหกอนคอื Layer 0) บนไดอะล็อกบอ็กซ New Layer แลวคลิกปุม ok ก็จะ
สงผลใหเลเยอร Background กลายเปนเลเยอรธรรมดาชื่อ Leyer0 (หรือช่ืออ่ืนที่เรากาํหนดเอง) 
 
      
 
 
 
 หลังจากนี้เมื่อเราตัดฉากหลังของภาพบนเลเยอร Layer 0 ออกไป สวนที่ถูกตัดจะกลายเปนพืน้โปรงใสซึ่ง 
Photoshop จะแสดงใหเห็นในลักษณะของตารางขาวสลับเทา 
 



 

 33 

 
 
 
 
 
 
 
 
 
 
 
 สําหรับการแปลงเลเยอรธรรมดาใหเปน Background ทําไดโดยเลือกคําสั่ง Layer > New  > Background 
From Layer ซ่ึงถาหากเลเยอรดังกลาวอยูที่ระดับชั้นบนๆ มันจะถูกยายลงมาระดับลางสุดโดยอัตโนมัติ 
 
การสรางเลเยอรใหม 
 ในการปรับแตงรูปภาพเราควรวางออบเจ็คแตละชิ้น แยกไวคนละเลเยอรกันเพื่อใหงายตอการแกไขในภายหลัง ไม
วาจะเปนการเคลื่อนยาย การแกไขเฉพาะสวน หรือแมแตการลบทิ้ง 
 การสรางเลเยอรใหมทําได ดังนี ้

• คลิกปุม New Layer           ที่อยูดานลางของพาเล็ต Layer 
 
 
 
 
 
 
 
 
 

เราจะไดเลเยอรใหม(ชองทีมสีีน้ําเงิน) ช่ือ Layer 1 โดยอัตโนมัติ (ช่ือเลเยอรที่ถูกสรางขึ้นมาใหมจะ
เรียงตามลําดับกันไปจาก Layer1 , Layer 2 , Layer 3,..) 
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ออปชั่นบนไดอะล็อกบ็อกซ New Layer 

ออปชั่นบนไดอะล็อกบ็อกซ New Layer จะประกอบดวยออปชั่นที่ใชกําหนดเราสมบัติของเลเยอร (ซ่ึงเรา
สามารถเลือกไวเลย หรือจะเก็บไวกําหนดในภายหลังกไ็ด) ดังนี ้

• Name ช่ือเลเยอรสําหรับใชแสดงบนพาเล็ต Layer โดยเราสามารถใชช่ือภาษาไทยได 
• Group With Previous Layer สรางเอฟเฟคตพิเศษดวยการใชออบเจ็คในเลเยอรลางมาบังรูปภาพในเลเยอรที่ 
       สรางมาใหม 
• Color สีเลเยอร ใชสําหรับแสดงบนพาเล็ต Layer เพื่ออํานวยความสะดวกใหเราแยกประเภท หรือกลุมเลเยอร

ดวยสายตาไดงายโดยไมมีผลตอการทํางานของโปรแกรม 
• Mode โหมดในการผสมสีของรูปภาพบนเลเยอรนี้กับเลเยอรอ่ืนที่อยูขางลาง (ดูเพิ่มเตมิในหวัขอ การผสม 

เลเยอร) 
• Opacity กําหนดความโปรงใสของเลเยอร และเอฟเฟคที่ใชในเลเยอร (ดูเพิ่มเติมในหวัขอ การกําหนดคาความ

โปรงใสของเลเยอร) 
• Fill with <mode> neutral color  ออปชั่นนี้จะใชไดเฉพาะกับบางโหมด โดยจะเปนการเติมสีกลาง (neutral 

color) ลงไปบนเลเยอรที่สรางใหมโดยอัตโนมัติ สีกลาง หมายถึง สีที่ปกตจิะไมมีผลใหเกิดความเปลี่ยนแปลง
ตอภาพโดยรวมเมื่อเลเยอรนัน้อยูในโหมดที่เลือกไว แตถามีการใสเอฟเฟคตใหเลเยอร (ซ่ึงทําใหสีกลาง
เปลี่ยนไป) ก็จะทําเกดิผลตางๆ ขึ้น สีกลางอาจเปนสีขาว ดํา หรือสีเทา 50%แลวแตกรณี 

 
 

การก็อปปเลเยอรในไฟลเดียวกัน 
 การก็อปปเลเยอรสามารถทําไดในไฟลเดยีวกันโดยมวีิธีดังนี ้

• คลิกลากเลเยอรที่ตองการกอปปไปวางบนปุม New Layer             ที่ดานลางของพาเล็ต Layer โปรแกรมจะ
สรางเลเยอรใหมซอนขึ้นมาใหโดยช่ือของเลเยอรใหมจะเกิดจากการนําชื่อเดิมตอทายดวยคําวา copy 
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การลบเลเยอร 
 การลบเลเยอรจะสงผลใหทกุสิ่งทุกอยางทีอ่ยูในเลเยอรถูกลบไปทั้งหมด ดังนั้นกอนที่เราจะตัดสินใจลบเลเยอรใด
ออกจากพาเล็ต Layer จึงควรพิจารณาใหดใีนกรณีที่ตองการทดลองจัดวางองคประกอบแบบตางๆ ขอแนะนําใหใชวิธี
ซอน/แสดงเลเยอร แทนการลบจนกวาจะแนใจวาไมใชเลเยอรนั้นแลวจริงๆ 

• ใชเมาสคลิกลากเลเยอรที่ตองการลบไปวางบนปุม Delete Layer             ที่ดานลางของพาเล็ต Layer 
โปรแกรมจะทาํการลบเลเยอรใหเรียบรอย 

 
การเปลี่ยนชื่อเลเยอร 
 เมื่อเราสรางเลเยอรใหมดวยการคลิกปุม New Layer บนพาเล็ต Leyer หรือดวยการกอปปเลเยอรจากไฟลอ่ืน 
โปรแกรมจะกาํหนดชื่อเลเยอรใหมใหโอยอัตโนมัติตามลําดับคือ Layer1, Layer 2, Layer 3 แตเพื่อใหงายตอการจําแนก
และจดจําเราควรเปลี่ยนชื่อของเลเยอร ตามขั้นตอนตอไปนี้ 

1. คลิกเลือกเลเยอรที่ตองการเปลี่ยนชื่อ 
2. ดับเบิลคลิกในชองชื่อ Layer  
3. ปอนชื่อเลเยอรใหมในชองชือ่เลเยอร  
4. คลิกปุม Enter 

 
 
 
 
 
 
 

การเลือกเลเยอรท่ีตองการใชงาน 
 ในการทํางานตางๆ ไมวาจะเปนการวาดภาพการตัดภาพ การเคลื่อนยายออปเจ็ค ฯลฯ เราจําเปนตองเลือกเลเยอรให
ถูกตอง มิฉะนัน้จะทําใหเกิดความผิดพลาด เชน ถาเราตองการยายตําแหนงรูปผลไมแตกลับเลือกเลเยอรที่เปนภาพเด็กไว 
ภาพเดก็กจ็ะถกูยายตําแหนงแทนเปนตน 
 การเลือกเลเยอรใน Photoshop สามารถทําได 2 วิธีคือ คลิกเลือกจากพาเล็ต Layer และการเลือกดวยเครื่องมือ 
Move  
 ในกรณเีลือกโดยใชพาเล็ต Layer ใหเราคลิกตรงชื่อ หรือตรงภาพตัวอยางของเลเยอรที่ตองการ แถบชื่อของเลเยอร
นั้นจะเปลี่ยนเปนสีน้ําเงินและมีไอคอน         ปรากฏขึ้นในชองดานหนา 
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 เราสามารถเลือกไดคราวละเลเยอรเดียวเทานั้นถาหากตองการทํางานกบัหลายเลเยอรพรอมๆ กันใหจัดเลเยอร
เหลานั้นเปนหมวดหมูเดยีวกนัโดยใช Layer Set 
 
 
 
 
 
 
การเปลี่ยนลําดับเลเยอร 
 ลําดับของเลเยอรสงผลตอการซอนทับกันของออปเจ็คตางๆ ในเลเยอรเหลานั้น โดยออปเจ็คของเลเยอรที่อยู
ดานบนของพาเล็ต Layer จะบังออปเจ็คของเลเยอรดานลาง 
 วิธีการเปลี่ยนลําดับของเลเยอรใหเราใชเมาสคลิกลากเลเยอรไปวางในลําดับที่ตองการไดเลย (คลิกลากตรงชื่อ 
หรือภาพตวัอยางเทานัน้) 
  
 
 
 
 
 
 
 
การซอน/แสดงเลเยอร 
 การซอนเลเยอรเปนการซอนเนื้อหาของเลเยอรนั้นไมใหปรากฏบนภาพ เพื่อประโยชนในการทดลองจัดภาพทีม่ี
องคประกอบตางๆ กัน และเมื่อตองการใชออปเจ็คนั้นอกีเราก็เพยีงสั่งใหแสดงเลเยอรนั้นขึ้นมา 
 วิธีการซอนเลเยอรใหเราใชเมาสคลิกไอคอนรูปดวงตา        ดานหนาเลเยอรที่ตองการซอน ใหรูปดวงตาหายไป          
ออปเจ็คของเลเยอรนั้นก็จะไมปรากฏบนรูปภาพ 
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 เมื่อตองการแสดงเลเยอรใหเราคลิกชองนั้นอีกครั้งเพื่อใหปรากฏไอคอนรูปดวงตาออปเจ็คของเลเยอรนั้นกจ็ะ
กลับมาปรากฏบนรูปภาพอกีครั้งหนึ่ง 
 
 
 
 
 
 
 
 
การลิงคเลเยอร (Link Layer) 
 การลิงคคือการเชื่อมโยงเลเยอรตั้งแต 2 เลเยอรเขาไวดวยกัน ทําใหเราสามารถเคลื่อนยาย และปรับเปลี่ยน 
(Transform) ภาพในเลเยอรไดพรอมๆ กันรวมถึงสามารถจัดเรียงออปเจ็ค จัดระยะหางระหวางออบเจ็คในแตละเลเยอร
และกอปปเลเยอรในกลุมทีลิ่งคไวไปใสในไฟลใหมพรอมๆ กันไดดวย 
 การลิงคเลเยอรมีขั้นตอนดังนี้ 

1. คลิกเลือกเลเยอรที่จะนําไปลงิคกับเลเยอรอ่ืน 
2. คลิกชองวางหลังไอคอนดวงตาในอีกเลเยอรหนึ่งที่ตองการนํามาลิงคเขากับเลเยอรแรกในขอ 1ใหเกิดเปน 
       ไอคอนลูกโซ 
3. ทําขอ 2 ซํ้า เพื่อลิงคเลเยอรอ่ืนๆ เพิ่มเขามาอีกตามตองการ 
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เราสามารถลิงคเลเยอรไดหลายชุด เชน ลิงค Layer 1, Layer 2 และ Layer 4 ในขณะเดียวกันก็ลิงค Layer 3 และ 

Layer 5 แตเลเยอรหนึ่งๆ จะลิงคไดเพียงชดุเดียว เชน ถาลิงค Layer 4 เขากับกลุม Layer 3 และ Layer 5 มันกจ็ะไมอยูใน
กลุม Layer 1 และ Layer 2 อีกตอไป 

หลังจากที่ลิงคเลเยอรเขาดวยกันแลว เมื่อเราเลือกเลเยอรใดเลเยอรหนึ่งในชุด จะปรากฏไอคอนรูป        โซขึ้น         
ดานหนาของทุกเลเยอรที่ลิงคกัน ยกเวนเลเยอรที่กําลังเลือกจะแสดงไอคอน          

เมื่อตองการยกเลิกลิงค  ใหคลิกที่ไอคอน       เพื่อใหรูปลูกโซหายไป 
 
การรวมเลเยอร (Merge)  

การรวมเลเยอร คือ การรวมเนื้อหาของแตละเลเยอรเขาดวยกันเปนเลเยอรเดียว เราสามารถรวมเลเยอรที่ลิงค
ดวยกัน (Merge Linked) และการยุบรวมทุกเลเยอรใหกลายเปนเลเยอร Background(Flatten Image) ซ่ึงมีรายละเอียด
และวิธีการรวมดังนี ้
Mrege Linked 
 Merge Linked เปนการรวมทุกเลเยอรที่ลิงคอยูกับเลเยอรปจจุบันใหกลายเปนเลเยอรเดียว ซ่ึงเลเยอรที่รวมแลวจะ
มีช่ือเหมือนกบัเลเยอรที่คลิกเลือกไวในขณะนั้น 

1. คลิกเลือกเลเยอรที่มีลิงคอยูกับเลเยอรอ่ืน 
2. คลิกปุม > เพือ่เปดเมนู แลวเลือกคําสั่ง Merge Linked 
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เทคนิคการไลสีดวยเคร่ืองมือ Gradient 
 Gradient  เปนเครื่องมือที่อยูในกลุมเดยีวกับ Paint  Bucket โดยใชเตมิสีเชนเดียวกนั  แตจะเปนการเติมสีใน
ลักษณะของการใสโทนสีหรือไลระดับความทึบ/โปรงของสี 

1. กําหนดขอบเขตที่จะเติมสี โดยสราง Selection ลอมรอบบริเวณดังกลาว 
2. เลือกเครื่องมือ Gradient           (อยูในกลุมเดียวกับเครื่องมือ  Paint  Bucket) บนทูลบ็อกซ 
3. คลิกปุมลูกศรหลังชองสีบนออปชั่นบารเพือ่เปดพาเล็ต Gradient  แลวเลือกรูปแบบการไลสี(ดูเพิ่มเติมใน

หัวขอถัดไป) 
4. เลือกสี  Foreground  และหรือสี  Background 
5. กําหนดลักษณะการไลสี  โดยคลิกปุมบนออปชั่นบารซ่ึงมีอยู  5  แบบคอื 

   Linear  ไลสีเปนแนวตรง 
   Radial  ไลสีจากศูนยกลางเปนวงกลม 
   Angle   ไลสีเปนวงตามเข็มนาฬิกา 
   Reflected  ไลสีเปนแนวตรงโดยสะทอนสวนที่เหมือนกันในทิศทางตรงกันขาม 
   Diamond  ไลสีจากศูนยกลางเปนรูปสี่เหล่ียม 

6. กําหนดออปชั่นอื่นๆ บนออปชั่นบาร  ซ่ึงสวนที่แตกตางจากเครื่องมือที่กลาวมาแลว มีดังนี ้
• Reverse  กําหนดใหการไลสีกลับทิศทางจากปกต ิ
• Dither  ทําใหการไลสีมีความกลมกลืนมากขึ้น (ลดลักษณะทีใ่หเห็นสีเปนแถบๆ ลง) 
• Transparency  การเลือกออปชั่นนี้จะทําใหสามารถใชการไลสีแบบสีทึบไปโปรงใสได (ขึ้นกับ

ลักษณะการไลสีที่เลือกในขอ3) 
7. ใชเมาสคลิกลากบนรูปภาพ  เพื่อกําหนดทศิทางในการไลสี 
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เทคนิคการยอ ขยาย หมุน Object ดวยคําสั่ง Transform 

ชุดคําสั่ง Transform เปนคําสั่งที่ใชปรับขนาด ปรับหมนุ บิด หรือยดื ออปเจ็คที่เลือกไวโดยสราง Selection หรือ
โดยการเลือกทั้งเลเยอรกอน 
การปรับขนาด (Scale) 

1. เลือกออปเจ็คแลวเลือกคําสัง่  Edit  >  Transform  >  Scale  บนเมนูบาร 
2. คลิกลากรูปสี่เหล่ียมเล็กๆ ทีป่รากฏบนกรอบรอบออปเจ็ค ซ่ึงเรียกวาแฮนเดิล (handle) 

• ถาตองการคงสัดสวนเดิมของภาพใหกดคีย Shift คางไวขณะคลิกเมาส 
• ถาตองการใหออปเจ็คขยายออกจากศูนยกลางใหกดคยี  Alt คางไวขณะคลิกเมาส 

3. ใหดับเบิลคลิกภายในกรอบสีเ่หล่ียม หรือกดคีย  Enter เพือ่ใหการปรับขนาดมีผล แตถาตองการ  ยกเลิกให กดคีย 
Esc 

 
 

 
 
 
 
 
 
 
 
การปรับหมนุ (Rotate) 

1. เลือกออปเจ็คแลวเลือกคําสัง่  Edit  >  Transform  >  Rotate  บนเมนูบาร 
2. เล่ือนเมาสไปใกลแฮนเดิล หรือใหอยูภายนอกกรอบสี่เหล่ียม (สังเกตเมาสพอยเตอรจะเปนรูป      ) แลวคลิกลาก

เพื่อหมุนไปในทิศทางที่ตองการ 
3. ดับเบิลคลิกภายในกรอบสี่เหล่ียม หรือกดคยี Enter เพื่อใหการเปลี่ยนแปลงนี้มีผล แตถาตองการ   ยกเลิกให กดคยี 

Esc 
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การบิดออปเจ็ค (Skew) 

1. เลือกออปเจ็คแลวเลือกคําสัง่  Edit  >  Transform  >  Skew  บนเมนูบาร 
2. คลิกลากแฮนเดิลเพื่อบิดออปเจ็คตามตองการโดยการบดิออปเจ็คลักษณะนี้จะทําไดแนวเดยีวกับเสนกรอบรอบ

ออปเจ็คดานใดดานหนึ่งเทานั้นในแตละครั้ง 
3. ดับเบิลคลิกภายในกรอบสี่เหล่ียม หรือกดคยี Enter เพื่อใหการเปลี่ยนแปลงนี้มีผล แตถาตองการ  ยกเลิกให กดคยี 

Esc 
 
 
 
 
 
 
การบิดออปเจ็คอยางอิสระ (Distort) 

การบิดในลักษณะนี้ตางจากการบิดแบบ  Skew ตรงที่ไมมีขอจํากัดวาตองบิดในแนวเดยีวกับเสนกรอบรอบออปเจ็ค
ดานใดดานหนึ่ง 

1. เลือกคําสั่ง Edit > Transform  >  Distort 
2. คลิกลากแฮนเดิลเพื่อบิดออปเจ็ค  โดยเราสามารถลากแฮนเดิลแตละจดุไปยังตําแหนงใดๆ ก็ได 
3. ดับเบิลคลิกภายในกรอบสี่เหล่ียม หรือกดคยี Enter เพื่อใหการเปลี่ยนแปลงนี้มีผล แตถาตองการ  ยกเลิกใหกดคยี 

Esc 
 
 
 
 
 
 
 
การบิดแบบปรับสัดสวนท่ีปรากฏตอสายตา  (Perspective) 

1. เลือกคําสั่ง  Edit  >  Transform  >  Perspective 
2. คลิกลากแฮนเดิลเพื่อบิดออปเจ็ค โดยเมื่อเราคลิกลากที่มุมใดมุมหนึ่ง มมุตรงขามซึ่งอยูบนดานเดยีวกันจะถูกบิด

ไปดวยพรอมกันเพื่อใหเกิดผลแบบ  Perspective (หมายถึงการมองเห็นขนาดวัตถุเปนสัดสวนตามระยะใกลไกล) 
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3. ดับเบิลคลิกภายในกรอบสี่เหล่ียม หรือกดคยี Enter เพื่อใหการเปลี่ยนแปลงนี้มีผล แตถาตองการ  ยกเลิกให กดคยี 

Esc 
 
 
 
 
 
 
 

การพลิกออปเจ็ค (Flip) 
 หมายถึง การพลิกออปเจ็คกลับดาน เพื่อสลับระหวางดานบนกับดานลาง หรือระหวางดานซายกับดานขวา ซ่ึงจะ
ใหผลเหมือนกับภาพสะทอนในกระจกเงา 

• Edit  >  Transform  >  Flip   Horizontal 
ใชพลิกออปเจค็ในแนวนอนเพิ่อสลับซายขวา 

• Edit  >  Transform  >  Flip   Vertical 
ใชพลิกออปเจค็ในแนวตั้งเพือ่สลับบนลาง 
 

การปรับรูปทรงอิสระ (Free Transform) 
 คําสั่ง Free Transform สามารถใชแทนชุดคําสั่ง Transform ทั้งหมดทีก่ลาวมาแลว  ซ่ึงจะชวยใหเราปรับรูปทรง
ของออปเจ็คไดหลายอยางในคราวเดยีวกนั โดยการทํางานจะใชวิธีวางตําแหนงเมาสพอยเตอรที่เหมาะสม และการกดคีย 
Ctrl, Shift, Alt  ชวยแลวแตกรณี 

1. เลือกคําสั่ง  Edit   >  Free Transform   
2. เล่ือนเมาสพอยเตอรไปวางตรงตําแหนงตางๆ  และใชการกดคียชวย จากนั้นก็คลิกลากเพื่อปรับรูปทรงออปเจ็ค

ตามตองการ 
• การปรับขนาดใหเล่ือนเมาส  ไปบนแฮนเดลิ แลวคลิกลาก 
• การหมุน ใหเล่ือนเมาสไปนอกกรอบสี่เหล่ียม แลวคลิกลาก 
• การบิดแบบ Skew  ใหเล่ือนเมาสไปบนแฮนเดิล พรอมทัง้กดคีย Ctrl  คางไว  แลวคลิกลาก 
• การบิดแบบ Perspective ใหเล่ือนเมาสไปบนแฮนเดิล พรอมทั้งกดคยี Ctrl, Alt และ  Shift คางไวพรอมกัน

แลวคลิกลาก 
3. ดับเบิลคลิกภายในกรอบสี่เหล่ียม หรือกดคยี Enter เพื่อใหการเปลี่ยนแปลงนี้มีผล แตถาตองการ  ยกเลิกให กดคยี 

Esc 
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การหมุนหรอืกลับรูปภาพทั้งภาพ 
 เมื่อตองการหมุนหรือกลับรูปภาพทั้งภาพ ซ่ึงจะทําใหทุกๆ เลเยอรในภาพดังกลาวถูกปรับไปพรอมๆ กัน ใหใช
คําสั่งตอไปนี้ 

• Image >  Rotate  >  Canvas >  180˚   
         ใชหมุนรูปภาพไป  180  องศา 
• Image >  Rotate  >  Canvas >  90˚CW 

ใชหมุนรูปภาพไป  90 องศา ในทิศทางตามเข็มนาฬกิา 
• Image >  Rotate  >  Canvas >  90˚CCW 

ใชหมุนรูปภาพไป  90 องศา ในทิศทางทวนเข็มนาฬกิา 
• Image >  Rotate  >  Arbitrary 

ใชหมุนรูปภาพไปตามมุมตามคาที่กําหนดโดยจะปรากฏไดอะล็อกบอ็กซขึ้นมาใหเราปอนคาองศา (Angle) 
แลวเลือกวาจะหมุนตามเข็มนาฬิกา (CW)  หรือทวนเข็มนาฬิกา (CCW) 

• Image >  Rotate  >  Canvas >  Flip  Horizontal 
ใชพลิกรูปภาพในแนวนอนเพื่อสลับซายขวา 

• Image >  Rotate  >  Canvas >  Flip  Vertical 
      ใชพลิกรูปภาพในแนวตั้งเพื่อสลับบนลาง 
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การสรางตัวอักษร 
การสรางขอความแบบ Type Layer 
 เปนการสรางขอความแบบปกติเหมือนในโปรแกรมเวริดโปรเซสเซอรทั่วไป โดยขอความที่พิมพจะถูกเก็บไว
บนเลเยอรพิเศษที่เรียกวา Type Layer ซ่ึงเราสามารถเรียกกลับมาแกไขตัวสะกดหรอืจัดรูปแบบใหมได 

1. คลิกเลือกเครื่องมือ Horizontal Type              (ขอความแนวนอน) หรือ Vertical Type            (ขอความ
แนวตั้ง) บนทลูบ็อกซ 

2. ใชเมาสรูป        (ขอความแนวนอน) หรือรูป          (ขอความแนวตั้ง) คลิกบนรูปภาพบริเวณที่ตองการสราง
ขอความ 

3. กําหนดออปชั่นตางๆบนออปชั่นบาร เชน ฟอนต  ขนาด  สไตล และอื่นๆ 
4. พิมพขอความ (ระหวางพิมพเราสามารถเปลี่ยนแปลงออปชั่นบนออปชั่นบารได ซ่ึงจะสงผลตอขอความที่จะ

พิมพตอไป เชน สี และฟอนตตัวอักษร) 
5. เมื่อเราตองการยืนยนัขอความที่พิมพ ใหคลิกปุม             บนออปชั่นบาร หรือเลือกเครื่องมืออ่ืนๆ บน 

ทูลบ็อกซแตถาไมตองการขอความนั้นก็ใหกดคยี Esc หรือคลิกปุม            บนออปชั่นบาร    
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การสราง Type Selection 
 มีขั้นตอนคลายกับการสราง Type Layer  แตผลที่ไดจะเปนเสน Selection ไมใชขอความธรรมดา โดยขอความที่
พิมพจะไมถูกเก็บไวในเลเยอร และเราไมสามารถเรียกกลบัมาแกไขตวัสะกด หรือจัดรูปแบบใหม นอกจากจะนําไปใชใน
ลักษณะของ Selection ตามปกติเทานั้น 

1. คลิกเลือกเครื่องมือ Horizontal Type Mask             หรือ Vertical Type Mask     
2. ใชเมาสรูป          (ขอความแนวนอน) หรือรูป           (ขอความแนวตั้ง) คลิกบนรูปภาพสวนที่ตองการสราง

ขอความสังเกตวาสีพื้นบนรปูภาพจะเปลี่ยนไปเหมือนกบัการทํางานในโหมด Quick Mask 
3. กําหนดออปชั่นตางๆ บนออปชั่นบาร เชน ฟอนต  ขนาด  สไตล และอื่นๆ  
4. พิมพขอความ (ระหวางพิมพเราสามารถเปลี่ยนแปลงออปชั่นบนออปชั่นบารได) 
5. เมื่อเราตองการยืนยนัขอความที่พิมพ ใหคลิกปุม           บนออปชั่นบาร หรือเลือกเครื่องมืออ่ืนๆ บนทูลบ็อกซ

แตถาไมตองการขอความนั้นก็ใหกดคีย Esc หรือคลิกปุม           บนออปชั่นบาร 
 
 
 
 
 
 
ออปชั่นเกี่ยวกับตัวอักษร 
 เราสามารถกําหนดคณุสมบัติหลักๆ ของตัวอักษรและยอหนาไดโดยเลอืกออปชั่นบนออปชั่นบารของเครื่องมือ 
Type แตรายละเอียดคุณสมบัติที่สมบูรณจะมีอยูบนพาเล็ต Character และพาเล็ต Paragraph  
 ในการปรับแตงออปชั่นสําหรับตัวอักษรนัน้ เราสามารถเลือกปรับเฉพาะขอความบางสวน โดยไมจาํเปนตองปรับ
ทั้งหมด วิธีการ คือ ใชเมาสรูป         ของเครื่องมือ Type คลิกลากไปบนขอความที่ตองการปรับแตงใหปรากฏเปนแถบสีดํา 
(เชนเดียวกับ โปรแกรมประเภทเวิรดโปรเซสเซอรทั่วไป) แตถาไมเลือกขอความกจ็ะเปนการการปรับแตงทุกตวัอักษรใน 
เลเยอรนั้น หรือถากําลังพิมพขอความคางอยู ก็จะเปนการกําหนดเราสมบัติของขอความที่จะพิมพตอไป 
 เราสามารถเปดพาเล็ต Character ไดโดยเลือกคําสั่ง Window > Character หรือคลิกปุม          บนออปชั่นบารก็
ได ซ่ึงตัวเลือกตางๆ บนออปชั่นบารและพาแล็ต Character  มีดังนี้ 
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การแกไขหรอืปรับแตงขอความ 
 ขอความแบบ Type Layer ที่สรางไวแลวเราสามารถเรียกกลับมาแกไข หรือปรับแตงไดโดยทําดังนี้ 

1. เลือกเครื่องมือ Type ช้ินใดชิน้หนึ่งบนทูลบอกซ 
2. เลือกทําอยางใดอยางหนึ่งคือ 

• ถาตองการปรับแตงทั้งเลเยอร (เชน เปลี่ยนฟอนตหรือสีตวัอักษร) ใหคลิกเลือกเลเยอรของขอความ
นั้นบนพาเล็ต Layer 

• ถาตองการปรับแตงขอความบางสวน ใหใชเมาส   คลิกลากไปบนขอความดังกลาวใหเปนแถบสีดํา 
หรือถาตองการปรับออปชั่นเกี่ยวกับยอหนา ใหใชเมาสคลิกเพื่อวางเคอรเซอรบนยอหนานั้น 

• ถาตองการแกไข หรือพิมพขอความเพิ่มใหใชเมาส  คลิกเพื่อวางเคอรเซอรตรงตําแหนงนัน้ 
3. เปลี่ยนออปชัน่บนออปชั่นบาร  บนพาเล็ต Character หรือบนพาเล็ต Paragraph ตามตองการ 

 
 
 
 
 
 
 
 
 
 
 

4. คลิกปุม           บนออปชั่นบารเพื่อยืนยันการเปลี่ยนแปลง 
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การบิดขอความใหเปนรปูรางตางๆ 
 เราสามารถบิดขอความในเลเยอรใหเปนแนวโคงเปนรูปลูกคลื่น รูปปลา หรือรูปรางอื่นๆ ไดอีกมาก โดยกําหนดที่
ออปชั่น Warp Text          บนออปชั่นบาร 

1. สรางขอความ หรือเลือกเลเยอรขอความที่สรางไว 
2. คลิกเลือกเครื่องมือ Type            บนทูลบ็อกซ 
3. คลิกปุม Warp Text             เพื่อเปดไดอะลอ็กบ็อกซ Warp Text 
4. คลิกในชอง Style แลวเลือกรูปทรงที่ตองการจากเมน ู
5. เมื่อเลือกรูปทรงไดแลว เรายงัสามารถปรับแตงรูปทรงนัน้ไดจากออปชั่นเพิ่มเติม และตัวอักษรจะเปลี่ยนแปลง

ไปตามการปรับแตงของเรา 
• Horizontal  กาํหนดใหบิดตวัอักษรในแนวนอน 
• Vertical  กําหนดใหบิดตวัอักษรในแนวตัง้ 
• Bend  กําหนดปริมาณ และดานของตัวอักษรที่จะถูกบดิ 
• Horizontal Distortion  กําหนดใหบิดเบือนสัดสวนในแนวนอน 
• Vertical Distortion  กําหนดใหบดิเบือนสัดสวนในแนวตั้ง 

6. คลิก OK 
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เทคนิคการปรับแตงสี และแสงเงาของรูปภาพ 
หลักการปรบัแตงสีและแสงเงาใน Photoshop  

เมื่อเรามองดูรูปภาพจะเกดิการรับรูองคประกอบหลัก ๆ 2 สวน คือ สีสัน และแสงเงา (หรือความมดืสวาง) คําสั่ง
สําหรับปรับแตงสีและแสงเงาของ Photoshop ที่อยูในเมนู Image > Adjustments จะทําหนาที่เปลี่ยนแปลงเราสมบัติทั้ง
สองนี้ โดยในการปรับสีก็มักจะทําใหแสงเงาของภาพเปลี่ยนแปลงไป ในขณะเดยีวกนัการปรับแสงเงาก็จะทําใหสี
เปลี่ยนไปดวย อยางไรก็ดี คําสั่งบางคําสั่งจะเนนทีก่ารปรบัแสงเงาเปนหลัก  แตบางคาํสั่งจะเนนไปที่การปรับสี 
 
 
 
 
 
 
 
 
 
 
 
 

 
การปรับแสงเงาใน Photoshop ก็คือการปรับลักษณะการกระจายตัวของพิกเซลบนฮิสโตแกรมนั่นเอง ภาพทีม่ี

คุณภาพดีจะตองมีการกระจายพิกเซลกวาง ซ่ึงจะทําใหมองเห็นรายละเอียดตามสวนตางๆ ของภาพไดชัดเจน ทั้งนี้เมื่อ
พิจารณาจากฮสิโตแกรมจะสามารถบอกไดวาเราควรปรับแสงเงาของภาพนัน้ในลักษณะใด จึงจะใหผลดีที่สุด หรือภาพใด
มีคุณภาพไมด ีเนื่องจากพิกเซลกระจุกตวัอยูบริเวณใดบริเวณหนึ่งมากเกินไป ซ่ึงถึงแมวาจะปรับแสงเงาแลวกจ็ะชวยอะไร
ไมไดมากนัก 
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การใชคําสั่ง Levels 
 คําสั่ง Levels ใชสําหรับปรับการกระจายตัวของแสง และเงา เพื่อใหภาพโดยรวมมคีุณภาพดีขึ้น คือมีความมืด
สวางของแตละบริเวณที่เหมาะสม มองเหน็รายละเอยีดของสวนตางๆ มากขึ้น และชดัเจนขึ้น คําสัง่นี้มีวิธีใชงานที่ไมยุงยาก 
และใหผลดีพอสมควร 
 
 นอกจากนั้นคาํสั่ง Levels ยงัสามารถใชปรับสีไดดวย โดยการเลือกปรับแสงเงาของเฉพาะบางแชนแนล ซ่ึงจะเปน
การเพิ่มหรือลดความสวางของแมสีบางสี ทําใหสีโดยรวมของภาพเปลีย่นไป 

วิธีใชคําสั่ง Levels มีขั้นตอนดังนี ้
1. เลือกเลเยอรทีต่องการปรับ แลวเลือกคําสัง่ Image > Adjustments > Levels เพื่อเปดไดอะล็อกบ็อกซ 

Levels 
2. คลิกออปชั่น Preview เพื่อแสดงผลการปรับแตงบนภาพทันท ี
3. เลือกแชนแนลสีที่ตองการปรับแตงจากชอง Channel กลาวคือ ถาตองการปรับโดยรวมก็เลือกแชนแนลสีรวม

คือ RGB หรือ CMYK หรืออาจเลือกปรับเฉพาะแตละแชนแนลกไ็ด 
4. ปรับแสงเงาโดยวิธีเล่ือนสไลเดอรหรือปอนคาในสวนของ Input Levels ดังนี ้

• Shadow(    )  เมื่อเล่ือนสไลเดอรนี้ไปยังตาํแหนงใด ทกุๆ พิกเซลที่อยูทางซายของจุดนั้น จะถูก
กําหนดใหเปนสวนที่มืดทีสุ่ดของภาพ (กลายเปนสีดํา) สวนพกิเซลอื่นๆ ก็จะถูกปรับตามไปดวย 
เพื่อใหสอดคลองกัน  เชน สมมติวาเรายายสไลเดอรนี้ไปยังตัวเลข 39 ทกุๆ พิกเซล ที่มีคาความ
สวางตั้งแต 39 ลงไปจะถูกกาํหนดใหมีความสวางเปน 0 ซ่ึงเทากับเปนการเพิ่มความตางระหวาง
สวนมืดกับสวนสวาง (contrast) ของภาพนั่นเอง 

• Midtone(    ) ใชเพื่อปรับตําแหนงของคาความสวางกลางระหวาง Shadow และ Highlight 
กลาวคือเมื่อเล่ือนไปทางซายจะทําใหภาพสวางขึ้น แตถาเลื่อนไปทางขวาจะทําใหภาพมืดลง 

• Highlight(    )  เมื่อเล่ือนสไลเดอรนี้ไปยังตําแหนงใดทกุๆ พิกเซลที่อยูทางขวาของจุดนั้น จะถูก
กําหนดใหเปนสวนที่สวางที่สุดของภาพ(กลายเปนสีขาว) ซ่ึงเทากับเปนการเพิ่มความแตกตาง
ระหวางสวนมดืกับสวนสวางของภาพเชนกัน 

5. ถาตองการลดความตางระหวางสวนมดืกบัสวนสวางของภาพ จะทําไดโดยเล่ือนสไลเดอรชุดลางหรือปอนคา
ในสวนของ Output Levels ดังนี ้

• Shadow(    )   เมื่อเล่ือนไปทางขวาจะทาํใหสวนมืดของภาพลดลง เชน ถาเราเลื่อนสไลเดอรนี้ไปที่
คา 20 ก็จะเปนการเปลี่ยนพกิเซลที่มีความสวาง 0 ใหกลายเปนความสวาง 20 สําหรับพิกเซลอื่นๆ ก็
จะถูกปรับความสวางไปตามสัดสวนดวย ผลคือภาพที่ไดจะมีความเปรียบตาง(contrast) ลดลง 
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• Highlight(    )  เมื่อเล่ือนไปทางซายจะทําใหสวนสวางของภาพลดลง เชน ถาเล่ือนสไลเดอรนี้ไปที่

คา 240 ก็จะเปนการเปลี่ยนพกิเซลที่มีความสวาง 255 ใหกลายเปนพกิเซลที่มีความสวาง 240 
สําหรับพิกเซลอื่น ๆ ก็จะถกูปรับความสวางไปตามสัดสวนดวย 

6. คลิกปุม OK เมื่อปรับภาพไดตามตองการแลว 
 
 
 
 
 
 
 
 
 
 

 

การใชคําสั่ง Curves 
 คําสั่ง Curves ใชสําหรับปรบัแสงเงาของภาพ เชนเดยีวกับคําสั่ง Levels แตแทนทีจ่ะมีตวัแปรใหเราควบคุมเพียง 
3 ตัว (คือ Shadow, Midtone และ Highlight)  เหมือนคาํสั่ง Levels ในคําสั่งนี้จะใชลักษณะของการปรับเสนกราฟแทน 
ทําใหเราสามารถตั้งคาความสวางของตําแหนงใดๆ ก็ได โดยเลือกไดมากถึง 14 จุด นอกจากนัน้คําสั่งนี้ยังใชปรับสีไดดวย 
โดยการแยกปรับความสวางในแตละแชนแนลตาง หากจากกนั 

1. เลือกคําสั่ง Image  >  Adjustments  >  Curves   เพื่อเปดไดอะล็อกบ็อกซ Curves 
2. คลิกเลือกออปชั่น  Preview   เพื่อใหแสดงผลการปรับแตงบนภาพทนัท ี
3. ที่ชอง Channel ใหเลือกวาตองการปรับแบบโดยรวม หรือปรับเฉพาะแชนแนลใด (เหมือนกับคําสัง่ Levels) 
4. ปรับแนวเสนกราฟ โดยใชวธีิใดวิธีหนึ่งคอื 

• ปรับดวยวิธีดึงเสนกราฟ โดยคลิกปุม         จากนั้นเลื่อนเมาสไปบนเสนกราฟตรงจุดที่ตองการ แลว
คลิกลากไปยังตําแหนงใหม เราสามารถดึงเสนกราฟในลกัษณะนีไ้ดทั้งหมด 14 จดุตามความจําเปน 

• ปรับดวยวิธีวาดเสนกราฟ โดยคลิกปุม         แลวเล่ือนเมาสไปคลิกลากในกรอบใหเกดิเปนแนวเสน
ตามที่ตองการ 
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5. เมื่อปรับคาไดตามตองการใหคลิกปุม OK 
 
 
 

 
 
 
 
 
 
 
 

 
การใชคําสั่ง Brightness/Contrast 
 Brightness/Contrast…. เปนคําสั่งที่งายทีสุ่ดสําหรับปรับแสงเงาและความตางระหวางสวนมดืกบัสวนสวาง
โดยรวมของภาพ โดยจะสงผลตอทุกพิกเซลเทาๆ กัน  ดังนั้นจึงอาจไมเหมาะสําหรับงานคุณภาพสูง เพราะอาจทําให
สูญเสียรายละเอียดของภาพบางสวนไป 

1. เลือกคําสั่ง Image > Adjustments > Brightness/Contrast  เพื่อเปดไดอะล็อกบ็อกซ Brightness/Contrast 
2. คลิกเลือกออปชั่น Previes เพื่อใหแสดงผลการปรับแตงบนภาพทนัท ี
3. Brightness ใชปรับความมืด -  สวางของภาพโดยถาเล่ือนสไลเดอรไปทางซาย (หรือปอนคาลบ) ภาพที่ไดจะ

มืดลง แตถาเลื่อนไปทางขวา (หรือปอนคาบวก) จะทําใหภาพสวางขึ้น 
4. Contrast ใชความตางระหวางสวนมืดกับสวนสวางของภาพ โดยถาเล่ือนสไลเดอรไปทางซาย (หรือปอนคา

ลบ) จะไดภาพที่มี contrast ลดลง แตถาเล่ือนไปทางขวา (หรือปอนคาบวก) จะไดภาพที่มี contrast สูงขึ้น 
5. เมื่อปรับคาเสร็จแลวใหคลิกปุม OK 
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การใชคําสั่ง Hue/Saturation 
 เปนคําสั่งที่ใชปรับสี และแสงเงาของภาพดวยการเปลี่ยนคา Hue (สี)  Saturation (ความอิ่มตัวหรือความบริสุทธิ์
ของสี) และ Lightness (ความสวาง) โดยวธีินี้เราสามารถเลือกไดวาจะปรับสีใหกับภาพโดยรวม (ซ่ึงจะสงผลใหทกุพิกเซล
ปรับสีไปอยางสัมพันธกัน) หรือเฉพาะสีใดสีหนึ่ง นอกจากนั้นยังสามารถปรับใหภาพมีโทนสีเดียวไดโดยเลือกออปชั่น 
Colorize 

1. เลือกคําสั่ง Image  >  Adjustments  >  Hue/Saturation  เพื่อเปดไดอะล็อกบ็อกซ  Hue/Saturation 
2. คลิกเลือกออปชั่น Preview เพื่อใหแสดงผลการปรับแตงบนภาพทนัท ี
3. ในชอง Edit ใหเลือกสีที่ตองการปรับ ซ่ึงถาเลือก Master จะเปนการปรบัสีโดยรวมทัง้หมด 
4. เล่ือนสไลเดอรหรือปอนคาในสวนตางๆ ดงันี้ 

• Hue ใชปรับสีของพิกเซลใหเปลี่ยนเปนสีอ่ืนโดยทุกๆ สีจะถูกปรับไปเปนคาเทาๆ กันเมื่อเทียบกับ
ตําแหนงเดิมในวงกลมสี (Color Wheel) 

• Saturation ปรับความอิ่มตัวของสี ถาเล่ือนไปทางขวา (คาบวก) จะทําใหสีสดใสฉูดฉาดขึ้น ถา
เล่ือนไปทางซาย (คาลบ) จะทําใหสีซีดลงจนกลายเปนสเีทาในที่สุด 

• Lightness เพิ่มหรือลดความสวางของภาพโดยถาเล่ือนสไลเดอรไปทางขวา (คาบวก) จะไดภาพที่
มีความสวางขาวเพิ่มขึ้น แตถาเล่ือนไปทางซาย (คาลบ) จะทําใหภาพมดืดําลง 

5. ออปชั่น Colorize ใชเปลี่ยนใหสีของภาพเหลือเพียงโดนสีเดียว (ตามทีก่ําหนดโดยคา Hue) ซ่ึงเหมาะจะใชทํา
เทคนิคพิเศษ เชนการสรางภาพสีซีเปย 

6. เมื่อไดผลลัพธตามที่ตองการแลว ใหคลิกปุม OK 
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การใช Filter เพ่ือสราง Effect ใหกับภาพ 

ฟลเตอรเปนอีกวิธีหนึ่งในการสรางเอฟเฟคตแปลกตาตางๆ ใหกับรูปภาพ เชน การแปลงภาพถายใหกลายเปน
เหมือนกับภาพที่ศิลปนวาดขึ้นโดยใชเครื่องมือหลายหลายประเภท  ไมวาจะเปนดนิสอสี  สีน้ํา  หรือสีชอลค  การเติม
พื้นผิว (Texture) ใหกับภาพ  การปรับภาพใหเบลอในลกัษณะตางๆ หรือการเพิ่มความคมชัดใหกับภาพที่ถายมาไมดี  เปน
ตน  นอกจากนี้เรายังสามารถใชฟลเตอรเพื่อชวยในการสรางภาพกราฟกไดดวยเชนกัน 
 การใชฟลเตอรจะมีผลตอเลเยอรที่กําลังเลือก  หรือถาเราสราง Selection  ไวก็จะมีผลตอพื้นที่ภาพใน Selection 
เทานั้น สําหรับภาพบางโหมดคือ Bitmap และ Index Color  เราจะไมสามารถใชฟลเตอรเลย  และบางฟลเตอรเพื่อชวยใน
การสรางภาพกราฟกไดดวยเชนกัน 
 เราสามารถเรียกใชฟลเตอรของ  Photoshop  ไดจากเมนู Filter  โดยคําสั่งทั้งหมดจะถูกจัดแบงออกเปนหมวดหมู
ตามคุณสมบัติ  เพื่อใหใชงานไดสะดวก  ฟลเตอรบางตัวเมื่อเรียกใชแลวจะมีผลทันที  แตสวนใหญจะมีออปชั่นใหเรา
ปรับแตงผลลัพธเพิ่มเติม  ซ่ึงแตละฟลเตอรจะมีจํานวนและชนิดของออปชั่นที่แตกตางกันออกไป 
 
การใชฟลเตอรกับเลเยอร 

1. ถาภาพของเรามีหลายเลเยอร  ใหคลิกเลือกเลเยอรที่ตองการจากพาเล็ต Layers 
2. เลือกคําสั่งสําหรับเรียกใชฟลเตอร  เชน  Filter > Artistic > Watercolor 
3. บนไดอะล็อกบ็อกซของฟลเตอรจะมีภาพตวัอยางในกรอบดานบน  พรอมทั้งมีปุม        เพื่อใชขยายและปุม            
              เพื่อใชยอภาพตวัอยาง  สวนดานลางจะเปนออปชั่นเฉพาะของแตละฟลเตอร  เพื่อใชปรับใหไดผลลัพธ 
       ตามตองการสําหรับฟลเตอร Watercolor  ในตัวอยางนี้จะมีออปชัน่คือ 

• Brush  Detail  กําหนดความละเอียดของฝแปรง 
• Shadow  Intensity  เพิ่มสวนที่เปนเงาของภาพ 
• Texture  เพิ่มพื้นผิวใหกับภาพ 

4. คลิก  OK 
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การใชฟลเตอรเดิมซ้ํา 
 ในกรณีที่เราตองการใชฟลเตอรเดิมซ้ําพรอมดวยการกําหนดออปชั่นตางๆ ที่เหมือนกัน  เราไมจําเปนตองทํา
ขั้นตอนแบบเดิมๆ ซํ้าอีก  แตสามารถเลือกคําสั่งใหโปรแกรมทํางานซ้าํไดจาเมน ู
 ตัวอยาง เชน  ถาเราเพิ่งใชฟลเตอร Radial Blur จบไป  ตอนบนสุดของเมนู Filter จะปรากฏคําสั่ง  Radial Blur  
ขึ้นมา ซ่ึงเราสามารถเรียกใชไดเลย (หรือจะใชวิธีกดคีย Ctrl + F ก็ได) หลังจากนัน้เมื่อเราเรียกใชฟลเตอรอ่ืน คําสั่งบนสุด
นี้ก็จะเปลี่ยนไปเปนฟลเตอรดังกลาวนัน้ตอไป 
 
สรางรูป Selection ดวยพาเล็ต Path 
สรางรูปหลายเหลี่ยมดวยเครื่องมือ Pen 

1. คลิกเลือกเครื่องมือ Pen 
2. กําหนดออปชั่นตางๆ บนออปชั่นบาร 
3. ใชเมาสรูป            คลิกเพื่อสรางจุด Anchor จุดแรกแลวปลอยเมาส 
4. เล่ือนเมาสรูป           ไปคลิกจุดตอไปตามตองการจะเกิดเสนเชื่อมตอระหวางจุดเหลานี้ 
5. กลับไปคลิกที่จุดเริ่มตนเพื่อปดเสน Path โดยเมาสจะเปลี่ยนเปนรูป           จะไดเสนเชื่อมจุดสุดทายมายัง 
       จุดเริ่มตนจนครบวง 

 
 
 
 
 
 
 
 
 
 
สรางเสนโคงดวยเครื่องมือ Pen 

การสรางเสนโคงดวยเครื่องมือ Pen ทําไดโดยการคลิกลากที่  Direction Point  ตรงปลายเสนที่ยื่นออกมาจากจดุ 
Anchor ซ่ึงทิศทางในการลาก Direction Point  นี้จะสงผลตอลักษณะการโคงของเสน  เมื่อเราฝกใชเครื่องมือนี้จนชํานาญ
ก็จะสามารถสรางภาพกราฟกที่ซับซอนได 

1. คลิกเลือกเครื่องมือ Pen    
2. กําหนดออปชั่นตางๆ บน ออปชั่นบาร 
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3. ใชเมาสรูป          คลิกคางที่จุดเริ่มตน แลวลากเสน Direction  ออกจากจุด Anchor จุดแรก ซ่ึงในขณะที่คลิก

ลากเมาส จะเปลี่ยนเปนรูป    
4. ใชเมาสรูป          คลิกสรางจุดใหม พรอมทั้งลากเสน Direction  โดยทิศทางการลากจะสงผลตอลักษณะของ 
        เสน  เชน    

• ถาลากเสนไปในทิศทางเดยีวกันกับจุดที่แลวจะไดเสนในลักษณะตวั   S 
• ถาลากเสนไปในทิศทางตรงขามกับจุดทีแ่ลวจะไดเสนในลักษณะตวั  C 

5. สรางสวนโคงเพิ่มเติมตามตองการ แลวปดเสน 
 
 
 
 
  
 
 
การแปลงเสน Path  ใหเปน  Selection  

นอกเหนือจากการใชเสน Path  เพื่อวาดรูปทรงตางๆ แลว เรายังสามารถแปลงเสน Path ใหเปน Selection เพื่อใช
ในจุดประสงคตางๆ ไดเชน การตัดภาพออปเจ็คออกจากฉากหลังเปนตน 
 วิธีการแปลงเสน Path เปน Selection มีดังนี้ 

1. คลิกเลือกในชดุเสน Path ที่ตองการจากพาเล็ต Path 
2. ใหคลิกขวา แลวเลือกคําสั่ง Make Selection จากนัน้คลิก ok 
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การนําภาพไปใชกับเว็บไซต 

เราสามารถใช Photoshop แปลงรูปภาพที่เปนไฟลชนดิตางๆ ไมวาจะเปนรูปที่สรางเอง หรือนํามาจากแหลงอื่น 
เพื่อใหเหมาะสําหรับนําไปใชกับเว็บ โดยใชคําสั่งพิเศษทีโ่ปรแกรมเตรียมไวใหนอกเหนือจากคําสั่งบันทึกไฟลตามปกต ิ
 ไฟลรูปภาพที่เปนมาตรฐานสําหรับใชบนเว็บคือ GIF, JPEG, PNG และ WBMP ซ่ึงแตละแบบจะมีขอจํากัดและ
ความหมายสมสําหรับลักษณะภาพทีแ่ตกตางกันออกไป นอกจากนีไ้ฟลที่ใชควรมีขนาดเล็กซึ่งจะทําใหโหลดผาน
อินเทอรเน็ตไดอยางรวดเร็ว แตในขณะเดยีวกันคุณภาพก็ตองไมตางจากตนฉบับมากนัก เราสามารถใช Photoshop บันทึก
ไฟลรูปภาพชนิดอื่นใหเปนไฟลสําหรับเวบ็แบบใดแบบหนึ่งดังกลาวกไ็ดโดยโปรแกรมจะใหเราทดลองปรับออปชั่นตางๆ
ในการแปลงไฟลพรอมทั้งแสดงผลเปรียบเทียบ เพื่อใหเราเลือกรูปที่มีคุณสมบัติตรงตามความตองการมากที่สุด 

รูปแบบของไฟลรูปภาพสําหรับเว็บ 
รูปแบบของไฟลรูปภาพที่เปนมาตรฐานสําหรับนําไปใชกับเว็บไดนัน้มีอยู 5 แบบซึ่งเหมาะกับภาพที่มีลักษณะ

แตกตางกันออกไปดังนี ้
1. GIF เปนรูปแบบที่มีขอจํากดัตรงจํานวนสซ่ึีงสามารถใชไดสูงสุดเพียง 256 สี (ขอมูลมีขนาด 8 บิต) จึงเหมาะ
สําหรับภาพโลโก ภาพการตูน ภาพวาดลายเสน หรือภาพตัวอักษร ซ่ึงมีลักษณะเปนสีทึบ ไมมีการไลระดับ และมี
ขอบที่คมชัดแตถาใชรูปแบบนี้เก็บภาพถาย จะทําใหไดภาพที่มีสีไมตอเนื่อง และไฟลจะมีขนาดใหญ 
       ไฟล GIF มจีุดเดนตรงที่เราสามารถกําหนดใหฉากหลังของวัตถุหรือพืน้ที่บางสวนของภาพโปรงใส 
(Transparent)  กําหนดใหภาพแสดงแบบเบลอๆกอนแลวคอยๆ ชัดเจนขึ้นตามปริมาณขอมูลที่ถูกโหลด
(Interlace) และใชทําภาพเคลื่อนไหว(Animation) ได 
2. JPEG ไฟลชนิดนี้สามารถใชสีไดถึง 16.7 ลานสี (24 บิต) จึงเหมาะสําหรับเก็บภาพถาย หรือภาพกราฟกที่ใชสี
จํานวนมาก และมีการไลระดับสีอยางตอเนื่อง เราสามารถกําหนดใหภาพถูกแสดงแบบเบลอๆ กอนแลวคอย
ชัดเจนขึ้น (Progressive) ไดในทํานองเดยีวกับไฟล GIF แตไมสามารถกําหนดใหฉากหลังโปรงใสหรือทํา
ภาพเคลื่อนไหว 
 จุดเดนอีกอยางของไฟล JPEG คือ เราสามารถกําหนดการบีบอัดขอมูลไดหลายระดับ ทําใหภาพใหญๆ มี
ขนาดไฟลที่เล็กลงตามตองการ แตการบีบอัดจะมีผลตอคุณภาพของภาพ คือยิ่งบีบอดัมากเทาใดความคมชัดกจ็ะลง
ลงเทานั้น ซ่ึงภาพที่ถูกบีบอดัมากเกนิไปจะดูเบลอและปรากฏแถบสี่เหล่ียมใหเห็นเปนหยอมๆ 
3. PNG-8 เปนรูปแบบที่ใชสีไดเพียง 256 สีและมีคุณสมบัตคิลายกับไฟล GIF จึงเหมาะสําหรับภาพสีเรียบๆ เชน
ภาพโลโก ภาพการตูน ภาพวาดลายเสนและภาพตวัอักษร นอกจากนีย้ังสามารถกําหนดใหฉากหลังโปรงใส และ
ทําใหภาพคอยๆแสดงชัดขึ้นทีละนอยไดเชนเดียวกนั 
4. PNG-24 เปนรูปแบบที่ใชสีไดถึง 16.7 ลานสีเชนเดยีวกบั JPEG จึงเหมาะสมสําหรับภาพถาย หรือภาพที่มี
โทนสีตอเนื่องเชนกัน แตเนือ่งจาก PNG ใชวิธีบีบอัดขอมูลแบบไมสูญเสียคุณภาพ ทาํใหไฟลที่ไดมีขนาดใหญ
กวา JPEG มาก 
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คําสั่ง  Save For Web 
 เมื่อตองการบันทึกภาพเพื่อนําไปใชกบัเวบ็ ใหเราเลือกคําสั่ง Fire  >  Save For Web จะปรากฏไดอะล็อกบ็อกซ 
Save For Web เพื่อใหเราทาํการปรับแตงออปชั้นตางๆ ในการแปลงไฟล ดังนี ้
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การบันทึกภาพ 
 หลังจากที่เลือกไดแลววาควรใชผลลัพธตามภาพตวัอยางภาพใดใหเราคลิกในกรอบของภาพนั้นแลวคลิกปุม Save 
จะปรากฏไดอะล็อกซบ็อกซ Save Optimized As ใหเลือกโฟลเดอรที่จะจดัเก็บภาพ และกําหนดชือ่ไฟลตามตองการ แลว
คลิกปุม Save 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ถาหากในโฟลเดอรที่เลือกมไีฟลช่ือเดียวกนัอยูกอนแลว จะปรากฏไดอะล็อกบ็อกซเตอืน ใหคลิก Replace เพื่อ
บันทึกทับ 
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Macromedia Flash เปนโปรแกรมที่มีประสิทธิภาพสูงสําหรับงานสรางภาพกราฟก ภาพเคลื่อนไหว ตลอดจน
มัลติมีเดียสําหรับเว็บ โดยเราสามารถใช Flash ในการสรางเนื้อหาลักษณะตาง  ๆ ซ่ึงพรอมจะนําเสนอบนอินเทอรเน็ตได
ทันที ไมวาจะเปน 

• ภาพโลโกที่เคลื่อนไหวได 
• ระบบเนวิเกชัน่ ซ่ึงเปนเมนสํูาหรับนําผูชมเขาไปยังหนาตางๆ  ในเว็บ 
• มัลติมีเดีย ที่ประกอบดวยภาพเคลื่อนไหวอยางสมจริงของตัวอักษร และกราฟกพรอมเสียงประกอบ เชน ภาพ

เปดตัวของเวบ็ แบนเนอรโฆษณา หรือภาพเคลื่อนไหวที่แสดงเรื่องราว 
• ระบบงานบนเว็บ (Web Application) ซ่ึงตองมีการรับขอมูลและการกระทําของผูชม เพื่อนําไปประมวล และ

แสดงผลออกมาตามเงื่อนไขที่กําหนดไว รวมไปถึงพวกเกมสตางๆ  
• แมกระทั่งเว็บไซตก็สามารถสรางไดเสร็จสมบูรณภายใน Flash เชนกนั 
โปรแกรม Flash มีเครื่องมือที่พรอมเพรียงสําหรับใหเราสรางภาพเคลื่อนไหวและมลัติมเีดียไดอยางสะดวกและมี

ประสิทธิภาพ นับตั้งแตเครื่องมือพื้นฐานในการวาด และจัดการรูปทรงแบบตาง ๆ ความสามารถในการดึงรูปภาพบิทแมพ 
ไฟลเสียง และภาพวดิีโอจากภายนอกเขามาใช ความสามารถจัดเก็บ และเรียกใชออปเจ็คตางๆ อยางมีประสิทธิภาพ มี
เครื่องมือสําหรับสรางภาพเคลื่อนไหวที่สมบูรณ และใชงาย มีภาษาโปรแกรมสําหรับควบคุมการทํางานของมัลติมีเดียที่
ซับซอน นอกจากนีห้ลังจากสรางเสร็จแลว Flash ก็มีเครื่องมือใหเรานําผลงานที่ไดไปแสดงบนเว็บเพจ โดยเราสามารถ
ปรับแตงคุณสมบัติใหเหมาะกับลักษณะการแสดงผลหรือเงื่อนไขของบราวเซอรอีกดวย 
 ลักษณะเดนของภาพเคลื่อนไหวทีไ่ดจากโปรแกรม Flash ก็คือไฟลมีขนาดเล็ก จึงสามารถโหลดมาแสดงผลได
อยางรวดเรว็ รวมทั้งใหภาพลายเสนที่คมชัด สามารถยอ  ขยาย ขนาดไดโดยมีความละเอียดคงเดิม ทัง้นี้เนื่องจากภาพที่
สรางใน Flash จะเปนกราฟกชนิดเวคเตอร ซ่ึงใชคําสั่งที่มีลักษณะคลายสูตรทางคณติศาสตรในการวาดเปนรูปทรงขึ้นมา 
แทนที่จะเก็บขอมูลเปนจะดสีูเหมือนในกรณีของกราฟกชนิดบิทแมพ สําหรับภาพบทิแมพและไฟลเสียงจากภายนอกที่ถูก
ดึงเขามาใช เราก็สามารถกําหนดใหมีการบีบอัด และลดขนาดขอมูล เพื่อใหไดผลลัพธที่มีขนาดเหมาะสม ไฟล
ภาพเคลื่อนไหวและมัลติมีเดยีของ Flash มีช่ือเรียกเปนการเฉพาะวา “มูฟวี”่ ( movie ) 
 มูฟวี่ของ Flash ไดรับความนิยมนํามาใชบนเว็บอยางกวางขวาง หากเราทองเว็บไปพบกับภาพกราฟกที่นาตื่นตา
ตื่นใจ สวนมากแลวมกัจะเปนภาพที่สรางดวย Flash แทบทั้งสิ้น ตัวอยางเชนที่เว็บ www.disney.com  เปนตน ถาเรา
ตองการดูวาภาพใดเปนมูฟวีข่อง Flash หรือไม ก็ทําไดโดยคลิกขวาบนภาพนั้น จะปรากฏเมนูลัดซึ่งมีขอความวา About 
Macromedia Flash Player ขึ้นมา 
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แนะนําองคประกอบ และพ้ืนที่การทํางานของโปรแกรม 
 เมื่อเรียกใชโปรแกรมดวยคําสั่ง All Program  >  Macromedia Flash 8 จากปุม Start จะปรากฏหนาตางของ
โปรแกรม โดยมีสวนประกอบตางๆ ดังนี้ 
 
หนาจอของ Macromedia Flash 8 

เมื่อเปดโปรแกรม Flash 8 ขึ้นมาครั้งแรกจะไดพบกับหนาจอมาตรฐาน (Default Layout) ที่แสดงสวนประกอบ
สําคัญตางๆ ดังตอไปนี ้
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. แถบชื่อ (Title Bar) 
แถบชื่อหรือไตเติลบารเปนสวนที่แสดงชือ่โปรแกรมซึ่งก็คือ Macromedia Flash 8 และบอกชื่อไฟล

ที่กําลังเปดอยู พรอมกับมีปุม ยุบ / ขยายวนิโดว และปดโปรแกรม 
2. แถบเมนู  (Menu Bar)  

แถบเมนู ประกอบดวยเมนูคาํสั่งตางๆ ที่ใชในการสรางมฟูวี่  การจดัการกับไฟล และวินโดว
โปรแกรม รวมถึงการตั้งคาพื้นฐานตางๆ  

3. ทูลบ็อกซ (Menu  Bar) 
กลองเครื่องมือหรือทูลบอ็กซ คือสวนที่รวบรวมเครื่องมือชนิดตางๆ ที่ใชในการสราง และปรับแตง

ออปเจ็คเพื่อแสดงในมูฟวี่เอาไว โดยแบงออกเปน 4 สวนยอยดังนี ้
 



 

 61 

 
• สวนเครื่องมือ (Tools)  

ประกอบดวยเครื่องมือเลือกออปเจ็ค ใสขอความ วาดรปู และระบายสี 
• สวนกําหนดมมุมอง (View) 

ประกอบดวยเครื่องมือยอ / ขยายมุมมอง และเลื่อนหนาจอภาพ 
• สวนกําหนดส ี(Colors) 

ประกอบดวยเครื่องมือเลือกสีสําหรับเสน และพื้นภาพ 
• สวนปรับแตงเครื่องมือ หรือออปชั่น (Options) 

ประกอบดวยคุณสมบัติเสริม (Modifier) สําหรับปรับแตงการทํางานของเครื่องมือชนิดตางๆ โดย 
รายละเอียดเหลานี้จะเปลี่ยนไปตามชนิดของเครื่องมือที่กําลังเลือก 

4. สเตจ (Stage) 
คือ พื้นที่ส่ีเหล่ียมสีขาวตรงกลางหนาจอ ซ่ึงเราใชสําหรับจัดวางเนื้อหาของมูฟวี่แตละเฟรมลงไป 

หรือเปรียบไดกับสวนหนาของเวทีที่ตัวละครตางๆ จะปรากฏออกมาใหผูชมเห็นนั่นเอง เมื่อเลนมูฟวีภ่าพจะ
ปรากฏเฉพาะสิ่งที่อยูบนสเตจเทานั้น 

สําหรับบริเวณสีเทาโดยรอบสเตจเรียกวา พื้นที่ทํางาน (Work area) เปนสวนที่ใชจดัเตรียมเนื้อหา 
หรือวางองคประกอบที่ยังไมตองการแสดงใหเห็น เปรียบไดกับดานขางและดานหลังของเวที ที่ตัวละครใช
แตงกายหรือเตรียมปรากฎตวั โดยปกติโปรแกรมจะแสดงสวนของ Work area ไวเสมอ  
5. ไทมไลน (Timeline) 

ไทมไลนเปนเครื่องมือสําคัญที่ใชในการสรางภาพเคลื่อนไหว โดยประกอบดวย 2 สวนหลักคือ  
เลเยอร (layer) และเฟรม (frame) เลเยอรนั้นเปรียบเสมอืนเปนแผนใสที่เราใชจัดวางออปเจ็คหลายๆ ช้ินให
เรียงซอนกันได ในขณะทีแ่ตละออปเจ็คยงัคงมีความเปนอิสระตอกัน สวนเฟรมเปนการแบงภาพเคลื่อนไหว
ออกเปนขั้นตอนยอยๆ เหมอืนกับภาพนิ่งหรือฟลมภาพยนตรแตละภาพ ซ่ึงเมื่อนําหลายๆ เฟรมมาแสดงอยาง
ตอเนื่องจะทําใหเห็นเปนภาพเคลื่อนไหวที่สมบูรณ 
6. พรอพเพอรตี (Property) 

เพื่อลดความยุงยากในการเปด / ปด และจัดการพาเนล รวมทั้งไดอะล็อกบ็อกซจํานวนมาก Flash 8 
ไดเพิ่ม Property inspector ขึ้นมาสําหรับใชในการปรับแตงคุณสมบัตติางๆ ของออปเจ็คหรือองคประกอบ
ของมูฟวี่ไดอยางสะดวก โดยรายละเอียดภายใน Property inspector จะเปลี่ยนไปตามองคประกอบที่เรา
กําลังเลือกในขณะนัน้ 
7. พาเนล (Panel)  

พาเนล คือกรอบหนาตางเลก็ๆ ซ่ึงบรรจุเครื่องมือที่ใชสําหรับปรับแตงคุณสมบัติขององคประกอบ
ตางๆ  ในมูฟวีไ่มวาจะเปนซมิโบล อินสแตนซ เฟรม ซีน ตัวอักษร สี และอื่นๆ รวมทั้งชวยใหเราตรวจสอบคา
และจัดการเปลี่ยนแปลงองคประกอบเหลานี้ได  
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การกําหนดคาพื้นฐานกอนการสรางชิ้นงาน 

คุณสมบัติพื้นฐานของไฟลเอกสาร Flash (Document Properties) ประกอบดวยขนาดพื้นที่ในการแสดงผล 
(ขนาดสเตจ) สีพื้น  อัตราเร็วในการแสดงภาพเคลื่อนไหว และหนวยวดัของไมบรรทัด เราควรกําหนดคาเหลานีต้ั้งแตตอน
เร่ิมตนสรางชิ้นงาน แตก็สามารถเปลี่ยนแปลงภายหลังได 

วิธีกําหนดคุณสมบัติเหลานี้ ทําไดโดยเลือกคําสั่ง  
Modify > Document แลวใสคาในไดอะลอ็กบ็อกซ 
จากนั้นคลิก OK 
  
 
 
 
 
 
Dimensions   คือขนาดของสเตจที่ใชในการแสดงมูฟวี่ ซ่ึงสามารถกําหนดไดหลายวิธีดังนี ้

• ใสคาความกวาง และความสงูในชอง Width และ Height ซ่ึงถาหากไมระบุหนวย โปรแกรมจะ
ใชหนวยตามไมบรรทัด (Ruler Unit) มีขนาดมาตรฐานของสเตจ คือ 550 * 400 พิกเซล ขนาด
เล็กที่สุดคือ 1*1 พิกเซล และขนาดใหญทีสุ่ดไดเทากับ 2880 * 2880 พิกเซล 

• Match :Printer เปนการกําหนดขนาดสเตจใหเทากับพืน้ที่ใหญที่สุดที่สามารถพิมพได ซ่ึง
คํานวณจากขนาดกระดาษลบดวยพื้นที่ขอบโดยรอบ (Margin) ตามที่กําหนดไวในสวนของ 
Page Setup 

• Match : Contents เปนการกําหนดขนาดสเตจโดยปรับใหรอบๆ เนี้อหาทั้งหมดเทากันใน
แนวตั้งและแนวนอน โดยพื้นที่วางดานขวาจะถูกปรับใหเทากับพื้นที่วางดานซาย สวนพื้นทีว่าง
ดานลางจะถูกปรับใหเทากับพื้นที่ดานบน ดังนั้นถาตองการใหสเตจมีขนาดพอดกีับเนื้อหาจะตอง
เล่ือนองคประกอบทั้งหมดไปชิดมุมดานซายบนกอนคลิกปุมนี ้

• Match : Default ใชปรับขนาดสเตจใหเทากับคามาตรฐานคือ 550*400 พิกเซล 
Background Color   กําหนดสีพื้นของสเตจ โดยคลิก            แลวเลือกสีที่ตองการจากชุดสีที่ปรากฏขึ้น 
Frame Rate   คืออัตราเร็วในการแสดงภาพเคลื่อนไหว ตัวเลขนี้บอกถึงจํานวนเฟรมของภาพที่จะถูกแสดง

ออกมาใน 1 วนิาที ตามปกตใินการเลนมูฟวี่บนคอมพวิเตอร (รวมทั้งกรณีที่เลนผานเว็บ) ควรใช
ความเร็ว ประมาณ 8-12 fps (frame per second) โดยคามาตรฐานเทากับ 12 fps 

Ruler Units    เลือกหนวยวดัของไมบรรทัด ซ่ึงจะแสดงอยูที่ดานบน และดานซายของพื้นที่ทํางาน 
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การใชสี 
             กอนที่เขาสูเนื้อหาของการวาดภาพ เราควรทราบวิธีใชเครื่องมือเลือกสี 2 ชนิดที่มีในทูลบ็อกซ และ Property 
inspector (รวมทั้งในพาเนล Color Mixer) คือ Stroke Color                  และ Fill Color                    อยางคราวๆ กอน 
 Stroke Color ใชสําหรับกําหนดสีเสน สวน Fill Color ใชกําหนดสีพื้นของรูปทรงเครื่องมือทั้งสองนี้มีวิธีใช
เหมือนกนั คือเมื่อเราคลิกในชองสี            จะปรากฏหนาตางชุดสีขึ้นมา พรอมกับเมาสซ่ึงใชเล่ือนไปคลิกเลือกสีที่ตองการ
ได (คลิกเลือกไดทั้งในตารางชุดสี และจากออปเจ็คอื่นบนสเตจ) ความแตกตางของเครื่องมือทั้งสองนี้คือในชุดสี Fill จะมีสี
แบบไลระดับ หรือเกรเดยีนท (Gradient) เพิ่มขึ้นมา สวนชุดสี Stroke ไมมี เนื่องจากเสนจะใชสีเกรเดียนทไมได 
 
 
 
 
 
 
 
 
 ในกรณีที่เราคลิกชองสีแลวแตไมตองการเลือกสีใหมใหกดคีย Esc หรือคลิกในชองเดิมซ้ําอีกครั้งเพื่อปดหนาตาง
ชุดสี นอกจาก Stroke Color และ Fill Color แลว ในกลุมนี้ยังมีเครื่องมอืชวยอีก 3 ตวัที่อยูถัดลงมา ซ่ึงจะปรากฏเฉพาะบน
ทูลบ็อกซ 

 
ซ่ึงมีหนาที่ดังนี้ 
 
 

 
 
 
 
 
 
 
 
 
 

ตัวอยางที่กําลังเลือก 

คลิกเลือกสี 

เลือกสีอื่นที่ไมไดอยูในชุดสีนี้ 

สีเกรเดียนท 

เลือก Stroke หรือ Fill เพื่อปรับสี ปรับ Stroke หรือ Fill ไมใหมีสี 

สลับสีระหวาง Stroke หรือ Fill  ปรับสี Stroke หรือ Fill เปนคาเริ่มตน  



 

 64 

 
การวาดภาพ 

เครื่องมือวาดรปู และลงสีของ Flash ประกอบดวยอุปกรณพื้นฐานตางๆ คลายกับในโปรแกรมกราฟกทั่วไป เชน 
เครื่องมือสําหรับเลือก  เครื่องมือวาดเสนและรูปทรงแบบตางๆ  เครื่องมือระบายสีและเทสี  ยางลบ ตลอดจนถึงเครื่องมือ
สรางตัวอักษร อยางไรก็ดี หลักเกณฑการทํางานบางอยางใน Flash  จะแตกตางออกไปจากโปรแกรมอื่นคอนขางมาก ซ่ึงผู
ที่เพิ่งเริ่มใชโปรแกรมอาจตองใชเวลาทําความคุนเคยบางเล็กนอย 
 ใน Flash เราใชเครื่องมือวาดรูป และลงสีเพื่อสรางสรรคและปรับแตงออปเจ็คลักษณะตางๆ สําหรับนําไปแสดง
ในมูฟวี่ เนื้อหาของสวนนี้จะอธิบายถึงวิธีใชเครื่องมือที่เกี่ยวของทั้งหมดในรูปแบบที่เขาใจงาย และกะทดัรัด ซ่ึงจะชวยให
เราสรางผลงานที่ตองการไดดังใจ อยางไรก็ดีเครื่องมือบางชนิดเชน Pen Tool นั้น เปนเครื่องมือประสิทธิภาพสูง ซ่ึง
สามารถใชวาดรูปรางไดอยางไมจํากัด แตมีวิธีการใชที่คอนขางซับซอน และตองอาศัยเวลาในการฝกฝนใหคุนเคย ซ่ึงการ
เร่ิมตนดวยความเขาใจวิธีการใชเครื่องมือเหลานี้อยางถูกตอง จะชวยใหเราวาด และตกแตงรูปที่ตองการไดอยางมี
ประสิทธิภาพ 
 

รูปทรง เสน และพื้นรูป (Shape, Stroke และ Fill) 
 เมื่อเราวาดรูปดวยเครื่องมือตางๆ ของโปรแกรม Flash ส่ิงที่เกิดขึ้นเรยีกวา รูปทรง (Shape) ซ่ึงมีองคประกอบ  
2 สวน คือ เสน (Stroke) และพื้นรูป (Fill) ที่สามารถแยกเปนอิสระออกจากกันได 

•  เสน (Stroke) หมายถึง สวนที่เปนลายเสน เชนในกรณีของเสนตรง  เสนโคง  เสนที่ขดเปนลวดลาย รวมทั้ง
สวนที่เปนเสนขอบรอบรูปทรง 2 มิติ เชน วงกลม ส่ีเหล่ียม หรือรูปหลายเหลี่ยมตางๆ คุณสมบัติของเสนมี 
3 สวน คือ สี (Color)  ขนาดหรือความหนา (Height) และลวดลาย (Style) 

 
 
      

 
รูปทรงที่เปนลายเสน จะประกอบดวยเสน (Stroke) เพียงอยางเดียว 

 

• พื้นรูป(Fill) หมายถึง สวนที่เปนพื้นทีภ่ายในของรูปทรง 2 มิติ หรือพื้นที่ที่ลอมดวยเสน คุณสมบัติของ Fill มี
เพียงอยางเดยีวคือสี 

 
      
 
 
 

 
รูปทรง 2 มิติจะประกอบดวยเสนขอบ (Stroke) และพื้นภาพ (Fill) ซึ่งเปนอิสระจากกัน 

    รูปทรง (Shape)            เสนขอบ (Stoke)               พ้ืนภาพ (Fill) 
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 รูปทรง 2 มิติอาจประกอบดวยทั้ง Stroke และ Fill หรือ Fill เพียงอยางเดยีว สวนเสนจะมีเฉพาะ Stroke เทานั้น 
ในการวาดรูปทรงหนึ่งๆ เราสามารถกําหนดคุณสมบัติของ Stroke และ Fill ไวลวงหนา หรือจะแกไขปรับแตงภายหลังก็ได 
 
การกําหนดสี ความหนา และลวดลายของเสน 
 นอกจากสแีลว เสนยังมีคณุสมบัติอ่ืนที่เรากําหนดไดคือ ความหนา (Height) และลวดลาย (Style) ซ่ึงตัวเลือกทั้ง
สองนี้จะปรากฏบน Property  เมื่อเราเลือกเครื่องมือวาดรปูที่เกี่ยวกับเสน หรือเมื่อเราเลือกรูปที่วาดไวแลวซ่ึงมีเสนเปน
องคประกอบอยู 
 
 
 
 
 
 
 
 
 

 
การกําหนดความหนาของเสนทําไดโดยใสคาลงในชองตัวเลข (หนวยเปนพอยต  pt) หรือคลิกปุมดานหลังแลว

เล่ือนสไลเดอร สําหรับลวดลายจะเลือกไดจากรายการที่มีอยูในชอง ปรับลวดลายเสน 
 
 
 
 
 
 
 
 
 
 

               ความหนาเสน                ลวดลายเสน  

สีเสน  
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การสรางตัวอักษรและขอความ 

ไฟลของ Flash ไมจําเปนตองมีเฉพาะรูปภาพเทานั้น  แตเราสามารถใสตัวอักษรหรือแมแตขอความยาวๆ เขาไป
ได  เราสามารถปรับแตงคุณสมบัติของขอความไดหลากหลาย  ไมวาเปนการกําหนดสี  การใชฟอนตหรือรูปแบบตัวอักษร
ตางๆ รวมทั้งฟอนตภาษาไทย  การจัดชองไฟและระยะบรรทัด  นอกจากนี้เรายังสามารถยอ - ขยาย หมุน บดิ จัดกลุม และ
จัดระดับขอความไดเชนเดยีวกับออปเจ็คทัว่ๆ ไป โดยทีย่งัคงแกไขเนื้อหาของขอความนั้นไดหากตองการ 
 เราจะมาดกูันถึงวิธีใชเครื่องมือ Text Tool เพื่อสรางขอความขึ้น  ตลอดจนถึงการปรับแตงขอความในลักษณะ
ตางๆกัน 
 ขอความในโปรแกรม Flash  แบงออกเปน 3 ประเภท ไดแก 

• ขอความคงท่ี (Static Text)  หมายถึง ขอความแบบปกติ  ที่ไมมีการเปลี่ยนแปลง 
• ขอความไดนามิก (Dynamic Text) คือ ขอความที่มีการเปลี่ยนแปลงเกดิขึ้นเรื่อยๆ ตามขอมูลที่รับมา

จากเซิรฟเวอร 
• ขอความอินพทุ (Input Tex)  คือ ฟลดขอความที่ใชรับขอมูลผานแบบฟอรม 
 

ขอความแตละประเภทจะมีออปช่ันปลีกยอยที่ใหเรากําหนดแตกตางกนัออกไปโดยที่ขอความทั้ง 3 ประเภท
สนับสนุนการเขารหัสภาษาแบบ Unicode  
 เราสามารถสรางขอความในแนวนอน (เรียงจากซายไปขวา) หรือขอความในแนวตั้ง (เรียงจากซายไปขวา หรือจาก
ขวาไปซาย) โดยปกตแิลว Flash จะสรางขอความในแนวนอนแตเราก็สามารถแกไขออปชั่นตางๆ ใน Preference ได 
 
ประเภทของฟอนต 
Embedded fonts 
 เมื่อเราใชฟอนตที่ติดตั้งอยูในเครื่องของเราในการออกแบบมูฟวี่ โปรแกรมจะฝงฟอนตไวในไฟล .swf ดวย 
เพื่อใหแนใจวาการแสดงผลใน Flash Player จะเปนไปตามที่ตั้งใจ แตฟอนตบางชนิดก็ไมสามารถฝงไปกับมูฟวี่ไดการ
ตรวจสอบวาฟอนตที่เราใชอยูนั้นสามารถสงออกไปกับไฟลไดหรือไม ใหเลือก View > Preview Mode  > Antialias Text 
เพื่อดูคุณภาพของตัวอักษร ถาขอบของตัวอักษรเปนรอยหยัก  แสดงวาโปรแกรมไมรูจักโครงรางของตัวอักษรชนิดนั้น 
และไมสามารถสงออกไปได 
 
Device fonts  
 ฟอนตอีกประเภทหนึ่งที่สามารถใชไดคือ Device Fonts ซ่ึงจะไมมกีารฝงขอมูลฟอนตไปกับไฟล .swf แต
โปรแกรมจะเลือกใชฟอนตบนเครื่องที่มีลักษณะใกลเคียงกันแทน  ดังนั้นสิ่งที่ผูชมเห็นกแ็ตกตางไป เนื่องจากไมมีการฝง
ขอมูลฟอนตไปกับไฟล จึงทาํใหขนาดไฟลโดยรวมเล็กลง และยังสามารถแสดงผลตัวอักษรขนาดเลก็ (นอยกวา 10 พอยท) 
ไดคมชัดกวาฟอนตที่ฝงมากับไฟล เพราะเปนการใชฟอนตที่ออกแบบมาสําหรับเครื่องนั้นๆ โดยเฉพาะ 
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Device fonts  ในโปรแกรม Flash นั้นมีดวยกัน 3 ชนิด ไดแก 
• _sans ที่คลายกับ Helvetica หรือ Arial 
• _serif ที่คลายกับ Times New Roman 
• _typewriter ที่คลายกับ Courier 

เราสามารถเลือกใชฟอนตเหลานี้ไดจากรายการฟอนตในกรอบ Properties เมื่อมีการแสดงไฟลมฟูวี่  โปรแกรมจะ
เลือก Device font ชนิดแรกที่ปรากฏอยูในเครื่องของผูชม 

 

การสรางขอความ 
 การสรางขอความสามารถทําไดดวยการกําหนดกรอบขอความ (Text block) บนสเตจดวย Text tool ในการสราง
ขอความ ทําไดโดยสรางกรอบขอความเพยีง 1 บรรทัด จากนั้นพื้นที่กรอบจะขยายออกเมื่อมีตามจาํนวนตวัอักษร หรืออาจ
สรางเปนกรอบที่มีความกวางหรือความสูงคงที่ ซ่ึงจะมีการขึ้นบรรทัดใหมใหโดยอัตโนมัติ 
ขั้นตอนการสรางขอความ 

1. คลิกเลือก Text tool    
2. เปดกรอบ Properties  
3. ในกรอบ Properties เลือกชนิดของขอความจากปอปอพัเมนู เพื่อกําหนดชนดิของขอความ 

• เลือก Static Text เพื่อสรางขอบเขตขอความที่ไมเปลี่ยนแปลง 
• เลือก Dynamic Text เพื่อสรางขอบเขตที่แสดงขอความอัพเดทโดยอัตโนมัติ 
• เลือก Input Text เพื่อสรางขอบเขตใหผูใชใสขอความได 

4. สําหรับ Static Text คลิกเลือกปุม Text Direction     
• เลือก Horizontal  เพื่อเรียงขอความจากซายไปขวาในแนวนอน (คาดีฟอลต) 
• เลือก Vertical Left-to-Right เพื่อเรียงขอความในแนวตั้งจากซายไปขวา 
• เลือก Vertical Right-to-Left เพื่อเรียงขอความในแนวตั้งจากขวาไปซาย 

5. ทําตามขั้นตอนใดขั้นตอนหนึ่งตอไปนี ้
• คลิกในตําแหนงที่เราตองการเริ่มตนขอความ เพื่อสรางกรอบที่แสดงขอความบรรทัดเดียว 
• คลิกในตําแหนงที่เราตองการเริ่มตนขอความ แลวลากตามความกวางหรือความสูงที่ตองการ เพื่อ

สรางกรอบขอความที่มีความกวางคงที่ (ขอความในแนวนอน) หรือความสูงคงที่ (ขอความใน
แนวตั้ง) 
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6. ปรับตั้งคาอื่นๆ ของตัวอักษร 
หลังจากสรางขอความแลว ถาตองการเปลี่ยนขนาดของกรอบขอความ ใหลากจดุควบคุมขนาดตาม

ทิศทางที่ตองการ และถาตองการเปลี่ยนประเภทขอความระหวางแบบความกวางหรอืความสูงคงที่กับแบบขยาย
ได ใหดับเบิลคลิกที่จุดควบคุมขนาด 
 

กําหนดคาตางๆ ของตัวอักษร 
 เราสามารถกําหนดคณุสมบัติของตัวอักษรและขอความในแตละยอหนา หรือพารากราฟได คุณสมบัติของ
ตัวอักษรประกอบดวย ชนดิตัวอักษร ขนาด  สไตล  สี  ระยะหางระหวางตัวอักษร  การปรับชองไฟ และตําแหนงของ
ตัวอักษร  สําหรับคุณสมบตัิของพารากราฟประกอบดวย การจัดแนว พื้นที่ขอบ  ยอหนาและระยะหางระหวางบรรทัด โดย
ดีฟอลตแลว ขอมูลเกี่ยวกับตวัอักษรจะถูกฝงอยูใน Flash มูฟวี่ (ไฟล SWF) แตเราก็สามารถเลือกใชตัวอักษรตามอปุกรณ
ได (เฉพาะขอความในแนวตัง้) 
 

 
 

 เมื่อขอความถูกเลือกอยู เราสามารถใชกรอบ Properties ในการเปลี่ยนแปลงคุณสมบัติของอักษร และพารากราฟ 
เวลาที่เราสรางขอความใหม โปรแกรมจะใชคุณสมบัติของตัวอักษรที่เปนอยูปจจุบัน ถาตองการเปลี่ยนแปลงใหคลิกเลือกที่
ขอความกอน แลวจึงทําการปรับแตงคาตางๆ ตามรายละเอียดตอไปนี ้

• เลือกชื่อตัวอักษรจากรายการ หรือใสช่ือเขาไปเอง 
 
 

คลิกสําหรับขอความในแนวนอน        คลิกสําหรับขอความในแนวนอนตั้ง 

ลากสําหรับขอความในแนวนอน        ลากสําหรับขอความในแนวนอนตั้ง 
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• คลิกที่ปุมสามเหลี่ยมทางขวาของชองขนาดอักษร แลวเล่ือนคาขนาดตวัอักษร หรือใสคาขนาดเขาไปเอง 

ตัวอักษรจะใชหนวยเปน Point โดยไมคํานงึถึงหนวยของไมบรรทัดที่กาํหนดไว 
• คลิกเลือกตัวหนาที่ปุม Bold         หรือตัวเอียงที่ปุม  Italic       
• เปลี่ยนสีขอความดวยการเลือกสีจากชองสี (Color box) 
• คลิกเลื่อนคาระยะหางระหวางตัวอักษรที่เลือกหรือขอความทั้งหมด จากชอง Character Spacing หรือใสคา

เขาไปโดยตรง 
• คลิกเลือก Auto Kern ถาตองการใหมกีารปรับระยะหางระหวางตัวอักษรบางตัวเปนพิเศษโดยอัตโนมัติ เพื่อ

ความสวยงาม เชนตัว A กับ V จะถูกปรับใหชิดกนัมากขึน้ 
• เลือกตําแหนงตัวอักษรจากเมนู Character Position คา Normal จะวางตัวอักษรบนเสน ตามปกติ 

Superscript จะวางตัวอักษรเหนือเสนฐาน (ขอความในแนวนอน) หรือดานขวาของเสนฐาน (ขอความใน
แนวตั้ง) Subscript จะวางตวัอักษรใตเสนฐาน (ขอความในแนวนอน) หรือดานซายของเสนฐาน (ขอความใน
แนวตั้ง) 

• สําหรับขอความแบบ Static Text เฉพาะขอความในแนวนอน   เราสามารถเลือกออปชั่น Use Device Fonts 
เพื่อใช Font ที่มีอยูในอุปกรณแสดงผลนั้นๆ 

• สําหรับขอความที่ใช Use Device Fonts จะสามารถเลือกออปชั่น Selectable เพื่อใหผูชมสามารถคลิกเลือก
ขอความของมูฟวี่ไดดวย 
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Timeline 
 ไทมไลนเปนเครื่องมือที่ใชในการสรางภาพเคลื่อนไหว โดยประกอบดวย 2 สวนหลักๆ คือ เลเยอร และเฟรม  ซ่ึง
แตละสวนมีองคประกอบดังนี้ 
 
 
 
 
 
 
 
 
 เลเยอร (Layer) เปรียบเสมือนแผนใส ทีเรียงซอนๆ กันอยู เมื่อเราวาดรูปหรือวางออปเจ็ค ลงไปบนแผนใสแตละ
แผน หากรูปอยูตําแหนงเดียวกันเราจะมองเห็นเฉพาะรปูที่ซอนอยูดานบน 
 
การสรางเลเยอรใหม 

1. คลิกเลือกบนเลเยอรกอนหนาที่ตองการใหเลเยอรใหมอยูดานบน 
2. คลิกปุม Insert Layer        ที่ดานลางของไทมไลน 

จะมีเลเยอรใหมปรากฏขึ้นมาเหนือเลเยอรที่เราเลือกไว โดยชื่อเลเยอรจะเรียงกันไปเลือ่ยๆ เชน Layer 2, 
Layer 3 , ... 
 

การเปล่ียนชื่อเลเยอร 
1. ดับเบิลคลิกที่เลเยอรที่ตองการเปลี่ยนชื่อ 
2. พิมพช่ือใหมเขาไปแทน แลว กดคยี   Enter  ช่ือใหมจะเขาไปแทนชื่อเดิม   

 
การเลือกเลเยอร 

• การเลือกเพียงเลเยอรเดียว    ใชวิธีคลิกเมาสบนไอคอนหรือช่ือเลเยอรนั้น หรือคลิกเฟรมใดเฟรมหนึง่บน 
       เลเยอรนัน้ 
• การเลือกหลายเลเยอรตอเนื่องกัน     ทําโดยการคลิกเลเยอรแรกกอน จากนั้นกดคยี Shift  คางไว   แลวคลิกที ่
       เลเยอรสุดทาย 

 
 
 
 

Layer 

Frame 
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การเปล่ียนลําดับเลเยอร 
• คลิกลากเลเยอรที่ตองการยายไป แทรกไวตรงตําแหนงใหม (จะเหน็วา จะมีเสนประบอกตําแหนงในการวาง 
       เลเยอรแสดงใหเห็นขณะที่คลิกเมาสลาก) เสร็จแลวทําการปลอยเมาส 

 
 
 
 
 
 
การลบเลเยอร 

• เลือกเลเยอรทีต่องการลบ แลวคลิกไอคอนถังขยะ        ที่ดานลางของไทมไลน 
 

เฟรม (Frame) เฟรมมีลักษณะเหมือนกบัฟลมภาพยนต คือแตละชองจะแสดงภาพการเคลื่อนไหวของตัวละคร
ในแตละจังหวะ ซ่ึงเมื่อมีการเลนภาพในเฟรมตามลําดับอยางรวดเร็ว กจ็ะทําใหดูเหมือนวาตวัละครนัน้กําลังเคลื่อนไหว
จริงๆ เฟรมแบง ออกเปน 2 ประเภท คือ คยีเฟรม (Keyframe) และ เฟรมระหวางกลาง (In-between frame) 

คียเฟรม (Keyframe) คือ เฟรมที่เราใชกําหนดการเปลี่ยนแปลงเนื้อหาของมูฟวี่แตละขั้นตอน 
เฟรมระหวางกลาง (In-between frame) คือ เฟรมที่โปรแกรมสรางใหโดยอัตโนมตัิตามลักษณะการเคลื่อนไหว

แบบตางๆ 
 

• การสรางคียเฟรม (Keyframe)  
การสรางคียเฟรมปกติ ซ่ึงจะเปนการก็อปปเนื้อหาของเฟรมที่อยูกอนหนาทั้งหมดทําไดโดย คลิก
เลือกชองเฟรมที่ตองการสรางเปนคียเฟรมแลวเลือก Insert  >  Timeline  >  Keyframe (ลักษณะ
ของ คียเฟรม      ) 
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• การแทรกเฟรมระหวางกลาง (In-between frame) 

การขยายชวงเวลาของการแสดงภาพเคลื่อนไหว สามารถทําไดโดยเพิม่เฟรมเขาไป ในชวงเวลาที่
ตองการโดยมขีั้นตอนดังนี้   

1. เลือกเฟรมปลายทาง หรือเฟรมระหวางกลาง ที่ตองการขยายเวลา 
2. เลือกคําสั่ง Insert  >  Timeline  >  Frame 

 
 

 
• การลบเฟรม  

1. เลือกเฟรมที่ตองการลบ (เฟรมเดียว หรือหลายเฟรมกไ็ด) 
2. คลิกเมาสขวาที่เฟรมที่ตองการลบ จากนั้นเลือก Remove Frames 

 
• การเปล่ียนคียเฟรมใหเปนคียระหวางกลาง 

1. เลือกคียเฟรม   
2. เลือกคําสั่ง Modify > Timeline  >  Clear Keyframe เนื้อหาเฟรมดังกลาว รวมทั้ง

เฟรมอื่นๆ ที่ตอเนื่องจากคยีเฟรมเดิม จะถูกแทนทีด่วยเนื้อหาของเฟรมที่อยูกอนหนา 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 กอนทําการเปลี่ยนคียเฟรม                                       ผลลัพธที่ได 
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การสรางภาพเคลื่อนไหวแบบตางๆ 

เราสามารถสรางภาพเคลื่อนไหวใน Flash  ดวยการเปลี่ยนเนื้อหาในเฟรมที่ตอเนื่องกนั  เราสามารถทําใหออปเจ็ค
เคลื่อนที่ผานสเตจ เพิ่มหรือลดขนาด  หมนุ  เปลี่ยนสี คอยๆ ปรากฏขึ้น  หรือเปลี่ยนแปลงรูปราง  การเปลี่ยนแปลงที่เกิดขึ้น
อาจเปนไปอยางอิสระ หรือเกิดขึ้นพรอมๆ กับการเปลี่ยนแปลงอื่นก็ได  เชนทําใหออปเจ็คหมุนไปพรอมๆ กับกําลัง
เคลื่อนที่อยูบนสเตจ 
 ในโปรแกรม  Flash  มีวิธีการสรางภาพเคลื่อนไหวได 2 แบบ  ไดแก แบบทวีน (Tween animation) และแบบ
เฟรมตอเฟรม (Frame-by-frame-animation) ในการเคลื่อนไหวแบบทวีนนัน้เราเพยีงแตสรางเฟรมเริ่มตน และเฟรม
สุดทาย แลวใหโปรแกรมจดัการสรางเฟรมระหวางกลางขึ้นเอง  พรอมกับความสามารถในการเปลี่ยนแปลงลักษณะตางๆ
ของออปเจ็คอยางคอยเปนคอยไปจากเฟรมสุดทาย  เพื่อใหเกิดลักษณะของการเคลื่อนไหว  สวนการเคลื่อนไหวแบบเฟรม
ตอเฟรมนั้น  เราจะตองสรางภาพขึ้นเองในทุกเฟรม 
 
การเคลื่อนไหวแบบทวีน (Tween  animation) 
 ภาพเคลื่อนไหวแบบทวีนแบงออกเปน 2 ประเภท ไดแก 

• การเปลี่ยนแปลงแบบเคลื่อนไหว (Motion  tween)  เปนการเปลี่ยนแปลงเกิดจากการกําหนดคุณสมบัติของ
ออปเจ็ค เชน ตําแหนง ขนาด  สี  หรือทิศทาง  จากนัน้จงึทําการเปลี่ยนแปลงในภาพหลัง  นอกจากนั้นยัง
สามารถสรางการเคลื่อนไหวแบบตามเสนทางไดอีกดวย (Tween  motion  along  a  path) 

• การเปลี่ยนแปลงรูปราง (Shape  tween)  เปนการเปลี่ยนแปลงระหวางรูปทรงที่แตกตางกัน โดยเราอาจจะ
วาดรูปไวในตอนแรก  แลวทําการเปลี่ยนรูปทรงในภายหลงั  โดยโปรแกรมจะสอดแทรกคา และรูปทรงของ
เฟรมที่อยูระหวางนั้น 

 
การเคลื่อนไหวแบบทวีนนัน้เปนวิธีการที่มปีระสิทธิภาพในการสรางการเคลื่อนไหว และความเปลีย่นแปลงตาม

เวลา  พรอมกบัคงขนาดไฟลที่คอนขางเล็ก  เนื่องจากโปรแกรมเก็บเฉพาะขอมูลการเปลี่ยนแปลงระหวางเฟรมเทานั้น 
 

การเคลื่อนไหวแบบเฟรมตอเฟรม (Frame-by-frame-animation) 
 การเคลื่อนไหวแบบเฟรมตอเฟรมจะมกีารเปลี่ยนแปลงเนือ้หาบนสเตจทุกๆ เฟรม  ซ่ึงจะเหมาะกับภาพเคลื่อนไหว
ที่มีรูปเปลี่ยนแปลงไปในทกุเฟรม  แทนที่จะเปนเพียงการเคลื่อนที่บนสเตจดวยลักษณะดังกลาว  ทําใหโปรแกรมตองเก็บ
ขอมูลในแตละเฟรมอยางครบถวน  ไฟลจงึมีขนาดใหญมากกวาการเคลื่อนไหวแบบทวีน 
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สราง motion tween  ดวยการใชคําสั่ง 
 เปนการสรางคียเฟรมแรกขึน้มากอน  แลวแทรกจํานวนเฟรมที่เราตองการลงในไทมไลน  แลวจึงสั่ง Insert > 
Timeline > Create Motion Tween  จากนั้นจึงเล่ือนออปเจ็คไปยังตําแหนงใหม  โปรแกรมจะสรางคียเฟรมสิ้นสุดใหเอง
โดยอัตโนมัต ิ
 1.      เลือกคียเฟรมเปลาบนไทมไลน   แลววาดออปเจ็คบนสเตจ  
 2.       วาดหรอืนําอารตเวิรคเขามาวางไวในเฟรมแรกของการเคลื่อนไหว ภายในเฟรมควรมีออปเจค็เพียงชิ้นเดียว  
และตองเปนกราฟกออปเจ็ค  
 
 
 
 
 
 

3.     เลือกคียเฟรมบนไทมไลน ในกรอบ  Properties  เลือกการ Tween แบบ Motion    
 
 
 

 
4.     สรางคียเฟรมที่ 2 ในตําแหนงที่ตองการ 

 
 
 
 
 

5. ขณะที่เลือกคยีเฟรมที่ 2 อยู ใหทําการเลื่อน ออปเจ็คไปในตําแหนงทีต่องการ  
 
 
 
 
 
 
 
 
 

วาดรูปวงกลมบน สเตจ 

เลื่อนรูปวงกลมไปยังตําแหนงที่ตองการ 
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6. ทดสอบการเคลื่อนไหวโดยกดคีย Enter  

 
 
 
 
 
 
 
 
การแปลงรูปราง (Tweening  Shape) 
 ดวยลักษณะการแปลงรูปแบบ  Shape  tween  ทําใหเกดิเอฟเฟคตในการคอยๆ เปลี่ยนรูปรางของสิ่งหนึ่งไปยัง
อีกสิ่งหนึ่ง การแปลงรูปดังกลาวนี้จะไดผลดีที่สุดเมื่อมีการแปลงรูปเพียงรูปเดียว  ถาตองการแปลงรูปหลายๆ รูปพรอมกัน
ก็จะตองจัดใหรูปทรงเหลานั้นอยูบนเลเยอรเดียวกัน 
 กอนที่จะเริ่มการแปลงรูปอินสแตนซ กรุป และบิทแมพ นั้นเราจะตองแยกสวนองคประกอบตางๆ ออกจากกนั
กอน  ดวยคําสัง่  Break Apart  และสําหรับขอความ  เราจะตองทําการแยกสวนถึง 2 คร้ังเพื่อเปลี่ยนขอความใหเปน 
ออปเจ็ค  กอนที่จะนําไปสรางการเคลื่อนไหวตอไป 

วิธีการแปลงรปูราง 
1. คลิกที่ช่ือเลเยอร  เพื่อเลือกเลเยอรที่ตองการ  พรอมกับเลือกคียเฟรมเปลาในตําแหนงที่จะใหเปนจุดเริ่มตน

ของการเคลื่อนไหว 
2. วาดหรือนําอารตเวิรคเขามาวางไวในเฟรมแรกของการเคลื่อนไหว  ภายในเฟรมควรมีออปเจ็คเพียงชิ้น

เดียว  และตองเปนกราฟกออปเจ็ค  หรืออินสแตนซ กรุป บิทแมพ และขอความที่ถูกแยกสวนแลว 
 
 
 
 
 
 

3. เลือกคียเฟรมบนไทมไลน   ในกรอบ  Properties  เลือกการ Tween แบบ Shape 
 

 
 
 
 
 

วาดรูปวงกลมบน สเตจ 

ผลลัพธที่ได 
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4. สรางคียเฟรมที่ 2 ในตําแหนงที่ตองการ 

 
 
 
 
 

5. ขณะที่เลือกคยีเฟรมที่ 2 อยู ใหทําการแกไขรูปทรง สี หรือตําแหนงของอารตเวิรคเปนอีกรูปแบบหนึง่   
        ตามตองการ 

 
 
 
 
 
 

6.     ทดสอบการเคลื่อนไหวโดยกดคีย Enter  
 

 
 
 
 
 
 
 

การสรางภาพเคลื่อนไหวแบบเฟรมตอเฟรม 
 ในการสรางภาพเคลื่อนไหวแบบเฟรมตอเฟรม  ทําไดโดยกําหนดแตละเฟรมใหเปนคียเฟรม และใสเนื้อหาที่
แตกตางกันในแตละเฟรม โดยท่ีคียเฟรมใหมจะมีเนื้อหาภายในเหมือนกบัคียเฟรมกอนหนา ทําใหเราสามารถแกไขเนื้อหา
ในเฟรมอยางเปนลําดับขั้น 
 วิธีการสรางภาพเคลื่อนไหวแบบเฟรม มีขั้นตอนดังนี ้

1. คลิกที่ช่ือเลเยอร เพื่อเลือกเลเยอรที่ตองการ พรอมกับเลือกเฟรมที่จะใหเปนจดุเริ่มตนของการเคลื่อนไหว 
2. ถาเฟรมนั้นไมใชคียเฟรม ใหเลือกคําสั่ง Insert > Timeline > Keyframe กอน 
3. สรางอารตเวิรคสําหรับเฟรมแรก โดยเราสามารถใชเครื่องมือวาด Paste กราฟกจาก Clipboard หรือ

อิมพอรตไฟลเขามา 
4. คลิกเฟรมถัดไปทางดานขวา แลวเลือก ส่ัง Insert > Timeline >  Keyframe เพื่อสรางคียเฟรมใหมมีเนื้อหา

เหมือนกับคยีเฟรมที่ผานมา 

แกไขรูปวงกลมบน สเตจ ใหเปนรูปสี่เหลี่ยม 

ผลลัพธที่ได 
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5. ดัดแปลงเนื้อหาภายในเฟรมบนสเตจ เพื่อสรางเนื้อหาทีแ่ตกตางไปเล็กนอยในการเคลื่อนไหว 
6. ทําซ้ําขั้นตอนที่ 4 และ 5 เพือ่สรางการเคลื่อนไหวจนครบ 
7. ทดสอบการเคลื่อนไหวโดยกดคีย Enter  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เฟรม 1 

เฟรม 2 

เฟรม 3 

ผลลัพธที่ได 
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การควบคุมภาพเคลื่อนไหวดวย Action Script 
ภาษา ActionScript และ พาเนล Actions 
 ActionScript เปนภาษาที่ใชในการเขยีนโปรแกรม (Programming Language) ที่ Flash ไดนํามาใชเพิ่ม
ความสามารถของมูฟวี่ในการโตตอบกับผูชมภาษานี้มีลักษณะเปน Object-oriented เชนเดียวกับ JavaScript  ผูสรางเว็บ
ใชเพื่อเพิ่มคณุสมบัติอินเตอรแอคทีฟใหกบัเว็บเพจ โดยทั้ง ActionScript และ Javascript จะมีรูปแบบคําสั่ง และวิธใชที่
คลายคลึงกัน 
 การใชคําสั่งบางสวนของ ActionScript ตองอาศัยพื้นฐานความเขาใจเกี่ยวกับการเขยีนโปรแกรมที่ลึกซึ้ง
พอสมควร แตก็มีหลายคําสั่งที่เราไมจําเปนตองมีความรูอะไรมากก็สามารถจะนํามาใชสรางมูฟวี่โตตอบที่นาสนใจได
หลากหลายลักษณะ 
 
พาเนล Actions 
 วิธีสรางและแกไขคําสั่ง ActionScript จะทําโดยใชพาเนล Action ซ่ึงเราสามารถเปดขึ้นมาไดโดยเลือกคําสั่ง 
Windows > Actions จะปรากฏพาเนลซึ่งมีสวนประกอบดังนี ้
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเพื่อเปด / ปด

เพิ่มคําสั่ง    ลบคําสั่ง 
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วิธีสรางคําสั่ง 
 การสรางคําสั่งจะเริ่มจากการคลิกเลือกคียเฟรม หรือออปเจ็คที่จะกําหนดคําสั่งใหทํางานจากนัน้ในพาเนล Action 
ให 

• คลิกปุม Add            จากนั้นเลื่อนไปยังกลุมคําสั่งที่ตองการใชแลวเลือกคําสั่ง 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
วิธียาย กอปป และลบคําสั่ง 
 คําสั่งที่สรางไวแลว ราสามารถยายตําแหนง กอปปหรือลบออกได แตกอนที่จะทําเราจะตองเลือกคาํสั่งนั้นๆ กอน
โดยใชเทคนิคตอไปนี ้

• การเลือกคําสั่งเพียงบรรทัดเดียว ใหเล่ือนเมาสไปคลิกที่บรรทัดนั้น 
• การเลือกคําสั่งหลายบรรทัดที่ติดกัน ใหเล่ือนเมาสไปคลิกลาภผานบรรทัดของคําสั่งเหลานั้น 

การยายคําสั่งสามารถทําไดโดย 
• ใชเมาสคลิกลากคาํสั่งที่เลือกไวไปแทรกตรงตําแหนงทีต่องการ 
• คลิกปุม down        เพื่อยายคาํสั่งที่เลือกไวลง 1 บรรทัด หรือคลิกที่ปุม up        เพื่อยายขึ้น 1 บรรทัด 

การกอปปคําสัง่สามารถทําไดโดย 
• ใชเมาสคลิกลากคําสั่งที่เลือกไว ไปแทรกตรงตําแหนงทีต่องการ โดยกดคีย Ctrl คางไวดวย 
• คลิกขวาบนคําสั่งที่เลือกไวแลวเลือก Copy จากนั้นคลิกเลือกบรรทัดปลายทาง  คลิกขวาบนบรรทดันั้น แลว

เลือก Paste คําสั่งที่กอปปมาจะถูกแทรกไวตอจากบรรทดัปลายทาง 
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การลบคําสั่งสามารถทําไดโดย 

• กดคีย Delete 
• คลิกปุม minus   
ในการยายกอปปหรือลบคําสั่งหากคําสั่งเหลานั้นเปนกลุมคําสั่งที่มีคําสั่งยอยอยูภายใน(สังเกตวาคาํสั่งยอยจะรน

เขาไปทางขวา) ผลการยาย กอปป หรือลบจะมีตอคําสั่งทัง้กลุมเสมอ 
ถาหากการแกไขผิดพลาด และตองการยกเลิกใหคลิกขวาตรงที่ใดๆ ในชองนั้นก็ไดแลวเลือกคําสั่ง Undo 

 

กําหนดแอ็คชั่นใหกับเฟรม 
 การกําหนดแอค็ชั่นใหกับเฟรม จะทําใหมฟูวี่แสดงแอ็คชั่นนั้นขึ้นมาเมื่อหัวอาน (Playhead) เล่ือนมาถึงเฟรมนัน้
บนไทมไลน เชนถาตองการสรางลูปบนไทมไลนระหวางเฟรมที่ 20 และ 10 ก็จะตองใสแอ็คชั่นไวที่เฟรม 20 เพือ่ส่ังให
หัวอานวิ่งไปที่เฟรม 10 ดังนี้ 
 GotoAndPlay (10) 
 แอ็คชั่นบางอยางมักจะถูกกําหนดไวที่เฟรมแรกของมูฟวี่เสมอ เชน คําสั่งที่กําหนดฟงชั่น และตวัแปรในตอน
เร่ิมตนของมูฟวี่ รวมถึงแอ็คชั่นอื่นๆ ที่เราตองการใหเกดิขึ้นในตอนเริม่ตนของมูฟวี่ รวมถึงแอ็คชั่นอื่นๆ ที่เราตองการให
เกิดขึ้นในตอนเริ่มตนของมฟูวี่แนะนําใหใสแอ็คชั่นสําหรับเฟรมทั้งหมดไวบนเลเยอรเดียวกัน เพื่อทีจ่ะไดคนหาอยาง
สะดวก 
 วิธีการกําหนดแอ็คชั่นใหกับเฟรม 

1. เลือกคียเฟรมบนไทมไลนแลวเลือก Window > Actions 
2. ใสแอ็คชั่นใหกับเฟรมดวยการดับเบลิคลิกที่คําสั่ง 
3. ใสพารามิเตอรที่จําเปนสําหรับแอ็คชั่นนั้น 
  เฟรมที่มีแอ็คชั่นกําหนดอยูจะแสดงดวยตวัอักษร a บนไทมไลน และเราอาจทดสอบคําสั่งโดยเลือก  
       Control > Test Movie 
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กําหนดแอ็คชั่นใหกับปุม 
 การกําหนดแอค็ชั่นใหกับปุมจะทําใหมูฟวี่แสดงแอ็คชั่นขึน้มา เมื่อปุมถูกคลิกหรืออยูใตตําแหนงของเมาสโดยการ
กําหนดแอ็คชัน่ไวกับอินสแตนซของปุมซึ่งจะไมมีผลกระทบตออินสแตนซอ่ืนที่มาจากซิมโบลเดียวกัน และเมื่อเรากําหนด
แอ็คชั่นใหกับปุมจะตองใสคาํสั่งไวภายในตัวควบคุม on พรอมทั้งระบเุหตุการณของเมาสหรือคียบอรดที่จะทําใหเกิด
แอ็คชั่นขึ้น ซ่ึงใน Normal Mode นี้โปรแกรมจะใส event เปน on(release){............} มาใหอัตโนมัติ 
 วิธีการกําหนดแอ็คชั่นใหกับปุมมีดังนี ้

1. เลือกปุมที่ตองการแลวเลือก Window > Actions 
2. ใสแอ็คชั่นใหกับเฟรมดวยการดับเบิลคลิกที่คําสั่ง 
3. ใสพารามิเตอรที่จําเปนสําหรับแอ็คชั่นนั้น เสร็จแลวทดสอบคําสั่งโดยเลือก Control > Test Movie 

 
 
 
 
 
 
 
 
 

 
 
 
 
การนําภาพกราฟกมาใชในโปรแกรม 

เราสามารถอิมพอรตไฟลรูปภาพไดหลายประเภทดังนี ้
 ภาพบติแมพ Flash สามารถนําเขาภาพบติแมพหลายชนิด ซ่ึงชนิดหลักๆ ก็เชน    
                                     JPG, GIF, BMP, PNG, TIFF, PCT, PSD, PIC 
 ภาพเวคเตอร Flash รูจักไฟลภาพเวคเตอรเกือบทุกชนดิ แตชนิดหลักๆ จะประกอบดวย  
                                     WMF, AI, EPS, DXF, EMF, SGI, PNTG, QTIF, TGA ,   
                                     FreeHand(.fh-,ft10) และมูฟวี่ของ FutureSplash Player(.spl) 
 ภาพเคลื่อนไหว ชนิด animated GIF และ Flash Player(.swf) จะถูกอิมพอรตเขามา  
                                          เปนมูฟวีภ่าพเคลือ่นไหว 
 ภาพวดิีโอ ชนิด Audeo Interleaved(.avi) Digital Video(.dv),Motion Picture   
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วิธีการอิมพอรตภาพ 
 ไมวาจะเปนไฟลรูปภาพประเภทใด จะใชวิธีการอิมพอรตแบบเดยีวกันดังนี ้

1. เลือคําสั่ง File > Import  > Import to Stage… 
2. เปดหาและดับเบิลคลิกชื่อไฟลที่ตองการในไดอะล็อกบ็อกซ Import 

 
 
 
 
 
 
 
 
 
 
 

3. รูปภาพนั้นจะปรากฏบนสเตจ โดยจะมีสถานะเปนอยางไรก็ขึ้นกับประเภทของมนัคือ 
• กรณีเปนภาพบิทแมพ จะไดออปเจ็คเพียงชิ้นเดียว และมีรายการปรากฏขึ้นในไลบรารีโดยมีประเภทเปน

ภาพบิทแมพไมใชซิมโบลปกติของ Flash 
• กรณีเปนภาพเวคเตอรทั่วไป ภาพจะประกอบดวยกลุมของออปเจ็คยอยที่ใชสรางมันขึ้นมา โดยไมมี

รายการปรากฏในไลบรารี ออปเจ็คเหลานี้เราสามารถแกไขและปรับแตงไดเหมือนรูปวาดของ Flash เอง 
 

การนําภาพเคลื่อนไหวไปใชกับเว็บ 
หลังจากที่เราไดสรางผลงานมาจนกระทั่งบทนี้ ก็ถึงเวลาทีจ่ะนําผลงานนัน้ออกสูสายตาของผูชมทั่วไปผานทางเว็บ

เพจเสียที ในการนํามูฟวี่ไปเลนบนเว็บเพจ เราควรจะกําหนดคาตางๆ เพื่อปรับคุณสมบัติและขนาดของไฟลใหเหมาะสม
กับการนําไปใช โดยไฟลมูฟวี่ของ Flash (ไฟล.fla) ที่เราสรางขึ้น จะถูกนําไปใชในรปูไฟลมูฟวี่ของ Flash Player 
(ไฟล.swf) 
 นอกจากนั้นเรายังสามารถเอ็กซพอรต มูฟวี่ออกไปในรปูของไฟลรูปภาพ GIF, JPEG รวมทั้งไฟลวิดีโอ 
QuickTime, AVI และอื่นๆ เพื่อนําไปใชกบังานที่มีความตองการแตกตางออกไป หรือสําหรับใชกบับราวเซอรที่ไมมีปล๊ัก
อินของ Flash Player ติดตั้ง แตปจจุบนัผูใชอินเตอรเน็ตสวนใหญจะใชบราวเซอรที่มีปล๊ักอินของ Flash  Player อยูแลว 
ซ่ึงไดแก Netscape 2 ขึ้นไป และ Internet Explorer 3 ขึ้นไป 
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 การนําไฟล .swf ไปนําเสนอบนเว็บเพจ สามารถทําได 3 วิธีคือ 

• สําหรับผูที่คุนเคยกับการเขยีนโคด HTML เราอาจใชแทก็ OBJECT หรือ EMBED พรอมกับการ
กําหนดคาแอตทริบิวต และ Value ที่เหมาะสม เพื่อจัดวางไฟล.swf ไวในเว็บเพจเอง 

• ใหโปรแกรม Flash สรางแท็กสําเร็จรูป เพื่อใหเรากอปปไปใชในไฟล HTML ไดทนัที โดยไมตอง
เขียนโคดเอง เราสามารถนําโคดนี้ไปใสในเว็บเพจที่เขยีนดวยภาษา HTML โดยตรง หรือในเว็บเพจที่
สรางดวยโปรแกรมอื่นๆ ก็ได  เชน FrontPage 

• โดยการใชโปรแกรม Dreamweaver ซ่ึงเปนโปรแกรมชวยสรางเว็บเพจที่มีการทํางานแบบ 
WYSIWYG จากผลิตรายเดียวกับ Flash นี่เอง เมื่อใช Dreamweaver สรางเว็บเพจ เราสามารถใช
เครื่องมือที่มีในโปรแกรม เพื่อแทรกมูฟวี่เขาสูเว็บเพจไดทันที 

 

คําแนะนําเพื่อการสรางไฟลมูฟวี่ใหมขีนาดเล็ก 
 แมวาโปรแกรม Flash จะสามารถปรับไฟลมูฟวี่ที่จะนําไปใชมีขนาดเล็กลงไดโดยอัตโนมัติ แตจะเปนการดกีวา
หากเราควบคมุการสรางผลงานในทกุขั้นตอน เพื่อที่จะทําใหไดไฟลที่มีขนาดเล็กทีสุ่ด เพราะเมื่อนํามูฟวีไ่ฟแสดงบนเว็บ
เพจ ถาไฟลมขีนาดใหญ ผูชมจะตองเสียเวลาโหลดนานซึ่งอาจจะทําใหไมอยากแวะมาเยี่ยมชมเว็บของเรา วิธีทําใหมูฟวี่มี
ขนาดเล็กลงทีสุ่ดเทาที่จะเปนไปได ใหปฏิบัติตามขอแนะนําตอไปนี ้
 

คําแนะนําในสวนที่เกี่ยวกับการสรางมฟูวี่โดยทั่วๆ ไป 
• ควรใชซิมโบลแทนออปเจค็ทุกชนิดที่ปรากฏในมูฟวี่มากกวาหนึ่งครั้ง 
• ในการสรางภาพเคลื่อนไหว ควรใชวิธีสรางแบบ Tween ทุกครั้งที่เปนไปได เพราะหากใชภาพเคลื่อนไหว

แบบเฟรมตอเฟรม จะตองใชคียเฟรมจํานวนมากจึงทําใหไฟลมีขนาดใหญ 
• ในการสรางซิมโบลภาพเคลื่อนไหวควรทาํเปนมูฟวี่คลิปจะดกีวากราฟกซิมโบล 
• พยายามจํากดัพื้นที่การเปลี่ยนแปลงของออปเจ็คในคยีเฟรม โดยใหการเปลี่ยนแปลงหรือการเคลื่อนไหวของ

ภาพประเภทบทิแมพ ควรใชภาพบิทแมพสาํหรับทําเปนฉากหลังและภาพนิ่งเทานัน้ 
• การใชเสียงประกอบ ควรใชเสียงประเภท MP3 ซ่ึงเปนเสียงที่มีขนาดของไฟลคอนขางเล็ก 
 

คําแนะนําเกี่ยวกับการสรางออปเจ็ค 
• ควรจัดออปเจค็ตางๆ เขาเปนกลุม ใหมากที่สุดเทาที่จะทาํได 
• ใชเลเยอรเพื่อแยกออปเจ็คทีม่ีการเคลื่อนไหวและที่ไมไดเคลื่อนไหวออกจากกัน 
• ควรใชคําสั่ง Modify > Optimize เพื่อชวยลดจํานวนเสนที่ประกอบกนัขึ้นเปนรูปทรงตางๆ 
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• ไมควรใชเสนแบบเสนประ เสนจุด หรือเสนที่เปนลวดลายตางๆ การใชเสนทึบธรรมดา จะทําใหไฟลมีขนาด

เล็กกวา นอกจากนี้การวาดเสนดวย Pencil Tool จะทําใหไฟลเล็กกวาการใช Brush Tool 
 

วิธีเอ็กซพอรตภาพเคลื่อนไหวไปใชกับเว็บ 
1. เปดมูฟวี่ทีต่องการเอ็กซพอรต แลวเลือกคําสั่ง  File > Export  > Export Movie 
2. ตั้งชื่อและเลือกชนิดของไฟลเปน .swf  แลวคลิกปุม Save 

 
 
 
 
 
 
 
 
 
 
 

3.  กําหนดออปชั่น ในสวนของ JPEG Quality ใหปรับเปน 100 เพื่อความคมชัดของภาพเคลื่อนไหว เสร็จแลว 
        เลือก OK 
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SWiSHmax เปนโปรแกรมที่ใชสําหรับสรางงานทางดานกราฟก เชน การสรางตัวอักษร ภาพนิ่ง และ

ภาพเคลื่อนไหวที่สามารถนําไปใชกับงานประเภทตางๆ ไดเชนเดียวกบัโปรแกรม Flash เชน งาน Presentation งาน 
Animation หรือ แมกระทั่งการออกแบบ และพัฒนาเว็บไซต เปนตน ลักษณะการใชงานของโปรแกรม SWiSHmax จะงาย
กวาโปรแกรม Flash เนื่องจากมี Effect สําเร็จรูปประเภทตางๆ มาให นอกจากนี้ยังสามารถเขียนสคริปตเพื่อควบคุมการ
ทํางานได ทําใหโปรแกรม SWiSHmax เปนที่นาสนใจ และกําลังไดรับความนิยมเปนอยางมาก และยังสามารถสรางงาน 
Animation เชน การสรางภาพเคลื่อนไหวที่มีการเลนเสียง ในเวลาเดยีวกันไดเหมือนกับโปรแกรม Flash แตสามารถทําได
สะดวกและรวดเร็วกวา ดังนัน้จึงทําให SWiSHmax เปนโปรแกรมที่นาสนใจสําหรับผูที่ตองการสรางงาน Animation การ
นําเสนองานตางๆ ผานทางเว็บไซต รวมถึงการออกแบบ และพัฒนาเวบ็ไซตใหมีรูปแบบที่นาสนใจ 

SWiSHmax ประกอบดวยเครื่องมือตางๆ ที่ชวยใหการสรางชิ้นงานมีความหลากหลาย ทั้งการสรางภาพนิ่ง และ
ภาพเคลื่อนไหวที่สามารถใส Effect ไดมากกวา 230 แบบ นอกจากนี้เราสามารถควบคุมการทํางานดวยสคริปต ทําใหงานที่
สรางขึ้นเปนไปตามความตองการ อีกทั้งสามารถนําไปแสดงผลใน Flash Player, Browser และ Media Player ไดอีกดวย 

 

แนะนําองคประกอบหลัก และพ้ืนที่การทํางานของโปรแกรม 
 เมื่อเร่ิมใชงานโปรแกรมโดยคลิกที่ปุม  Start > Programs > SWiSHmax จะปรากฏจอภาพดงัรูป 
 
 
 
 
 

Main Menu                Toolbars 

Main Menu                Toolbars 

Outline Panel 

Layout Panel 

Object Panel 

Status Bar 

Timeline Panel 
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1.  Main Menu  คือ เมนูที่ใชแสดงชุดคําสั่งทั้งหมดของโปรแกรม SWiSHmax เมือ่คลิกเลือกเมนูคําสั่ง จะปรากฏ

คําสั่งยอยใหเลือกตามตองการ 
2.  Toolbars คือแถบเครื่องมือที่มีไอคอนคําสั่งตางๆ เพื่อใหสามารถเขาถึงคําสั่งไดทันที โดยการทํางานของ 

ไอคอน คําสั่งจะเหมือนกับการใชคําสั่งใน Main Menu ในครั้งแรกที่เปดโปรแกรมจะมีเพยีง Standard Toolbar, Insert 
Toolbar และ Control Toolbar แสดงอยูบนจอภาพ โดยในโปรแกรม SWiSHmax จะมี Toolbar ทั้งหมด 6 ชนดิ ไดแก 
Standard Toolbar, Insert Toolbar,Control Toolbar, Grouping Toolbar, Export Toolbar และ Toolbar ที่ผูใชสราง
ขึ้นเอง 

3. Timeline Panel เปนสวนที่ใชสําหรับสรางภาพเคลื่อนไหว โดยการใส Effect และสคริปตใหกับออปเจ็ค 
ตางๆ Timeline Panel จะแบงออกเปน 3 สวน ดังรูป 

 
 
 

 
 
 
 

• ปุมคําสัง่  เปนสวนที่รวบรวมปุมคําสั่งในการสรางภาพเคลื่อนไหว และปุมคําสั่งที่ใชปรับแตง Timeline ซ่ึง
ปุมทั้งหมดมีลักษณะ และวิธีการใชงาน ดังนี้ 

 
ใชสําหรับใส Effect ใหกับออปเจ็ค เพื่อสรางเปนภาพเคลื่อนไหว ซึ่งปุมนี้ จะปรากฏเมื่อคลิกที่ 
ออปเจ็ค และเมื่อคลิกที่ปุมนี้ จะปรากฏรายการ Effect ให เลือก เชน Fade, Zoom, Blur เปนตน 
 
ใชสําหรับลบ Effect ที่เลือกใน Timeline  
 
ใชสําหรับแกไขการแสดง Timeline เชน ปรับความกวางของเฟรม ปรับความสูงของ Timeline 
 
ใชสําหรับยอหรือขยายกลุมของปุมคําสั่ง 
 

• Object Label  เปนสวนทีใ่ชสําหรับแสดง Scene และออปเจ็คตางๆ โดยในสวนนีจ้ะมีปุมคําสั่ง 2 ปุม คือ 
ปุม Forward Arrow               ใชเล่ือนไปที่ Scene กอนหนานี้ และปุม Backward              ใชเล่ือนไปที่ 
Scene ตอไป 

• Timeline   เปนสวนที่ใชสําหรับกําหนดการเคลื่อนไหวของออปเจ็คตางๆ โดยภายใน Timeline  
                          ประกอบดวย 
 

ปุมคําสั่ง       Object Label                                    Timeline 
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• เฟรม (Frame)  มีลักษณะเปนชองเล็กๆ เมื่อนําหลายเฟรมมาเรียงตอเนือ่งกัน จะมีลักษณะ

เหมือนตาราง ซ่ึงเรา  เรียกวา Timeline 
• Frame Ruler   คือแถบบอกจํานวนเฟรม ซ่ึงอยูดานบนของ Timeline โดยจะเริ่มตนจากเฟรม  

0 เปนตนไป 
• Play Head   คือเสนสีแดงที่ใชสําหรับบอกตําแหนงวาขณะนีก้ําลังทาํงานอยู ณ เฟรมใด 

 
4.  Outline Panel เปนสวนที่ใชในการจัดการกับ Scene และออปเจ็คตางๆ เชน การเพิ่ม และลบ Scene หรือ

ออปเจ็ค นอกจากนีย้ังแสดง Scene ทั้งหมด และแสดงออปเจ็คตางๆ ในแตละ Scene โดยลักษณะจะอยูในรูปของ
แผนภาพตนไม ที่มีการแบงลําดับชั้น 

5.   Layout Panel เปนสวนที่ใชสําหรับแสดงตําแหนงของออปเจ็ค การจัดลักษณะ และรูปทรงตางๆ ของออป
เจ็คที่อยูใน Workspace โดยใชเครื่องมือ (Tools) ที่จดัเตรียมไวใหใน Layout Panel นอกจากนีย้ังใชในการแสดงผลลัพธ
ของ Movie โดยภายในLayout Panel มีสวนประกอบดงันี้ 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Workspace    เปนพืน้ที่หลักที่ใชสําหรับแสดง แกไข และปรับแตงออปเจ็คนอกจากนี้ยังเปนพื้นที่ที่ใช
ดูการแสดง Movie โดยถาใชในการแสดง Movie พื้นทีส่วนนี้จะเรียกวา “Stage” 

2. Layout Title แสดงชื่อของ Scene ที่กําลังทํางานอยูในปจจุบัน 
3. Toolbox  เปนกลองที่ใชสําหรับบรรจุเครื่องมือ ในการวาดภาพตางๆ เครื่องมือสําหรับปรับแตง  

ออปเจ็ค เครื่องมอืสําหรับเลือก และปรับมมุมองของออปเจ็ค  
4. Tool Options  เปนสวนเครือ่งมือเพิ่มเติมที่ใชงานรวมกบัเครื่องมือตางๆ ใน Toolbox เพื่อปรับแตง

ออปเจ็คที่ไดสรางขึ้น 

 
Workspace 

Layout Title 

Toolbox 

Tool Option 

View Option 
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5. View  Options  เปนกลุมเครื่องมือที่ใชสําหรับปรับขนาดมุมมองของ Workspace ใหเปนไปตาม

ตองการ 
6. Object Panel เปนสวนที่ใชกําหนดคุณสมบัติของ Movie, Scene และออปเจ็คตาง ๆ ที่เลือกมาใชงาน 

 

การสรางขอความ 
 ขอความเปนออปเจ็คชนิด Text ที่ถูกสรางลงบน Scene โดยขอความเหลานี้อาจเปนตัวอักษรในลกัษณะตางๆ 
เชน กลุมขอความ ตัวอักษรตัวเดยีว สัญลักษณ หรืออาจเปนไฟลขอมลูที่มีนามสกุลของไฟลเปน .txt ก็สามารถนํามาสราง
เปนขอความได โดยสามารถสรางได ดังนี้  

1. คลิกไอคอน  Insert Text            จาก Insert Toolbar 
2. พิมพขอความที่ตองการใน Text Object Panel (อยูทางขวามือของ Workspace) 

 
 

 
 
 
 
 
 
 
 

การปรับแตงขอความ 
 การปรับแตงขอความของโปรแกรม SWiSHmax จะเหมอืนกับโปรแกรมที่ใชบน Windows เชน Microsoft 
Word ที่สามารถปรับสี ขนาด รูปแบบตัวอักษร และลักษณะการจัดวาง แตจะมีบางสวนที่แตกตางกนั เชน การกําหนดชนิด
ของขอความ เปนตน โดยการกําหนดคณุสมบัติตางๆ ใหกับออปเจ็ค Text จะทําไดจากจอภาพ “Text Object Panel” โดย
จะปรากฏเมื่อคลิกเลือกขอความ 

ลักษณะจอภาพ “Tex Object Panel” ของออปเจ็ค Tex ในแตละชนดิ (Text Type) จะแตกตางกนับางเล็กนอย แต
สวนประกอบหลัก ๆ จะเหมอืนกัน 
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Name   กําหนดชื่อใหกับออปเจ็ค Text 
Target    สําหรับกําหนดใหออปเจ็ค Text ทํางานรวมกับสคริปต โดยจะแสดงเมื่อใสช่ือใหกับออปเจ็ค Text 
Font Type    กําหนดรูปแบบของการแสดงฟอนต (ซ่ึงในรูปเปนแบบ Vector) 
Text Direction           กําหนดทิศทางของขอความ 
Insert Character          สําหรับใสตัวอักษรพิเศษ 
ปุม  Text Type Selection  กําหนดชนิดของขอความใหเปนแบบ Static Text, Dynamic Text หรือ Input Text 
 

การนําเขารูปภาพกราฟก 
การนํารูปภาพกราฟกเขามาใชในโปรแกรม SWiSHmax สามารถทําได 3 วิธี คือ การนําเขาโดยใชออปเจ็ค Image 

การใชคําสั่ง File > Import และการนําเขาทาง Content  Object Panel ซ่ึงเปนเพียงการนํารูปภาพเขามาเก็บไวใน
โปรแกรมแตยงัไมไดนําไปใชงาน โดยในหัวขอนีจ้ะกลาวถึงการนําเขารูปภาพกราฟฟกโดยใชออปเจ็ค Image ซ่ึงมี
ขั้นตอนดังนี ้

1. เขาสูโปรแกรม SWiSHmax คลิกที่ปุม Insert ในจอภาพ “Outline Panel” เลือก Image จะปรากฏจอภาพ  
       “Open” 
2. คลิกเลือกโฟลเดอรที่เก็บรูปภาพ แลวคลิกเลือกรูปภาพทีต่องการ ในทีน่ี้เลือกภาพเคลื่อนไหวที่มไีฟลเปน .gif 

จากนั้นคลิกปุม Open  
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การสรางภาพเคลื่อนไหว 

งานมัลติมีเดียในปจจุบนั สวนใหญเปนงาน Animation ที่เกิดจากการทําใหออปเจ็คเคลื่อนที่ หรือเคลื่อนไหวไป
ตามรูปแบบทีก่ําหนด โดยการใส Effects ใหกับออปเจ็คนั้น ซ่ึงโปรแกรม SWiSHmax  เปนโปรแกรมที่มีความโดดเดนใน
เร่ืองการใส Effects ใหกับตวัอักษรหรือออปเจ็ค ไมวาจะเปนแบบแตกกระจาย (Explode) แบบหมุน 3 มิติ แบบมวนตี
ลังกา หรือประยุกตหลายๆ แบบมารวมกนั ซ่ึงสามารถทําไดงายและรวดเร็ว 
การกําหนด Effect ใหกบัออปเจ็ค 
 การทําใหอ็อบเจ็คเคลื่อนไหว หรือเคลื่อนที่ไปตามรูปแบบที่กําหนด เรียกวา การใส Effect ใหกับออปเจ็คสามารถ
กําหนดไดจากการคลิกเลือกออปเจ็ค จากนัน้คลิกปุม Add Effect                                ใน Timeline Panels 
 
 
 
 
 
 
 
 
 
 
 
 

เมื่อคลิกปุม Add Effects ใน Timeline Panels แลว ใหเลือก Effect ที่ตองการใชงานใหกับออปเจ็ค โดยในที่นี้
กําหนด Effect “Blur” ใหกบัออปเจ็ครูปภาพ จะปรากฏชวงเวลา หรือความยาวในการแสดงผล เรียกวา “Timeline Object” 
ใน Timeline Panels 
 
 
 
 
 
 
 
 
 
 

Timeline Object 
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จากรูป เปนการกําหนด Effect “Blur” (การสรางภาพเคลื่อนไหวแบบเบลอ) ใหกับออปเจ็คจากชวง Timeline ที่ 0 

Timeline ที่ 20 ซ่ึง Effect “Blur” จะแสดงผลดังรูป 
 
 
 
 
 
 
 
 
 

 
การปรับแตง Effect 
 การสรางภาพเคลื่อนไหวในโปรแกรม SWiSHmax ทําไดสะดวก และรวดเร็ว โดยการกําหนด Effect  ใหกับ 
ออปเจ็คนั้นๆ นอกจากนี้ยังสามารถเพิ่ม Effect หรือปรับแตงคารายละเอียดการใชงานใน Properties ได โดยการดับเบิ้ล
คลิกที่ Timeline Object หรือคลิกขวาที่ Timeline Object ของออปเจ็คนั้นๆ แลวคลิกเลือก Properties จะปรากฏ 
Properties Panel ของ Effect โดยแตละ Effect อาจจะแตกตางกันไป แสดงไดดังรูป 
 
 

 
 
 
 
 
 

Properties คือ การกําหนดคุณสมบัติบางอยางใหกับออปเจ็ค เชน การกําหนดขนาดออปเจ็ค การกาํหนดทิศ
ทางการเคลื่อนที่ในในแนวแกน X แกน Y กําหนดทิศทางการหมุน การปรับคา Alpha และการใสสีใหกับออปเจค็ เปนตน 
ซ่ึง Properties ในแตละ Effect จะมแีท็บการปรับคาตางกันไป บาง Effect  มีแท็บในการปรับคา Properties เหมือนกัน 
บาง Effect มีแท็บไมเหมือนกัน 

 
 

 ภาพจากเฟรมที่ 1                                           ภาพจากเฟรมที่   10                                      ภาพจากเฟรมที่  20 
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การลบ Effect 
 หากตองการลบ Effect ออกจากออปเจ็ค สามารถเลือกทําไดทั้งหมด 4 วธีิ ดังนี้ 

1. คลิกเมนู Edit จาก Main Menu แลวเลือก Delete Effect 
2. คลิกเมาสขวาที่ Timeline Object แลวเลือก Delete Effect 
3. คลิกปุม Delete Object                               ที่ Timeline Panels 
4. คลิกที่ไอคอน Delete             ที่ Toolbars 

 
การแปลงไฟลโปรแกรม SWiSHmax เปน File SWF เพ่ือใชกับเว็บ 

1. เปดไฟลที่ตองการ สงออกไปเปน ไฟล SWF 
2. คลิกที่เมนู   File >  Export > SWF 
3. เลือกโฟลเดอรที่ตองการจัดเก็บไฟล แลวกําหนดชื่อไฟลลงในชอง File Name แลวเลือก Save 
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Macromedia Dreamweaver 8 เปนโปรแกรมสรางเวบ็แบบมืออาชีพ โดยเปน HTML Editor ในแบบ Web 

Graphic Design ที่ใชในการออกแบบ  แปลงคําสั่ง  และพัฒนาเว็บไซต  เว็บเพจ  และการโปรแกรมบนเว็บ ดวย 
Dreamweaver นี้จะชวยใหเราสามารถสรางสรรคเว็บไซตไดอยางงายดาย ไมวาจะดวยการใชตวัชวยดวยคุณลักษณะ 
Visual  ที่เปนคุณสมบัติเดนของโปรแกรม หรือดวยการเขียนคําสั่ง HTML เองก็ได 
ชุดโปรแกรมของ Dreamweaver  
 โปรแกรม macromedia Dreamweaver เปนผลงานชิ้นเยี่ยมของบริษทั Macromedia เร่ิมเปนที่รูจักกนัตั้งแต 
Dreamweaver เวอรช่ัน 3.0 และเปนทีแ่พรหลาย และนิยมใชกันอยางสุดๆ ในเวอรช่ัน 4.0 ปจจุบนัไดถูกพัฒนาตอเนื่องมา
เปนเวอรช่ัน 8.0 โดยมาในชือ่วา Dreamweaver 8  
 

แนะนําองคประกอบหลัก และพ้ืนที่การทํางานของโปรแกรม 
การเรียกใช Dreamweaver 8 

1. คลิกที่ปุม Start 
2. ช้ีไปที่ Programs หรือ All Program 
3. ช้ีไปที่ Macromedia 
4. คลิกเลือก Macromedia Dreamweaver 8  
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    หนาตาของโปรแกรม Dreamweaver 8 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. แถบ Insert (Insert bar) 
ประกอบดวยปุมตางๆ ที่ชวยในการนําสิ่งตางๆ เชน รูปภาพ ตาราง ใสลงในหนาเวบ็เพจ 

2. แถบเครื่องมือ Document (Document Toolbar) 
เปนสวนทีใ่ชในการจัดการกบัเว็บเพจขณะนั้น เชน การเปลี่ยนมุมมองในการดหูนาเว็บเพจ 

3. หนาตาง Document (Document window)  
เปนสวนทีแ่สดงหนาเว็บเพจที่เรากําลังสรางหรือแกไขอยูขณะนั้น 

4. แถบสถานะ (Status bar) 
เปนแถบแสดงสถานะของหนาเว็บเพจที่เรากําลังสราง หรือแกไขอยูในขณะนัน้ 

5. พาเนล Properties (Property inspector) 
เปนสวนทีใ่ชในการปรับตั้งคาคุณสมบัติตางๆ ของสิ่งที่เราเลือก สวนนี้จะเปลีย่นแปลงไปตามสิ่งที่เราเลือก 
 
 



 

 95 

 
6. กลุมพาเนล (Panel groups) 

เปนกลุมของแผงควบคุมที่ยังไมไดเปดใช การเปด-ปดแผงควบคุมใดๆ ใหคลิกที่เครื่องหมายหัวลูกศรที่อยูหนาชื่อ
ของแผงนั้น 

7. พาเนล Site (Site panel) 
ชวยในการจดัการไฟล และโฟลเดอรในเวบ็ไซตที่เราสรางขึ้น หรือจัดการกับไฟลทั้งหมดที่อยูในฮารดดิสก 
เชนเดยีวกับโปรแกรม Windows Explorer 
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การเรียกใชคําสั่งของโปรแกรม 
การเรียกใชคําสั่งจากแถบเมนู 
 แถบเมนู(Menu bar) เปนสวนที่แสดงคําสัง่ที่ถูกจัดไวเปนกลุมๆ เรียกวา เมนู เพื่อความสะดวกในการเรียกใช  
การเรียกใชคําสั่งในแตละเมนูทําไดดังนี ้

1. คลิกที่ช่ือเมนู 
2. คลิกที่ช่ือคําสั่ง 

 
 
 
 
 
การเรียกใชคําสั่งจากเมนูลัด(Context menu) 
 เมนูลัด(Context menu) จะเปนคําสั่งพิเศษที่โปรแกรมจดัเตรียมไวให โดยคําสั่งเหลานี้จะเปลีย่นไปตามงานที่เรา
ทําขณะนัน้ 
 

• การเรียกใชเมนูลัดจะกระทําไดโดยคลิกปุมขวาของเมาส 
 
 
 
 
 
 
 
 
 
 
 
การยกเลิกคําสั่งและการทําซ้ํา 

เลือกคําสั่ง Edit > Undo หรือ เลือกคําสั่ง  Edit > Redo 
 

การออกจากโปรแกรม 
เลือกคําสั่ง File > Exit  หรือ คลิกที่ปุม Close ของหนาตางโปรแกรม 
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การกําหนดคาพื้นฐาน 

เลือกคําสั่ง Modify > Page Properties จะพบหนาตางสําหรับการตั้งคาตางๆ ของเว็บเพจ ใหทําการตั้งคา ดังนี ้
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• ในสวนของ  Page font เปนสวนที่มีไวกาํหนดรูปแบบของอักษรที่จะใชเปนรูปแบบมาตรฐานของเว็บเพจ 
• ในสวนของ  Size  เปนสวนที่มีไวกําหนดขนาดของอกัษรที่จะใชเปนขนาดมาตรฐานของเว็บเพจ 
• ในสวนของ  Text color เปนสวนที่มีไวกาํหนดสีของอกัษรที่จะใชเปนมาตรฐานของเว็บเพจ 
• ในสวนของ  Background  เปนสวนที่ทําการใสสีของพื้นหลัง เพื่อใหเว็บเพจของเรานาสนใจเพิ่มขึน้ 
• ในสวนของ  Background  Image เปนสวนที่เราสามารถนํารูปภาพมาแทรกเปนพื้นหลังของเว็บเพจ เพื่อให

เว็บเพจของเรานาสนใจมากขึ้นเชนกนั 
• ในสวนตอไปเปนสวนของการตั้งคาระยะหางขอบ เพื่อความเหมาะสม และสวยงามของเว็บเพจ เราสามารถ

กําหนดระยะหางขอบบน (Top Margin) ซาย (Left Margin) ขวา (Right margin) ลาง (Buttom margin) ได
โดยกําหนดระยะหางแตละขอบไดตามตองการ (ปกติมกักําหนดใหเปน 0 ) 
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การกําหนดคาภาษาไทย 

เลือกคําสั่ง Modify > Page Properties จะพบหนาตางสําหรับการตั้งคาตางๆ ของเว็บเพจ จากนัน้ใหทําการเลือก 
ในสวน Categoty เปน Title/Encoding และเลือกในสวนของ Encoding เปน Thai (Windows) ดังรูป 
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การกําหนดคา Title ใหกับเว็บไซต 

เลือกคําสั่ง Modify > Page Properties จะพบหนาตางสําหรับการตั้งคาตางๆ ของเว็บเพจ จากนัน้ใหทําการเลือก 
ในสวน Categoty เปน Title/Encoding และในสวนของ Title ใหพมิพขอความทีต่องการ ดังรูป 
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การกําหนดไซต 

การจัดตั้งโลคอลไซต (Local site) ในโปรแกรม Dreamweaver  8 คลายกับการสรางหองๆ หนึ่งขึน้มา เพื่อเก็บ
ไฟลเว็บหลายๆ ไฟล(เว็บไซตหนึ่งอาจมหีลายไฟล) เพื่อจะไดจัดการและเรียกใชไดสะดวกขึ้น ขั้นตอนการตั้งโลคอลไซตมี
ดังนี ้

1. เลือกคําสั่ง Site > New Site จะปรากฏกรอบ Site Definition เลือกแทบ็ Advanced 
2. ในสวนของ Category เลือก Local Info  ชอง Site Name : กรอกชื่อไซต  ชอง Local Root Folder : เลือก

โฟลเดอรที่เกบ็ไฟลเว็บเพจ และชอง Default Images Folder : เลือกโฟลเดอรที่เก็บรูปภาพ 
 
 
 
 
 
 
 
 
 
 
 
 
3. เลือก OKในสวนของพาเนล Site จะแสดงไซตตามที่เราไดสรางไว                                 
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การใสสี และแทรกภาพพื้นหลัง 

การใสสีพื้นหลัง 
1. เลือกคําสั่ง Modify > Page Properties 
2. ในสวนของ Background color เลือกสีที่ตองการ 
3. เลือก OK 

 
           ผลลัพธท่ีได 

 
 
 
 
 
 

การแทรกภาพพื้นหลัง 
1. เลือกคําสั่ง Modify > Page Properties 
2. ในสวนของ Background Image เลือก Browse 
3. เลือกภาพที่ตองการ  
4. เลือก OK 
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ผลลัพธท่ีได 
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การบันทึกไฟลเว็บเพจ 

เมื่อเราตองการสรางเว็บเพจใหม หรือแกไขไฟลเว็บเพจที่มีอยูเดิม แลวตองการบันทึกเก็บไว ใหทําตามขั้นตอน
ดังนี ้

การบันทึกไฟลใหม 
1. เลือกคําสั่ง File > Save As 
2. ในสวนของ Save in เลือก โฟลเดอรที่จะเก็บไฟล 
3. ในสวนของ File name พิมพช่ือไฟลที่ตองการ 
4. คลิกที่ปุม Save เพื่อบันทึก  

 
 
 

 
 
 
 
 
 
 

การบันทึกทับไฟลเดิม 
1. เลือกที่คําสั่ง File > Save  

 
การดูผลเวบ็เพจในเว็บบราวเซอร 

เลือกคําสั่ง File > Preview in Browser > เว็บบราวเซอร หรือ กดปุม f12 บนแปนพมิพ 
 
 
 
 
 
 
 
 

เลือกตําแหนงในดิสก 

พิมพช่ือไฟล 

เลือกนามสกุล  
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การสราง ปรับแตง ตัวอักษร และขอความ 

ลักษณะการใสขอความลงในเว็บเพจ คือการพิมพขอความที่ตองการลงไปตรงๆ คลายกับการพิมพเอกสารดวย
โปรแกรมประเภทเวิรดโปรเซสเซอรทั่วไป หลังจากนัน้จงึคอยมาจัดวาจะเนน หรือเปลี่ยนสีขอความใด  
วิธีการพิมพขอความ 
 กอนที่จะเริ่มพมิพขอความ ใหแนใจกอนวาเรากําลังอยูในมุมมองออกแบบ (Design view) โดยเลือกที่คําสั่ง  
View > Design 

1. วางตําแหนงตวับงบอกตําแหนงการพิมพ 
2. พิมพขอความที่ตองการ เราสามารถที่จะพิมพขอความตางๆ ไปจนสุดขอบขวาของหนาเว็บเพจ และเมื่อเรา

พิมพตอไป ขอความที่เกินนัน้จะถูกตดัขึ้นบรรทัดใหม เองโดยอัตโนมตัิ  
3. ถาตองการขึ้นบรรทัดใหมใหกด Shift + Enter ที่ คียบอรด 
 
 
 
 
 
 

 
การเลือกขอความ 

1. เล่ือนเมาสไปยังตําแหนงตนขอความที่ตองการจะเลือก 
2. คลิกเมาสซายคางไว 
3. ลากเมาสผานขอความที่ตองการ 
4. ปลอยเมาส 

 
การเลือกขอความยาวๆ 

1. เล่ือนเมาสไปยังตําแหนงตนขอความที่ตองการจะเลือก 
2. กด Shift คางไว 
3. คลิกตัวบอกตาํแหนงการพิมพที่ตําแหนงสุดทายที่ตองการ 

 
 
 



 

 105 

 
เลือกทีละคําหรือทีละวรรค 
 ดับเบิลคลิกที่คํา หรือวรรคนั้น 

 
 
 
 

เลือกท้ังหมด 
 เลือกคําสั่ง Edit > Select All 
 

 
 
 

การจัดรูปแบบอักษร 
1. เลือกสวนของขอความที่จะจดัรูปแบบ 
2. กําหนดคาในสวนของพาเนล Properties หรือเลือกคําสั่งจากเมนู Text  

 
 
 
 
 
 
 
 
 
 
 
 
 
 แบบอักษร            ขนาด                สี      ตัวหนา  ตัวเอน 
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การแทรกรูปลงในเว็บเพจ 

รูปภาพเปนสวนที่ชวยสรางสสัีนใหกับเว็บเพจของเราไดเปนอยางดี โดยในเว็บเพจนีอ้าจจะประกอบดวยรูปภาพ 
เชน ภาพถาย  ภาพวาด  หรือรูปปุมตางๆ ก็ได 

 
ชนิดของรูปภาพ 

1. GIF (Graphic Interchange Format) 
เปนรูปแบบของไฟลรูปภาพที่เปนที่นยิมกันอยางมาก สามารถกําหนดสีไดสูงสุด 256 สี ทําภาพโปรงแสง 
และสรางเปนภาพเคลื่อนไหวได มกัใชกบัภาพการตนูโลโก และภาพเคลื่อนไหว 

2. JPEG (Joint Photographic Experts Group) 
เปนรูปแบบของไฟลรูปภาพที่สามารถกําหนดสีไดเปนลานสี เหมาะสําหรับภาพถายรูปภาพจากการสแกน
รูปภาพที่มีพื้นผิว และรูปภาพใดๆ ที่มีสีมากกวา 256 สี คณุภาพของภาพจะมีผลโดยตรงกับขนาดของไฟลดวย 

3. PNG (Portable Network Graphic) 
เปนรูปแบบของไฟลกราฟกที่ใชบนเว็บ แตอาจใชไมไดกับทุกบราวเซอร รองรับความลึกของสีแบบ 32 บิต 
สามารถใสเอ็ฟเฟคได ไฟลชนิดนี้เปนไฟลมาตรฐานของโปรแกรม Macromedia Fireworks  

 ไฟล GIF และ JPEG เปนรูปแบบที่โปรแกรมเว็บบราวเซอรสวนใหญสามารถเปดดูได 
 

จัดเตรียมไฟลรูปภาพ 
 ไฟลรูปภาพตางๆ ที่เราจะนาํมาใสลงในเวบ็เพจของเรานัน้จะตองถูกจัดเก็บไวในโฟลเดอรของเว็บไซตที่เราสราง 
ดังนั้นเราจะตองจัดเตรียมรูปภาพทั้งหมดที่จะใช แลวนาํมาใสไวในโฟลเดอรของเวบ็ไซตนั้นเสียกอน ซ่ึงไฟลทัง้หมดจะ
ไปปรากฏในแท็บ Assets ของพาเนล Site เพื่อใหเราเรียกใชไดโดยสะดวก 
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การใสรูปภาพลงในเว็บเพจ 

1. วางตัวบอกตําแหนงการพิมพในตําแหนงที่จะใสรูปภาพ 
2. เลือกคําสั่ง Insert > Image  หรือ ในแถบ Insert  เลือกแท็บ Common แลวคลิกที่ปุม               Image 
3. เลือกไฟลรูปภาพที่ตองการแลวเลือก OK 

 
 
 
 
 
 
 
 

4. กําหนดคาตางๆ ของรูปไดจากสวนของพาเนล Properties  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

กําหนดคาตางๆของรูปไดในพาเนล Properties 
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การปรับขนาดของรูปภาพ 

1. คลิกที่รูปภาพที่จะปรับขนาดจะปรากฏจุดยึด (Handle) ที่ขอบลาง ขอบขวา  
และมุมขวาลางของรูป 

2. ลากจุดยดึเพื่อปรับขนาด  หากตองการคงสัดสวนของรูปไวดวย ใหกดปุม  
Shift คางไวขณะที่ลาก 
 
 
 
 

 
เราสามารถลากจุดยึดเพื่อปรับขนาดไดเล็กสุดที่ 8 * 8 พิกเซล หากตองการขนาดเล็กกวานี้ ใหใสคาลงในสวนของ 

W และ H ในพาเนล  Properties  
 

  
 
 
 

การจัดวางตําแหนงรูปภาพ 
 เราสามารถเลือกจัดวางตําแหนงของภาพไดหลายแบบ โดยเฉพาะเมื่อตองการจัดวางรวมกับขอความในสวนของ 
Align ของพาเนล Properties เลือกลักษณะการจัดวาง ซ่ึงอาจเปน 
 
 
 
 
 
 
 

Default        วางบนขอบลาง (หรือเปนไปตามคาปกตขิองโปรแกรมเว็บบราวเซอรที่ผูชมใช) 
Baseline     วางขอบลางของภาพเสมอแนวขอบลางของขอความ 
Top      วางขอบบนของภาพเสมอกับขอบบนทีสู่งสุดของขอความ หรือออบเจ็คอื่นที่อยูในบรรทัดนั้น 
Middle       วางกึ่งกลางของภาพเสมอกับขอบลางของขอความบรรทัดนั้น 
Text Top    วางขอบบนของภาพเสมอกับขอบบนของขอความในบรรทัดนั้น 
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Absolute Middle      วางกึ่งกลางของภาพเสมอกับกึ่งกลางของขอความบรรทัดนั้น 
Absolute Bottom      วางขอบลางของภาพเสมอแนวขอบลางของขอความ 
Left           วางภาพไวทางขอบซาย และจัดขอความไวทางขวาของภาพ 
Right           วางภาพไวทางขอบขวา และจัดขอความไวทางซายของภาพ 

 
การใสกรอบใหกับรูปภาพ 

1. คลิกที่รูปภาพที่จะใสกรอบ 
2. กําหนดคาความหนาของเสนกรอบในสวนของ Border ในพาเนล Properties แลวกด Enter 

 
 
 
 
 
 
 
 
 
 

การตั้งชื่อขึ้นแทนรูปภาพ 
 มีผูใชบางสวนที่ไมสนใจรูปภาพเทาไรนัก อาจเปนเพราะตองการเพียงเนื้อความ หรือความเร็วในการทองเว็บไม
มากนัก จึงมักตั้งคาโปรแกรมเว็บบราวเซอรใหไมตองแสดงรูปภาพ ดังนั้นในกรณเีชนนี้ เราก็นาที่จะตั้งชื่อแทนรปูภาพ 
นั้นๆ ของเรา เพื่อใหแสดงขึ้นแทนภาพ อยางนอยกใ็หผูชมไดทราบวาภาพนั้นเปนภาพอะไร 

1. คลิกที่รูปภาพนั้น 
2. พิมพช่ือลงในสวนของ Alt ในสวนของพาเนล Properties แลวกด Enter 

 
 
 
 
 
 

กรอบที่ได 
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เมื่อนําเมาสไปชี้ที่รูป 
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การสรางตาราง และการปรับแตงตาราง 

ตารางนับวาเปนสิ่งที่จําเปนอยางมากสําหรับการทําเว็บไซตเนื่องจากชวยใหผูออกแบบจัดตําแหนงการนําเสนอ
เนื้อหาไดงายและเปนระเบยีบสวยงาม ไมวาจะเปนรูปภาพหรือขอความ ผูเขียนกลายนืยันไดเลยวาเกือบทุกๆ เว็บใน
ปจจุบันนีต้องมีตารางอยูในเว็บอยางนอย 1 ตาราง ถึงแมเราจะไมเห็นเสนตารางปรากฏอยูเลยก็ตาม (สามารถสรางตาราง
ซอนในชองของตารางอีกอันได) 
เริ่มสรางตาราง 
 กอนสรางตาราง แนะนําใหทานเปดหนาเว็บเปลาขึ้นมาใหม โดยคลิกเมนู File > New จากนัน้เริ่มสรางตารางดังนี้ 

1. คลิกจุดเพื่อกําหนดตําแหนงที่จะแทรกตาราง 
2. เรียกคําสั่งสรางตาราง โดยคลิกเมนู Insert > Table หรือคลิก Common >         ที่แถบ Insert  ก็ได 
3. กําหนดคาคุณสมบัติที่สําคัญของตารางตามตองการเชน ขนาด จํานวนชอง ดังนี้ (ถายังไมแนใจวาตองการ

ขนาดเทาใด ใชคาที่เครื่องเตรียมใหกอนกไ็ด แลวคอยมาปรับแตงเพิ่มลดภายหลัง) 
• Rows                        จํานวนแถว 
• Columns          จํานวนคอลัมน 
• Table Width              ความกวางทั้งหมดของตาราง สามารถเลือกหนวยเปน pixel หรือ percent   
                                           ก็ได (เชน 50%ของขนาดความกวางบราวเซอรขณะนั้น) 
• Border  Thickness    ความหนาของเสนขอบตาราง ถาไมตองการใหแสดงเสนขอบ กําหนด 
                                           ขนาดเปน 0 (ศนูย) หนวย 
• Cell Padding             ระยะหางระหวางขอความในชองเซล กับเสนขอบของแตละเซล  
• Cell Spacing             ระยะหางระหวางเซลแตละเซล 

 
4. เมื่อเรียบรอยแลวคลิกปุม OK 
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ใสเนื้อหาหรอืรูปภาพลงในตาราง 

เราสามารถพิมพกรอกเนื้อหาที่เปนขอความ หรือใสรูปภาพลงในตารางไดคลายกับการใสในเว็บตามปกติที่กลาว
มาแลว แตกอนจะใสลงในชองใด ใหคลิกเลือกที่เซลชองนั้นเสียกอน เพื่อกําหนดตําแหนงหรือจุดวางนั้นเอง จากนั้นพิมพ
ขอความหรือเรียกรูปภาพมาวาง แตถาวางแลวเกดิไมพอใจ สามารถยาย โดยส่ัง Copy และ Paste ไปไวที่อ่ืนได 

 
 
 
 
 
 
 
ขณะที่เคอรเซอรอยูในตาราง เราสามารถเคลื่อนที่ไปยังเซลชองอื่นไดดังนี ้

• คลิกเมาสไปยงัเซลที่ตองการ 
• กดแปน Tab 1 คร้ังเพื่อเล่ือนไปยังเซลถัดไป 1 ชอง 
• กดแปน Shift + Tab 1 คร้ังเพื่อเล่ือนถอยหลัง 1 ชอง 
• กดแปนลูกศรทั้งสี่(ขางแผงตัวเลข) เพื่อเล่ือนตามทิศทางลูกศร 

 
การเลือกสวนของตาราง 
 กอนที่จะทําการปรับแตงแกไขตารางหรือสวนของตาราง เราควรรูจักวิธีการเลือกตารางหรือสวนของตาราง
เสียกอนดังนี ้
เลือกท้ังตาราง 

เหมาะสําหรับการเลือกตารางที่อยูโดดๆ (ไมไดซอนกันอยู) วิธีการมีดังนี้ 
1. เล่ือนเมาสไปที่บริเวณขอบนอกตาราง (แนะนําใหไปดานลางตาราง) หางจากเสนขอบเล็กนอย 
2. เมื่อลูกศรปลายเมาสปรากฏเปน       ใหคลิกปุมซาย 1 คร้ัง จะปรากฏเปนเสนขอบดําขึ้นรอบตาราง แสดงวา

เลือกไดแลว    
 

เลือกท้ังแถวหรือท้ังคอลัมน 
 บางครั้งอาจจําเปนตองเลือกทั้งแถว หรือทัง้คอลัมน เชนในการที่ตองการจัดใหขอความทั้งคอลัมนอยูกลางหรือชิด
ขวา ฯลฯ วิธีการเลือกมีดังนี ้

1. กรณีที่เลือกทัง้แถว ใหเล่ือนเมาสไปที่บริเวณขอบตารางดานซายแถวทีต่องการ ที่ปลายเมาสจะเปลี่ยนเปน        
กรณีที่เลือกทัง้คอลัมน ใหเล่ือนเมาสไปที่บริเวณขอบตารางดานบนตรงคอลัมนที่ตองการ ที่ปลายเมาสจะ
เปลี่ยนเปน   
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2. คลิกปุมซายเมาส 1 คร้ัง จะปรากฏเสนทึบรอบแถวหรือคอลัมนที่ถูกเลือกไว   
 
 
 
 
 
 

หากตองการเลือกทีละหลายแถวหรือหลายคอลัมน ใหกดปุมซายเมาสคางไวกอนขณะที่ปรากฏลกูศรดํา
ทึบ (ขอ 1) จากนั้นลากเมาสไปใหครบจํานวนแถว หรือคอลัมนที่ตองการ แลวจึงคอยปลอยเมาส 
 

เลือกเซล 
 หมายถึงเลือกทํางานกับเซลชองเดียวหรือหลายชอง วิธีการเลือกมีดังนี้ 

• กรณีเลือกเซลเดียวใหคลิกตรงเซลชองที่ตองการ 
• กรณีเลือกเซลหลายชองที่อยูติดกัน ใหคลิกที่ชองแรกกอน จากนัน้กดปุมซายเมาสคางไวแลวลากไปให

ครบตามตองการ จึงคอยปลอยเมาส 
 
 
 

 
 

 
 

หรือใชอีกวิธีคือคลิกที่ชองแรกกอนแลวกดแปน Shift คางไว จากนั้นคลิกเซลชองสุดทาย เมื่อเรียบรอยแลวจึง
ปลอยแปน Shift 

• กรณีเลือกเซลหลายชองที่ไมไดอยูตดิกัน ใหคลิกที่ชองแรกกอนแลวกดแปน Ctrl คางไว จากนั้นไลคลิก
เซลชองที่ตองการใหครบ เมือ่เรียบรอยแลวจึงปลอยแปน Ctrl 
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ปรับขนาดตาราง 
 เราสามารถปรับขนาดความกวาง ความสูงของตารางไดดังนี้ (การปรับขนาดทุกอยางสามารถทําไดเลย ไมวาจะมี
ขอมูลอยูในตารางหรือไมก็ตาม) 
 
ปรับขนาดทั้งตาราง 

1. เลือกตาราง 
2. ถาตองการปรับความกวางของตาราง ใหคลิกลากจุดสี่เหล่ียมดานขาง 
3. ถาตองการปรับความสูงของตาราง ใหคลิกลากจุดสี่เหล่ียมดานลาง 
4. ถาตองการปรับความกวางและความสูงพรอมๆ กัน ใหคลิกลากจุดสี่เหล่ียมที่มุมดานลางขวา (ถากดแปน Shift 

คางขณะเลื่อนเมาส จะเปนการบังคับใหปรับความกวาง และความสูงเพิม่ลดในสัดสวนที่เทากัน 
 
 
 

 
 

 
ปรับความกวางคอลัมนหรือความสูงแถว ดวยแผงควบคุม 

นอกจากการใชเมาสคลิกลากปรับขนาดแลว ในกรณีที่ตองการกําหนดคาแบบใหแมนยํา เราสามารถกรอกความ
กวางความสูงที่ตองการเขาไปโดยตรงที่แผงควบคุมไดดังนี้ 

1. เลือกคอลัมน หรือแถวที่ตองการ 
2. กรณีเลือกคอลมันกรอกคาทีต่องการเขาไปในชอง W (ความกวาง) หรือ กรอกคาเขาไปในชอง H (ความสูง) 

กรณีเลือกแถวเสร็จแลวกดแปน Enter 
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สรางตารางซอนภายในตาราง 
 เพื่อการนําเสนอเนื้อหาที่เปนระเบียบสวยงาม บางครั้งเราจําเปนตองสรางตารางซอนไวในตาราง ซ่ึงสามารถทําได
ไมยาก หลักการคลายกับการสรางตารางที่กลาวมาแลวดงันี้ 

1. คลิกตรงเซลชองที่จะใสตาราง 
2. เรียกคําสั่งสรางตาราง โดยคลิกเมนู Insert > Table หรือกดแปน Ctrl+Alt+T หรือคลิก Common >           ที่

แถบ Insert  ก็ได 
3. กําหนดคาคุณสมบัติที่สําคัญของตารางตามตองการเชน ขนาด จํานวน ชอง (ถากําหนดความกวางหนวย % 

ความกวางนั้นจะเทยีบกับขนาดของชองเซลที่บรรจุตารางอยู เชน 100% คือกวางเตม็ชองเซล 50% คือคร่ึงชอง
เซล) 

 
 
 
 
 

4. จัดรูปแบบตารางที่ซอนภายในนี้ไดตามตองการ (แยกอสิระจากตารางที่ครอบอยูภายนอก) 
 

เพิ่มคอลัมนและแถว 
 หากตองการเพิ่มคอลัมนหรือแถว สามารถทําไดงายๆ ดงันี้ 

1. เลือกตาราง 
2. ที่แผงควบคุมคุณสมบัติ ใหกรอกจํานวนแถว (Row) หรือคอลัมน(Column) โดยบวกเพิ่มเขาไปจากคาเดิม 

เชน คา Row เดิมเปน 3 ตองการเพิ่มอีก 2 ก็กรอกใส 5 เขาไป ฯลฯ 
 
 
 
 
 
 

 
 
 

 จํานวนแถว                             จํานวนคอลัมน 
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การลบคอลมันและแถว 
 หากตองการลบคอลัมนหรือแถว สามารถทําไดงายๆ ดังนี้ 

1. เลือกคอลัมนหรือแถวที่ตองการลบ 
 
 
 
 
 
 

2. กดแปน Delete (แปนพิมพบางเครื่องจะเขียนไววา Del)  หรือเลือกเมนู Modify > Table > Delete Row , 
Delete Column 

 
ปรับแตงรูปแบบตารางตามใจฉัน 

 นอกจากการปรับตามตนแบบแลว เรายังสามารถปรับแตรูปแบบเองตามใจชอบก็ได ซ่ึงสามารถทําไดหลายหลาย
กวา ดังนี ้

1. เลือกเซล หรือแถว หรือคอลัมน หรือทั้งตาราง ขึ้นอยูกับวาตองการปรบัแตงสวนใด ถาตองการปรับแตง
เฉพาะเซลชองใดชองหนึ่ง ก็เลือกแคเซลนั้น ถาตองการปรับทั้งคอลัมนก็คลิกเลือกทั้งคอลัมน ฯลฯ 

2. กําหนดคาลงในแผงควบคุมคุณสมบัติ แลวกด Enter ซ่ึงแผงควบคุมจะแตกตางกันหากเลือกทั้งตาราง หรือ
เลือกเซลดังนี ้

 
ลักษณะแผงควบคุมตาราง 

  แผงควบคุมจะมีผลกับโดยรวมของตาราง 
      
 
 
 

 
 
 
 
 
 

ความกวาง สูงตาราง 
ระยะหางขอความกับขอบเซล  ระยะหางระหวางเซล  ตําแหนงการจัดวางตาราง 

เปลี่ยนความกวางความสูง 
ใหเปน  %  หรือ  Pixel 

สีพ้ืนตาราง 
รูปภาพพื้นฉากหลังตาราง 

สีขอบตาราง 
ขนาดเสนขอบตาราง 
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ใสรูปเปนฉากหลังตาราง 
 หากตองการนาํภาพสวยๆ มาใสเปนฉากหลังพื้นตาราง ซ่ึงเลือกไดวาจะวางเฉพาะเซลชองใด  คอลัมนใด  หรือทั้ง
ตารางเลยก็ได มีวิธีการดังนี ้

1. คลิกเซล หรือเลือกคอลัมน หรือเลือกแถว หรือเลือกตาราง  
2. ที่แผงควบคุมคุณสมบัติตรงชอง Background ใหคลิกปุม       แลวเลือกไฟลภาพทีต่องการ 

 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ใสรูปภาพพื้นหลังเฉพาะบางเซล 

ใสรูปภาพพื้นหลังทั้งตาราง 
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การเชื่อมโยงเว็บเพจ 

หลังจากที่เราจดัตั้งเว็บไซตและทําการสรางเว็บเพจขึ้นหลายๆ เว็บเพจแลว เราจึงควรที่จะทําการเชือ่มโยงเว็บเพจ
เหลานั้นเขาดวยกัน เพื่อใหผูชมสามารถเขาถึงหนาเว็บเพจของเราไดโดยสะดวกและตอเนื่อง 
 
การเชื่อมโยงเว็บเพจ 
 เราสามารถสรางการเชื่อมโยงไดหลายแบบดวยกันดังนี ้

• เชื่อมโยงภายในเว็บเพจเดียวกัน 
• เชื่อมโยงไปยงัหนาเว็บเพจอื่นหรือไฟลเวบ็เพจอื่นในเวบ็ไซตเดียวกนั 
• เชื่อมโยงไปยงัเว็บไซตอ่ืน  
• เชื่อมโยงไปยงัอีเมล (E-mail link) 

 
การเชื่อมโยงภายในเว็บเพจเดียวกัน 
 ในการเชื่อมโยงไปยังสวนตางๆ ที่อยูในเวบ็เพจเดยีวกันจะมี 2 ขั้นตอนดวยกนั คือ กอนอื่นเราจะตองทําการ
กําหนดเปาหมายที่จะใหกระโดดไปถึงเสียกอนจากนั้นจงึจะกําหนดจุดเชื่อมโยงเพื่อเชื่อมโยงไปยังเปาหมายนั้น 

การกําหนดเปาหมาย (anchor) 
1. วางตัวบอกตําแหนงการพิมพตรงที่จะกาํหนดเปนเปาหมาย 
2. เลือกคําสั่ง Insert > Named Anchor หรือ กดปุม Ctrl+A หรือ ในแถบ Insert เลือกแท็บ Common แลวคลิก

ที่ปุม          Named Anchor 
3. ในสวนของ Anchor Name ตั้งชื่อเปาหมายแลวเลือก OK จะปรากฏเครื่องหมายแสดงเปาหมายทีจ่ดุที่กําหนด 

 
การสรางการเชื่อมโยงไปยังเปาหมาย 
1. เลือกขอความหรือรูปภาพทีจ่ะใชเปนจดุเชือ่มโยง 
2. ในสวนของ Link ในพาเนล  Properties พมิพเครื่องหมาย #  ตามดวยช่ือเปาหมายนั้น  
 

การเชื่อมโยงภายในเว็บไซตเดียวกัน 
 การเชื่อมโยงในลักษณะนี้ จะเปนการเชื่อมโยงไปยังสวนตางๆ ที่อยูในไฟลเว็บเพจอื่นซึ่งอยูภายในเว็บไซต
เดียวกัน 

1. เลือกขอความหรือรูปภาพทีจ่ะใชเปนจดุเชือ่มโยง 
2. คลิกที่ไอคอน         Browse to File ที่อยูทางขวาของ Link เพื่อไปเลือกไฟล แลวเลือก OK  หรือ พิมพ

ตําแหนงและชื่อไฟลเว็บเพจนั้นลงในชอง Link โดยตรง  
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3. ในสวนของ Target เลือกวาจะใหแสดงเวบ็เพจที่เปดใหมตรงที่ใด ซ่ึงอาจเปน 

_blank  เปดไฟลนั้นในหนาตางใหม 
_parent เปดไฟลนั้นในเฟรมหลัก หรือหนาตางหลกัที่จุดเชื่อมโยงนั้นอยู 
_self   เปดไฟลนั้นในเฟรม หรือหนาตางเดยีวกบัที่จุดเชื่อมโยงนั้นอยู(คาปกติ) 
_top  เปดไฟลนั้นในแบบเต็มจอ โดยยกเลิกเฟรมทั้งหมด 

 

การเชื่อมโยงไปยังเว็บไซตอื่น 
 การเชื่อมโยงลักษณะนี้ จะเปนการเชื่อมโยงไปยังสวนตางๆ ที่อยูในไฟลเว็บเพจ ซ่ึงอยูภายในเว็บไซตอ่ืน 

1. เลือกขอความหรือรูปภาพทีจ่ะใชเปนจดุเชือ่มโยง 
2. พิมพตําแหนง และชื่อไฟลเวบ็เพจนัน้ลงในชอง Link โดยตรง โดยตองพิมพตําแหนงในรูปแบบของ URL 

เชน http://www.kapook.com 
 
การเชื่อมโยงไปยังอีเมล 
 การเชื่อมโยงลักษณะนีจ้ะเปนการเปดโปรแกรมเขียนอีเมล เพื่อใหผูชมสงขาวสารมาหาเราไดโดยสะดวก 

1. วางตัวบอกตําแหนงการพิมพตรงที่จะสรางจุดเชื่อมโยงไปยังอีเมล  หรือเลือกขอความหรือรูปภาพที่จะใชเปน
จุดเชื่อมโยง 

2. ในสวนของ Link ในพาเนล Properties พมิพคําวา mailto: ตามดวยที่อยูอีเมล เชน 
mailto:webmaster@kapook.com 
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การใสสื่อแบบ multimedia 

นอกเหนือจากขอความ และภาพนิ่งแลว ใน Dreamweaver เรายังสามารถนําไฟลส่ือประสมที่เรียกวา มัลติมีเดยี 
(Multimedia) เขามาใสเพื่อแสดงผลรวมกันในเว็บเพจไดอีกดวยไฟลมัลติมีเดียเหลานี้ ไดแก ภาพเคลื่อนไหว หรือ
ภาพยนตร ซ่ึงถูกสรางจากโปรแกรมตางๆ เชน Macromedia Flash, Shockwave movies, Java applets, Quick Time, 
หรือ Active X เปนตน 

 
การใสมัลติมเีดียลงในเว็บเพจ 

1. วางตัวบอกตําแหนงการพิมพในตําแหนงที่ตองการ 
2. เลือกแถบ Insert ในแท็บ Common คลิกลูกศรที่ปุม             Media จากนั้นคลิกเลือกมีเดยีที่ตองการใชงาน 

 
 

การใส Flash movie 
การใส Flash movie จะกระทําไดดังนี ้
1. วางตัวบอกตําแหนงการพิมพในตําแหนงที่ตองการ 
2. เลือกแถบ Insert ในแท็บ Common คลิกลูกศรที่ปุม 
                  Media จากนั้นคลิกเลือก        Flash 
3. เลือกไฟล Flash movie (.swf) ที่ตองการ 

 
 
 
 
 

4. พาเนล Properties คลิกที่ปุม                         เพื่อดูการแสดงผลของ Flash movie  หรือกดปุม F12 เพื่อดใูน
เว็บบราวเซอร 
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การสรางปุมกดดวย Flash Button 
 Flash button ใชในการสรางปุมกด ซ่ึงมักนําไปใสในเวบ็เพจเพื่อใหผูชมคลิกเลือกการกระทําตางๆ เชน คลิกเพือ่
ไปยังเว็บเพจถดัไป เปนตน 

1. วางตัวบอกตําแหนงการพิมพในตําแหนงที่ตองการ 
2. เลือกแถบ Insert ในแท็บ Common คลิกลูกศรที่ปุม              Media จากนั้นคลิกเลือก       Flash Button 

 
 
 
 
 
 
 
 
 
 
 
 
 

3. กําหนดคาตาง ๆ แลวเลือก OK ในพาเนล Properties คลิกที่ปุม                         เพื่อดูรูปปุมที่ได  กดปุม F12 
เพื่อดูผลในเวบ็บราวเซอร 
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การใสไฟลเสียง 
 ไฟลเสียงที่สามารถนํามาใชไดจะมีอยูดวยกันหลายชนิด ซ่ึงแตละชนิดก็จะมีขอดีขอเสียในการนํามาใชใน 
เว็บเพจตางกนั อีกทั้งยังตองการโปรแกรมเสริม (Plug-in) ในการแสดงผลที่ตางกัน 
 
รูปแบบของไฟลเสียง 
 .midi หรือ .mid (Musical Instrument Digital Interface) 
 เปนรูปแบบสาํหรับเพลงบรรเลง สามารถเรียกใชไดในเวบ็บราวเซอรสวนใหญ โดยไมตองอาศัยโปรแกรมเสริม 
(Plig-in) โดยทั่วไปเปนไฟลที่มีคุณภาพเสียงดีมาก แตก็ขึ้นอยูกบัการดเสียงของเราดวย 

.wav (Waveform Extension) 
 เปนไฟลที่มีคณุภาพเสียงที่ด ีสามารถใชไดในเว็บบราวเซอรสวนใหญ โดยไมตองอาศยัโปรแกรมเสริม แตมีขนาด
ของไฟลคอนขางใหญ 
 .aif (Audio Interchange File Format, หรือ AIFF) 
 มีรูปแบบคลายกับไฟลชนดิ WAV  เปนไฟลที่มีคุณภาพเสียงที่ดี สามารถใชไดในเวบ็บราวเซอรสวนใหญโดยไม
ตองอาศัยโปรแกรมเสริม แตมีขนาดของไฟลคอนขางใหญ 
 .mp3 (Motion Picture Experts Group Audio, หรือ MPEG-Audio Layer-3) 
 เปนรูปแบบไฟลที่ถูกบีบอัดใหมีขนาดเล็กลง โดยยังคงคณุภาพเสียงที่ดมีากเทียบเทา CD แตตองใชโปรแกรม
เสริม เชน Quick Time, Windows Media Player หรือ RealPlayer ในการแสดงผล และดวยเทคโนโลยี Streaming ทํา
ใหสามารถทยอยแสดงผลไดโดยไมตองรอใหอานจนจบไฟล 
 .ra, .ram, .rpm,  หรือ Real Audio 
 เปนรูปแบบไฟลที่ถูกบีบอัดใหเล็กลงไปกวา MP3 แตคุณภาพเสียงจะดอยกวาเล็กนอย และตองใชโปรแกรมเสริม 
RealPlayer ในการแสดงผล พรอมเทคนิค Streaming 
 
การใสไฟลเสียงลงในเว็บเพจ 

1. วางตัวบอกตําแหนงการพิมพในตําแหนงที่ตองการ 
2. เลือกแถบ Insert ในแท็บ Common คลิกลูกศรที่ปุม              Media จากนั้นคลิกเลือก       Plugin 
3. ที่สวนของ Link ในพาเนล Properties พมิพ หรือเลือกไฟลเสียงที่ตองการ 
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การสราง Interactive Image 
การทํารูปแบบโรลโอเวอร (Rollover Image) 
 การใสเทคนิคโรลโอเวอรใหกับรูปภาพนัน้ จะเปนการกาํหนดใหรูปภาพที่แสดงบนเว็บบราวเซอรมีการเปลี่ยนรูป
ไปเปนอีกรูปแบบหนึ่งที่กําหนดไวไดเมื่อผูชมเล่ือนตัวช้ีของเมาสมาวางบนรูปนั้น ดังนั้นการทําโรลโอเวอรนี้ จะประกอบ 
ดวยรูปภาพ 2 รูป เพื่อใชเปลี่ยนสลับกันซึ่งภาพทั้งสอง จะตองมีขนาดเทากัน ซ่ึงหากไมเทากัน โปรแกรมก็จะทําการปรับ
ใหเทากัน โดยยึดภาพแรกเปนหลัก ซ่ึงอาจทําใหภาพที่ถูกปรับขนาดเสยีสัดสวนของภาพไปได  การทํารูปภาพแบบ 
โรลโอเวอร ทําไดตามขั้นตอนดังนี ้

1. ในหนาตาง Document วางตัวบอกตําแหนงการพิมพในตําแหนงที่จะสรางรูปภาพแบบโรลโอเวอร 
2. เลือกแถบ Insert ในแท็บ Common คลิกลูกศรที่ปุม             Image จากนั้นคลิกเลือก       Rollover Image  
        จะพบหนาตางกําหนดคา ดังรูป 

 
 
 
 
 
 
 
 
 
 
 

3. เลือก OK  
4. ผลที่ไดจากการใสคําสั่ง Rollover Image 

 
 
 

 

กําหนดขอความใหแสดงที่รูป เลือก URL ปลายทางที่ตองการจะเชื่อมโยง 

ต้ังช่ือใหกับรูปภาพ 

เลือกรูปที่ 1 
เลือกรูปที่ 2 

เริ่มตนแสดงภาพแรก 
 
 
เมื่อนําเมาสไปชี้ จะเปลี่ยนเปนภาพที่ 2 
 
 
เมื่อนําเมาสออกภาพจะกลับไปเปนภาพแรก 



 

 124 

 
 

การจดทะเบียนขอมีช่ือเว็บไซตนี้เรียกอีกอยางวา จดทะเบียนโดเมน หรือเรียกสั้นๆ วา จดโดเมน เชน ถาตองการมี
เว็บไซต www.createsmart.com เราจะตองจดทะเบยีนเพื่อใหไดโดเมน (Domain) ช่ือวา createsmart.com เสียกอน 
จากนั้นทาํการเชาพื้นที่เว็บโฮสทก็จะได www.createsmart.com  
 

ชื่อโดเมน 
 ช่ือโดเมน (Domain name) นั้นมีไวเพื่อใหเราหรือผูเขามาเยี่ยมชมเปดดเูว็บไซต หรือผูติดตอสามารถจําไดงายขึ้น 
ลองเปรียบเทียบดูวา ถาตองการเปดเว็บไซต แหงหนึ่งซึ่งมีช่ือดังนี ้

• http://127.52.11.28 และ www.createsmart.com 
 

จะเห็นไดวาถาเราใชช่ือเว็บไซตเปนตัวอักษร (ซ่ึงก็มาจากชื่อโดเมน createsmart.com นั่นเอง) ยอมสะดวก ส่ือ
ความหมายไดดีและจําไดงายกวา 

  
ชื่อโดเมนแบบมี 2 ระดับ 
 ลักษณะของชือ่โดเมนจะมีสวนหลัก 2 สวนดวยกนั ตัวอยางเชน www.itpart.biz, www.hotmail.com,  
www.yahoo.com มีสวนที่เปนชื่อโดเมน 2 สวนดังนี ้

createsmart . com          
 
 
 

ตัวอยางสกุลโดเมน 
---------------------------------------------------------------------------------------------------------------------------- 

      สกุลโดเมน               การใชงาน 
---------------------------------------------------------------------------------------------------------------------------- 
.com  .net  .info   .biz  และอื่น ๆ                สําหรับองคกรทั่วไป หางราน บริษัทและบุคคลธรรมดา       
                                                                           ทั่วไปก็สามารถจดทะเบยีนเปนเจาของได 
.org                 นิยมใชกับองคกรที่ไมแสดงผลกําไร 

                          สวนที่เปนช่ือเว็บไซต            สวนที่เปนนามสกุลหรือประเภทโดเมน 
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ชื่อโดเมนแบบมี 3 ระดับ 
                  ลักษณะของชื่อโดเมนจะมีสวนหลัก 3 สวนดวยกันคลายกับแบบ 2 ระดับที่ผานมา แตแบบ 3 ระดับนีจ้ะมีสวน
ขยายสําหรับประเทศดวย เชน www.psru.ac.th มีสวนที่เปนชื่อโดเมน 3 สวนดังนี ้

psru   .   ac  .  th 
 
 
 
 

ตัวอยางสกุลโดเมน 
---------------------------------------------------------------------------------------------------- 

สกุลโดเมน     การใชงาน 
---------------------------------------------------------------------------------------------------- 

.tw    สําหรับโดเมนประเทศใตหวนั 

.th    สําหรับโดเมนประเทศไทย 

.jp    สําหรับโดเมนประเทศญี่ปุน 
 
ใครสามารถจดทะเบียนโดเมนได และตองใชอะไรบาง 

 ผูเขียนขอแบงกลุมการจดทะเบียนออกเปน 2 ประเภทใหญๆ ดังนี้ 
 

โดเมนตางประเทศ 
 หมายถึงโดเมนสากล เชน .com   .net   .ort   .tv   .biz    .info  และอื่นๆ รวมทั้ง โดเมนที่มีนามสกุลเปน
ตางประเทศเชน  .us   .uk   ที่ระบบฐานขอมูลโดเมน (Whois Server) อยูตางประเทศ โดเมนเหลานี้ไมตองการ
เอกสารอะไรเพิ่มเติมเลย ดังนั้นทุกๆ คน เชน นักเรยีน นกัศึกษา ผูที่ทํางาน ตกงาน วางงาน ชาย หญิง สามารถจด
ทะเบียนขอชื่อโดเมนไดทั้งนัน้ ขอใหชําระเงินครบเทานั้นเปนพอ ซ่ึงถากรอกลงทะเบยีนจดโดเมนโดยตรงกับ
เว็บไซตของตางประเทศสวนใหญจะตองชําระคาบริการผานบัตรเครดิต เชน VISA , Master Card นอกจากนี้กม็ี
ระบบ Paypal (คนไทยไมคอยรูจักและไมคอยนิยมใช) 
 แตถาจดผานตวัแทนที่อยูในไทย ก็อาจใชวธีิการชําระโดยโอนเงินผานธนาคารเขาบัญชีของตัวแทน จาย
เปนเช็ค ชําระผานบัตรเครดิต หรือชําระดวยวิธีการอื่นๆ ซ่ึงแลวแตตวัแทนนัน้ๆ จะกําหนดขึ้นมาเพื่ออํานวยความ
สะดวกแกผูขอจดทะเบยีนโดเมน 
  
 
 
 

สวนที่เปนช่ือเว็บไซต     
สวนที่เปนนามสกุลหรือประเภท

สวนขยายบอกประเทศ 
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โดเมนในประเทศไทย 
 หมายถึงชื่อโดเมนที่ลงทายดวย .th แบงออกเปนหมวดหมูดังนี ้

• co.th สําหรับองคกรพาณิชย และธุรกิจ เชน createsmart.co.th ผูสมัครขอลงทะเบียนโดเมนจะตอง
เปนองคกรพาณิชยทีจ่ดทะเบียนในประเทศไทย เชน หนวยงานที่อยูในรูปบริษัท ฯลฯ หรือบริษัท
ตัวแทนตางประเทศที่อยูในประเทศไทย และตองจดทะเบยีนในประเทศไทย เอกสารหลักฐานที่ตอง
สงประกอบการขอจดทะเบยีนก็คือ เอกสารการจัดตั้งองคกร ที่ออกโดยทางราชการ 

• in.th สําหรับหนวยงานทกุประเภท และบุคคลทั่วไป เชน createsmart.in.th เอกสารหลักฐานทีต่อง
สงประกอบการขอจดทะเบยีนก็คือ บัตรประจําตวัประชาชนของผูยื่น หรือผูที่จะครอบครอง 

• ac.th สําหรับสถาบันการศึกษา เชน psru.ac.th ผูที่สมัครขอลงทะเบียนโดเมนเนมหมวดนี้จะตอง
เปนสถาบันการศึกษาที่จดทะเบียนในประเทศไทย    เอกสารหลักฐานที่ตองสงประกอบการขอจด
ทะเบียนก็คือ เอกสารการจัดตั้งองคกร ที่ออกโดยทางราชการ 

• go.th สําหรับการใชของภาครัฐบาล เชน กระทรวงหรือหนวยงานรัฐบาล ตัวอยางเชน police.go.th 
(สํานักงานตํารวจแหงชาติ) ผูขอลงทะเบียนโดเมนเนมภายใตหมวดหมูนี้จะตองเปนหนวยงานของ
รัฐบาลไทย   เอกสารหลักฐานที่ตองสงประกอบการขอจดทะเบยีนก็คือ เอกสารการจดัตั้งองคกร ที่
ออกโดยทางราชการ 

• net.th สําหรับผูใหบริการเครือขายอินเตอรเน็ต (ISP) ซ่ึงไดรับอนุญาตใหเปดบริการจากสื่อสารแหง
ประเทศไทย (CAT) หรือผูไดรับสิทธิ์ในการใหบริการจาก ISP  โดยมหีนังสือยืนยันจาก ISP นั้นๆ 
เชน ksc.net.th 

• or.th สําหรับองคกรที่ไมแสวงหาผลกําไร เชน nectec.or.th  คือศูนยเทคโนโลยีอิเลคทรอนิกส และ
คอมพิวเตอรแหงชาติ ฯลฯ 

• mi.th สําหรับหนวยงานทางทหาร เชน rtaf.mi.th  ของกองทัพอากาศ navy.mi.th ของกองทัพเรือ 
ฯลฯ 

 
ในสวนของการจดโดเมน และพื้นที่เก็บเว็บไซตในสมัยนีน้ั้นผูใหบริการจะใหบริการจดชื่อโดเมน และเชาพืน้ที่

เก็บเว็บไซต แบบครบวงจรทําใหมีความสะดวกมากขึน้ สวนขั้นตอนในการสมัครนั้นก็ไมยาก เพยีงเตรียมเอกสาร และ
กรอกขอมูลใหครบ (ขึ้นอยูกับเว็บไซตของผูใหบริการ วามีขั้นตอนอยางไร) เทานี้กส็ามารถมีเว็บไซตเปนของตวัเองได
แลว ตัวอยางเว็บไซตผูใหบริการ www.thaiezyhost.com, www.thaicoolhost.com, www.netdesignhost.com, 
www.thnic.net  
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สําหรับผูจัดทําเว็บไซต จะเห็นวาเว็บไซตที่ใหบริการพืน้ที่ทําโฮมเพจฟรี มักจะบอกวาสามารถใชงาน FTP (File 

Transfer Protocol) ได หรือไมได สําหรับที่ที่สามารถใชการอัพโหลดขอมูลผาน FTP ไดจะทําใหมีความสะดวก ในการ
อัพเดทเว็บเพจของเรามาก แตถาที่ไหนไมมีบริการ FTP ก็จะทําใหตองทําการอัพโหลดขอมูล โดยผานทางหนาเวบ็ไซต
นั้นๆ ซ่ึงสวนมากจะชาและเสียเวลามาก  

สําหรับสวนนี ้จะขอแนะนําขั้นตอน และวธีิการตางๆ ในการใชงานโปรแกรมสําหรับจัดการกับการอัพโหลด
ขอมูลแบบ FTP ที่ใชกันคอนขางมาก และขอยกตวัอยางกับการใชงานในการอัพโหลดขอมูลไปใสพื้นที่ของ 
pibul2.psru.ac.th หากเปนพื้นที่ทําโฮมเพจของที่อ่ืน ก็จะมหีลักการเหมือนกนั เพยีงแตเปลีย่นชือ่ของ Server ใหถูกตอง
เทานั้น 

 

รูจักกับโปรแกรม FTP ที่นิยมใชงานกันกอน 
โปรแกรมสําหรับทําการรับสงขอมูลผานระบบ FTP ที่นิยมกนัก็มีอยู 2 โปรแกรม คือ WS_FTP และ Cute FTP 

ซ่ึงหลักการทํางานตางๆ ก็จะคลายๆ กัน ตรงนี้จะขอแนะนําการใชงานของ WS_FTP Pro  ซ่ึงสามารถหาดาวนโหลดได
จากเว็บไซต http://www.ipswitch.com หลังจากทําการดาวนโหลดมาแลว ก็ทําการติดตั้งลงในเครื่องคอมพิวเตอรกอน 
โดยวิธีการตดิตั้งก็ไมยุงยากมาก ทําการ setup และกด next หรือ ok ไปเรื่อย ๆ จนเสร็จ 

 

สิ่งที่ตองทราบกอนทําการอัพโหลดขอมูล 
กอนที่จะเริ่มตนการใชงาน WS_FTP Pro เพื่อทําการอัพโหลดขอมูล หลังจากที่ทําการเขียนเว็บเพจตางๆ เสร็จ

เรียบรอยแลว ซ่ึงตรงจุดนี้ เราจะมีไฟลตางๆ ที่เก็บเปน .html, .php หรือไฟลรูปภาพตางๆ ที่ตองใชในเว็บเพจ เราจําเปน 
ตองทําการอัพโหลดขึ้นไปใส Server ในกรณีนี้ จะยกตวัอยางการใช Host ของ pibul2.psru.ac.th ส่ิงที่ตองทราบกอนทํา
การใชงานมีดงันี้ 

1. Host Name คือช่ือโฮสตที่ตองการใชงาน 
2. UserID คือ User ID ที่ไดรับ 
3. Password คือรหัสผาน ที่ไดรับ 
สําหรับชื่อของ Host ก็แลวแตวาใชงานทีไ่หน ซ่ึงชื่อของ Host ของแตละที่จะแตกตางกันออกไป ตรงนี้ตองอาน

จากขอมูลที่จะบอกเมื่อเราไปสมัครใชงานในที่ตางๆ วาจะตองใสช่ือเปนอะไร หากใสผิดก็จะไมสามารถทําการเชื่อมตอ 
Server ได 
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เร่ิมตนการใชงาน  WS_FTP Pro 
1.      ทําการเรียก โปรแกรม WS_FTP Pro  โดยคลิกที่ปุม Start 
2.      ช้ีไปที่ All Programs 
3.      ช้ีไปที่ WS_FTP Pro แลวทําการเลือก WS_FTP Pro จะพบหนาตางการทํางานของโปรแกรมดงัรูป 

 

 
 

4. หากเปนงานทาํงานครั้งแรกตองทําการสราง Site กอน (Site หมายถึง ช่ือเรียกในการเขาใช server เชน 
website) โดยเลือกที่ เมน ูfile > New Site โปรแกรมจะใหเราระบุช่ือ 

• Site Profile Name คือ ช่ือ Site ที่ใชในการเขา Server เชน website 
• Host Name or IP Address คือช่ือโฮสต ที่ตองการใชงาน เชน pibul2.psru.ac.th 
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5.  เลือก Next > โปรแกรมจะใหเราระบ ุ

• UserID : คือ ช่ือบัญชีผูใชของเรา  
• Password : คือ รหัสผาน ถาเปนเครื่องของเราเองใชประจําไมอยากใสรหัสผานทุกครั้งใหเลือก 

เช็กบอกซที่ Save Password ไวดวย เพื่อเก็บคารหัสผาน 
 

 
 

6.  เลือก Finish แลวทําการ เลือกที่ปุม Connect เพื่อเขาสูการใชงาน 
7.  เมื่อระบบติดตอ Server ไดแลวจะปรากฏหนาจอดังรูป 
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Note :ในการเขาใชงานครั้งตอไป เราไมจาํเปนตองทําการ สราง Site อีกแลวใหเราทําการเลือก Site แลวทําการ Connect 
เขาใชงาน Server ได เลย 
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การ Upload และ Download ไฟล 
        เมื่อทําการเขา Sever เรียบรอยแลวฝงซายมือคือ Local System  ภายในเครื่องเราเอง ฝงขวาคือ Remote System 
ภายใน Server 

1. ในการไฟล Upload  ขึ้น Server นั้น กอนอื่นใหปรับชองฝงซายไปที่ไฟล หรือโฟลเดอรที่เราตองการ Upload   
     กอน แลวปรับชองฝงขวาที่ตําแหนงทีเ่ราตองการจะวางไฟลนั้น จากนั้นเลือกไฟล หรือโฟลเดอรฝงซาย หาก   
     รายการที่เลือกมีมากกวา 1 รายการสามารถ ใชฟงชั่น Ctrl  หรือ Shift ในการเลือกได 
2.  เมื่อเลือกไฟลหรือโฟลเดอรไดครบแลว คลิกเลือกที่ปุม               โปรแกรมจะแสดงสถานะการ Upload ไฟล 
     หรือโฟลเดอร  ดังรูป 
 

 
 
 
 
 
 
 
 
 
 
 
 

3. เมื่อทําการ Upload ไฟล หรือโฟลเดอร เสร็จเรียบรอยแลว สวนลางของโปรแกรมจะแสดงคําวา Tranfer 
Complete เปนอันวาทําการ Upload ไฟลหรือโฟลเดอร สําเร็จ 

 

 
 

 4. ในการ Download ก็เหมอืนกันเพยีงแคเลือกไฟลหรือโฟลเดอร ฝงขวาคือ Remote System ภายใน Server 
                   ใหเรียบรอยแลวทําการ คลิกเลือก ที่ปุม               เพื่อดาวนโหลดไฟลหรือโฟลเดอร จาก Server ลงมาที่เครื่อง  
                 Pc ของเรา 
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การจัดการแฟมขอมูล 
 

 
 

เราสามารถจัดการแฟมขอมลูไดทั้งฝง PC และฝง  Server โดยเลือกไฟล หรือโฟลเดอรที่ตองการจัดการแลว ทํา
การ 

• Click ที่ปุม ChgDir เมื่อตองการเปลี่ยน หรือยายเมนเูขาไปในโฟลเดอรที่เลือก 
• Click ที่ปุม MkDir เมื่อตองการสรางโฟลเดอรขึ้นมาใหม 
• Click ที่ปุม View เมื่อตองการดูขอมูลในไฟลที่เลือก เชน Text File ตาง ๆ 
• Click ที่ปุม Exec เมื่อตองการรันไฟลที่เลือก 
• Click ที่ปุม Rename เมื่อตองการเปลี่ยนชื่อไฟลที่เลือก 
• Click ที่ปุม Delete เมื่อตองการลบไฟลที่เลือก 
• Click ที่ปุม Refresh เมื่อตองการทํารีเฟรส เพื่อใหขอมูลอัพเดทใหมสําหรับการดูขอมูล 
• Click ที่ปุม DirInfo เมื่อตองการดูรายละเอยีดของโฟลเดอรที่เลือก 

 
สรุป   จากทั้งหมดนี้ จะเห็นวาการที่เราสามารถทําการอัพโหลดแบบใช FTP ได จะชวยใหมีความสะดวกมาก ในการ

อัพเดทเว็บเพจที่ เขียนขึ้นมา ดังนั้นหากตองการสมัครใชพื้นที่สําหรับทาํโฮมเพจก็ควรจะเลือกที่รองรับ FTP ดวย 
 


